by TA Software

VERSION 3

USER MANUAL

Author: Peter Dodds, Chester U.K.

Plan-G User Manual Version 3.1.1 July 2014

VERSION HISTORY
Date

Version

Comment

06/06/2014 3.1.0

Draft version issued to TA Software for Comment

02/07/2014 3.1.1.90

Revised to Plan‐G 3.1.1 Build 90 to TA Software for Comment

14/07/2014 3.1.1.91

Release version

© Copyright 2009‐2014 TA Software
All rights reserved. Any unauthorised duplication of this publication (including upload to public
file sharing sites) is prohibited.
Written permission is required from TA Software for the duplication in part or in full of any
items herein.

Plan-G User Manual Version 3.1.1 July 2014

Plan G User Manual

V 3.1.1 July 2014

CONTENTS
1

INTRODUCTION..............................................................................................................1

2

FEATURES .......................................................................................................................2
2.1

Features Retained from Version 2 .....................................................................2

2.2

New Features in Version 3 .................................................................................2

3

PREREQUISITES ..............................................................................................................4

4

INSTALLATION ................................................................................................................5

5

6

7

8
i of viii

4.1

The Download ....................................................................................................5

4.2

Windows XP .......................................................................................................5

4.3

Windows Vista,Windows 7 and Windows 8 ......................................................5

4.4

Installation .........................................................................................................5

4.5

The Data .............................................................................................................6

4.6

Adding New Scenery ..........................................................................................7

FIRST RUN ......................................................................................................................8
5.1

Single PC.............................................................................................................8

5.2

Networked PCs ‐MSFS or Prepar3D ...................................................................8

5.3

Networked PCs – X‐Plane...................................................................................8

5.4

Has it Worked?...................................................................................................9

HAVE A LOOK AROUND................................................................................................10
6.1

The Quick Access Toolbar ................................................................................10

6.2

The Ribbon Menu Tabs ....................................................................................12

6.3

The Main Window............................................................................................12

6.4

The Pop‐up Windows.......................................................................................12

6.5

Tool Tips ...........................................................................................................13

THE RIBBON MENU TABS.............................................................................................14
7.1

The File Tab ......................................................................................................14

7.2

The Home Tab ..................................................................................................14

7.3

The Map Tab ....................................................................................................14

7.4

The Data Tab ....................................................................................................15

7.5

The View Tab....................................................................................................15

7.6

Ribbon Auto‐Hide.............................................................................................15

THE FILE MENU IN DETAIL............................................................................................17

Plan G User Manual

V 3.1.1 July 2014

8.1

New Plan ..........................................................................................................17

8.2

Open.................................................................................................................17

8.3

Merge...............................................................................................................18

8.4

Save As .............................................................................................................18

8.5

Recent ..............................................................................................................19

8.6

Export...............................................................................................................19

8.7

Print..................................................................................................................20

8.8

Help ..................................................................................................................20

8.9

Options.............................................................................................................21
8.9.1 Locations ..............................................................................................21
8.9.2 Units .....................................................................................................22
8.9.3 Sounds..................................................................................................23
8.9.4 FS Connections.....................................................................................24
8.9.5 The GPS Panel ......................................................................................25
8.9.6 User Aircraft.........................................................................................26
8.9.7 Traffic ...................................................................................................28
8.9.8 Weather ...............................................................................................28
8.9.9 General.................................................................................................29

8.10

More on Locations ...........................................................................................32
8.10.1 Single Computer – FS9 & FSX...............................................................32
8.10.2 Single Computer – Prepar3D ...............................................................34
8.10.3 Single Computer – X‐Plane ..................................................................34
8.10.4 Networked Computers.........................................................................34
8.10.5 Networked Computers using a Network Drive....................................34
8.10.6 J Allard Charts ......................................................................................36
8.10.7 Adding Additional Scenery Locations on the Same PC ........................36
8.10.8 Adding Additional Scenery Locations on a Networked PC ..................37

9

ii of viii

THE HOME RIBBON IN DETAIL .....................................................................................38
9.1

Find...................................................................................................................38

9.2

Start Position....................................................................................................40

9.3

Altitude ............................................................................................................40

9.4

Airspeed ...........................................................................................................40

9.5

Winds ...............................................................................................................41

Plan G User Manual

10

V 3.1.1 July 2014

9.6

Aircraft Profile..................................................................................................41

9.7

VFR/IFR.............................................................................................................42

9.8

Quick ................................................................................................................42

9.9

Random Destination ........................................................................................42

9.10

Reverse.............................................................................................................43

9.11

Edit ...................................................................................................................43

9.12

The Frame Button ............................................................................................46

9.13

Copy Route.......................................................................................................46

9.14

Range Rings......................................................................................................46

9.15

Bookmark .........................................................................................................46

9.16

KML ..................................................................................................................47

9.17

Connect/Disconnect.........................................................................................48

9.18

Map Panning Control .......................................................................................48

9.19

VATSIM.............................................................................................................49

THE MAP RIBBON IN DETAIL ........................................................................................50
10.1

User Configured Settings .................................................................................50

10.2

Airports ............................................................................................................51

10.3

Navaids.............................................................................................................52

10.4

Airspace............................................................................................................53
10.4.1 FS9, FSX and P3D..................................................................................53
10.4.2 X‐Plane .................................................................................................55

10.5
11

User Waypoints................................................................................................55

THE DATA RIBBON IN DETAIL.......................................................................................57
11.1

Building a Navigation Database .......................................................................57

11.2

Selecting Which Database to Use ....................................................................58

11.3

Data Tools ........................................................................................................59

11.4

Managing the User Waypoint Database..........................................................60
11.4.1 Editing Records ....................................................................................60
11.4.2 Deleting Records ..................................................................................60
11.4.3 Importing Records................................................................................61
11.4.4 Exporting Records ................................................................................61

11.5
12
iii of viii

Adding New Scenery ........................................................................................62

THE VIEW RIBBON IN DETAIL .......................................................................................63

Plan G User Manual

V 3.1.1 July 2014

12.1

Map Graticule ..................................................................................................63

12.2

Map Overlays ...................................................................................................63

12.3

The Plan Window .............................................................................................63

12.4

Plan Elevation Window ....................................................................................65

12.5

The Information Window.................................................................................66

12.6

The Aerodrome Window .................................................................................67

12.7

The Weather Window......................................................................................67

12.8

Trail Analysis ....................................................................................................68

12.9

Primary Flight Display ......................................................................................70

12.10 The Horizontal Situation Indicator...................................................................71
12.10.1

Direction Indicator ...........................................................................71

12.10.2

Course Deviation Indicator ..............................................................71

12.10.3

Automatic Direction Finder ............................................................. 71

12.10.4

Descent Profile Indicator .................................................................72

12.11 The Radio Stack................................................................................................72
12.12 The Traffic Window..........................................................................................73
12.13 VATSIM.............................................................................................................73
12.14 Zoom Controls..................................................................................................73
12.15 Keep Window on Top.......................................................................................74
13

CONTEXT MENU OPTIONS ...........................................................................................75
13.1

Right‐Click on the Map.....................................................................................75
13.1.1 Create User Waypoint..........................................................................75
13.1.2 Get Fly‐to Heading, Distance and Time ...............................................75
13.1.3 Move FS Aircraft to Here .....................................................................75
13.1.4 Spot Elevation ......................................................................................76
13.1.5 QDM Range and Bearing......................................................................76
13.1.6 Display and Hide Range Rings..............................................................77
13.1.7 Lock Info Panel .....................................................................................77

13.2

Right Click on an Airport ..................................................................................78
13.2.1 Start Flight Plan at Airport ...................................................................78
13.2.2 Select Alternate Destination................................................................79
13.2.3 Set COM Frequencies...........................................................................79
13.2.4 Show Airport Diagram..........................................................................79

iv of viii

Plan G User Manual

V 3.1.1 July 2014

13.2.5 Charts ...................................................................................................79
13.2.6 Instrument Approaches .......................................................................80
13.2.7 METAR and TAF....................................................................................83
13.2.8 Other Selections...................................................................................83
13.3

Right‐Click on a VOR or NDB ............................................................................83
13.3.1 Set VOR Frequency on NAV Radio .......................................................84
13.3.2 Set NDB Frequency on ADF Radio........................................................84
13.3.3 Show Radial..........................................................................................84
13.3.4 VOR Range ...........................................................................................85

14

FLIGHT PLANS...............................................................................................................86
14.1

Creating a Flight Plan Graphically ....................................................................86
14.1.1 New Flight Plan ....................................................................................86
14.1.2 Flight Conditions ..................................................................................86
14.1.3 Aircraft Profile......................................................................................86
14.1.4 Departure Airport ................................................................................87
14.1.5 Continue to Add Waypoints.................................................................89
14.1.6 Insert an Intermediate Waypoint ........................................................90
14.1.7 Start Position........................................................................................90
14.1.8 Save your Plan......................................................................................91
14.1.9 Passing Altitudes ..................................................................................91

14.2

14.1.10

ATA...................................................................................................91

14.1.11

Cross References..............................................................................92

14.1.12

Notes................................................................................................92

14.1.13

The Reverse Button .........................................................................92

Creating a Flight Plan in the Plan Window ......................................................92
14.2.1 Adding Waypoints to the Plan Table ...................................................92
14.2.2 Add Further Waypoints........................................................................93
14.2.3 Passing Altitudes ..................................................................................93
14.2.4 Notes ....................................................................................................94
14.2.5 Save Your Plan......................................................................................94

14.3

Right‐Click Options in the ‘Plan’ Window ........................................................94
14.3.1 Set This as the Active Leg.....................................................................94
14.3.2 Centre on Map .....................................................................................94

v of viii

Plan G User Manual

V 3.1.1 July 2014

14.3.3 Insert, Move or Delete Waypoint ........................................................95
14.3.4 Cross References..................................................................................95
14.3.5 Quick Snippet .......................................................................................97
14.3.6 Insert Snippet File ................................................................................98
14.3.7 Add Alternate.......................................................................................99
14.3.8 Set Author ............................................................................................99
14.4

Modifying Existing Flight Plans ........................................................................99
14.4.1 Adding a New Waypoint to the End of a Plan .....................................99
14.4.2 Inserting a New Waypoint ...................................................................99
14.4.3 Moving and Deleting Waypoints .......................................................100
14.4.4 Save Your Edited Plan ........................................................................100

14.5

Vertical Navigation Profiles............................................................................100
14.5.1 User Defined VNAV Profile ................................................................100
14.5.2 Default VNAV Profile..........................................................................100

15

16

USER WAYPOINTS ......................................................................................................102
15.1

Creating User Waypoints ...............................................................................102

15.2

Adding a New User Waypoint to a Flight Plan...............................................104

15.3

Modifying User Waypoints ............................................................................104

15.4

Deleting User Waypoints ...............................................................................105

AN EXAMPLE FLIGHT PLAN ........................................................................................106
16.1

Preparation ....................................................................................................106

16.2

The Scenic Route............................................................................................107

16.3

A Little Stick of Blackpool Rock ......................................................................109

16.4

Controlled Airspace........................................................................................110

16.5

Change of Plan ...............................................................................................112

16.6

VNAV Profile...................................................................................................113

16.7

Notes ..............................................................................................................113

16.8

Alternate ........................................................................................................113

16.9

Let’s Go Flying ................................................................................................115
16.9.1 Microsoft Flight Simulator .................................................................115
16.9.2 X‐Plane ...............................................................................................116
16.9.3 Prepare3D ..........................................................................................117

17
vi of viii

CONNECTION TO A FLIGHT SIMULATOR....................................................................119

Plan G User Manual

V 3.1.1 July 2014

17.1

Flight Data Transfer........................................................................................119

17.2

Communication Protocols .............................................................................120
17.2.1 FSUIPC3 for FS9..................................................................................120
17.2.2 SimConnect for FSX............................................................................121
17.2.3 FSUIPC4 for FSX ..................................................................................121
17.2.4 SimConnect for P3D ...........................................................................121
17.2.5 FSUIPC for P3D ...................................................................................122
17.2.6 XPUIPC for X‐Plane .............................................................................122

18

FLIGHT SIMULATOR AND PLAN‐G ON THE SAME COMPUTER ..................................123
18.1

Connecting to FS9 ..........................................................................................123

18.2

Connecting to FSX With SimConnect .............................................................124
18.2.1 Connection Using Pipe .......................................................................125
18.2.2 Connection Using IPv4 .......................................................................125
18.2.3 Connection Using IPv6 .......................................................................125

19

18.3

Connecting to FSX with FSUIPC......................................................................126

18.4

Connecting to P3D With SimConnect ............................................................126

18.5

Connecting to P3D With FSUIPC ....................................................................127

18.6

Connecting to X‐Plane....................................................................................127

FLIGHT SIMULATOR AND PLAN‐G ON A NETWORK...................................................129
19.1

First Find Your Sim .........................................................................................129

19.2

Connecting to FS9 from a Networked PC ......................................................129
19.2.1 WideFS ...............................................................................................130
19.2.2 Connection Steps ...............................................................................130

19.3

Connecting to FSX from a Networked PC with SimConnect..........................131
19.3.1 Creating a SimConnect.xml file for the IPv4 Protocol........................131
19.3.2 Creating a SimConnect.xml file for the IPv6 Protocol........................132
19.3.3 Modifying an Existing a SimConnect.xml file.....................................134
19.3.4 Configure the SimConnect Settings in Plan‐G....................................134
19.3.5 Connected ..........................................................................................135

19.4

Connecting to FSX from a Networked PC with FSUIPC..................................136
19.4.1 WideFS ...............................................................................................136
19.4.2 Connection Steps ...............................................................................137

19.5
vii of viii

Connecting to P3D from a Networked PC with SimConnect .........................137

Plan G User Manual

20

21

viii of viii

V 3.1.1 July 2014

19.6

Connecting to P3D from a Networked PC with FSUIPC .................................138

19.7

Connecting to X‐Plane from a Networked PC................................................139

MORE ON SIMCONNECT ............................................................................................142
20.1

Example 1.......................................................................................................143

20.2

Example 2.......................................................................................................144

APPENDICES ...............................................................................................................146
21.1

Appendix 1 Table of Illustrations ...................................................................146

21.2

Appendix 2 – Support ....................................................................................151

21.3

Appendix 3 – Acknowledgements .................................................................151

Plan G User Manual

1

V 3.1.1 July 2014

INTRODUCTION
Released in 2009, Plan‐G was the first Flight Simulator planning software tool to use
the acclaimed and versatile Google Maps mapping tool. Hitherto, the inbuilt planner
and third party external flight planners have extrapolated geographic data from the
Simulator program itself, with the limitation which that entails. Plan‐G was instantly
popular and widely acclaimed across the flight simulator enthusiast world, and in
September 2011 won the prestigious Mutley’s Hangar Award for Flight Simulator
Addon excellence.
Using a public domain global map Plan‐G overlays features pertinent to Flight and
Flight Planning – Airports, Controlled Airspace, Prohibited and Restricted Areas,
Instrument Approach Paths and many more.
Flight Plans can be graphically modified; adding, deleting or dragging waypoints to new
positions with the mouse. User defined waypoints can be created “on the fly” as you
build a plan.
Plan‐G Version 3 is a brand new, completely revised version, and now uses Open
Street Maps as its mapping base. Although terrain modelling and shading is not
currently available in OSM, the vertical terrain profile feature in Plan‐G‐v2 has been
enhanced and simplified to provide the same vertical navigation planning capability.
The several information panes are now presented as floating windows, allowing the
user to place information anywhere on the screen, or not, as they wish.
Many new features have been added to Version 3 to make Plan‐Gv3 the essential
Flightsimmers utility application. As well as working with FS9 and FSX, Plan‐Gv3 now
interfaces with X‐Plane, and with VATSIM if the user is connected to the Internet.
To avoid complicating the text unnecessarily, where the words “Flight Simulator”
appear in the text, X‐Plane is included unless there is a specific difference between the
behaviour of the Microsoft product and X‐Plane, which is explained separately.
New features include: creating separate aircraft performance profiles, “Quick” flight
plans, IFR flight plans, local KML & KMZ, bookmarking particular map views and a
unique Radio Stack which simplifies changing frequencies, especially if Plan‐G is run on
a separate display to FS or X‐Plane.
Version 3.1.1 of the software includes many new enhancements, including support for
Prepar3D, aircraft performance profiles, the ability to open jpeg format charts, an
autopilot added to the radio stack, multiple VOR radials projection (allows position
fixing by intersecting radials) and enhanced flight plan editing functions.
There are now separate versions of Plan‐G for Windows XP and for Windows Vista
onwards, including Windows 8.1. Do make sure you download the correct version for
your operating system.
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2

FEATURES

2.1

Features Retained from Version 2

2.2

•

Supports FS9 and FSX.

•

Shows airspace, airports and radio navaids on the map (from Flight Sim data).

•

Configurable levels of detail (objects displayed) for each zoom setting.

•

Vertical Navigation profile (requires additional Digital Elevation Model (DEM)
download).

•

Fully editable flight plans can be saved in FSX or FS9 format (.pln), or in Plan‐G’s
own format (.plg).

•

Existing FS plans and Plan‐Gv2 plans can be loaded and edited if required.

•

Flight plans can be reversed at the click of the mouse.

•

Flight Plans can be annotated, and waypoints cross‐referenced to ground‐based
radio navaids.

•

Either map or Pilot’s Log (PLOG), or both, can be printed.

•

Customisable database of user waypoints, Visual Reference Points (VRPs), airstrips
etc. Many useful waypoints are included in the download. Multiple user
databases can be built if required.

•

Additional User Waypoint comma separated text files can be imported.

•

Can be run on a second monitor or on a networked PC across a local area network
(LAN).

•

Synchronised connection to FSX or FS9 either on the same computer or across a
LAN.

•

Aircraft telemetry, aircraft flight trails, traffic, weather etc available when
connected to FSX or FS9.

•

Saved flight trails can be displayed for later analysis.

•

Configurable Range Rings can show distance or flight time.

•

Display instrument approaches and low altitude airways.

•

Display current weather for known weather stations in TAF and METAR format
even if not connected to FS.

New Features in Version 3
•

Plan‐G Version 3.1 includes support for Lockheed Martin's commercial training
flight simulator Prepar3D.

•

OpenStreetMaps interface (replaces Google Maps) for comprehensive
topographical detail including railways (traditional VFR navaid) woodland, parkland
and watercourses.

•

“Snippets” ‐ multiple waypoints which can be inserted into a plan either by “quick”
entry” or from a snippets format (.snip) file.
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•

Now supports X‐Plane Versions 9 & 10. Fully editable flight plans can be saved in
the X‐Plane format (.fms), or in Plan‐G’s own format (.plg).

•

VATSIM Support – show all VATSIM controllers and active pilots on the map.

•

RADIAL menu allows you to click on multiple VORs or NDBs and display specified
radials from them for easy identification of intersections.

•

A COM/NAV Radio Stack which simplifies changing frequencies, especially if Plan‐G
is run on a separate display to FS or X‐Plane. The radio stack also includes an
autopilot.

•

Drag and drop editing of flight plan routes.

•

Additional options added to the main map context menu.

•

KML (& KMZ) files can now be stored on your PC.

•

Revised Elevation Plot display.

•

Aircraft Performance Profiles. Can your chosen aircraft fly at the cruising airspeed
or altitude you have set?

•

Data Tools allow data to be moved between MSFS and X‐Plane databases.

•

PDF and JPEG Charts display. Copy your airport charts, approach plates etc into
Plan‐G Files\Charts\<Airport CAO Code> and they will automatically be available
when you right click that airport on the map.

•

One or more VOR Radials can be plotted by bearing and distance either to or from
one or more VORs.
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PREREQUISITES
To function, Plan‐G requires that the .Net (DotNet) Client Profile be installed on the
user’s PC. Plan‐G Version 3.1.1 for Windows XP requires .Net 4.0; Plan‐G 3.1.1 for
Windows Vista onwards requires .Net 4.5. If the correct version isn't installed on your
PC, it is downloaded automatically by the installation program, so the user doesn’t
need to take any action. All future releases after 3.1.1 will require .Net 4.5.
Plan‐G requires an active Internet connection to display the Map base, whichever one
you select to use, and update it correctly. An Internet connection also allows VATSIM
traffic and controllers to be displayed when the ‘VATSIM’ option on the Home ribbon
is selected.

Page 4 of 152

Plan G User Manual

4

INSTALLATION

4.1

The Download

V 3.1.1 July 2014

Download the latest version (and the correct version for your operating system) from
the TA Software Forum http://www.tasoftware.co.uk/forum. Unzip the downloaded
zip file to a temporary folder of your choice. Two files will be extracted:

4.2

•

Setup Plan‐G 3.1.1.exe, and

•

ReadMe.txt.

Windows XP
Plan‐G Version 3.1.1‐xp is the correct version to run under Windows XP.

4.3

Windows Vista,Windows 7 and Windows 8
Plan‐G Version 3.1.1‐w7 works with Windows Vista, 7 and 8 (including 8.1).
The person installing Plan‐G must have Administrator privileges. This means either
•

Having an Adminstrator account on the computer, in which case, double‐clicking
‘Setup Plan‐G 3.1.1.exe' will start installation, or,

•

Obtaining temporary Administrator privileges by right clicking on ‘Setup Plan‐G
3.1.1.exe’ selecting “Run as Administrator”. Installation will then commence.
Note: This manual is valid for Plan‐G under any of the above operating systems

4.4

Installation
The setup window opens with a window containing a copyright notice. Click the ‘Next’
button to open a window containing a dialogue box in which to enter the folder into
which you wish to install Plan‐G. The default locations depend on your operating
system.
In a 32 bit Windows system, the default is a folder within the standard Program Files
system of Windows, normally:
C:\Program Files\TA Software\Plan‐Gv3
For 64 bit systems, the default is a folder in Program Files (x86), normally:
C:\Program Files (x86)\TA Software\Plan‐Gv3
Some people have problems with file access permissions when installing in these
default locations, especially with Windows Vista, Windows 7 and Windows 8. With
these three operating systems, you may prefer to install Plan‐G outside these secure
areas of your file system. However, because Plan‐G now stores its working files
outside the Program Files or Program Data secure areas, this is less of an issue than
formerly.
If you do choose to install Plan‐G outside the Windows secure areas, first create an
appropriate folder in which you wish to install Plan‐G, then simply click the “Browse”
button and navigate to the folder you have created, for example:
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C:\Users\John Doe\Aviation\Flight Simulation\Plan‐Gv3
You can install Plan‐G for everyone that uses the computer on which it is being
installed, or just yourself, the person installing it. You can also check the amount of
disk space needed. When you then click the ‘Next’ button, following an “Are you
sure?” confirmation screen, on which you again click the ‘Next’ button, installation will
then proceed rapidly.

The installer will place the Plan‐G icon
on your desktop which is the shortcut to
start the program. Move it somewhere convenient if you wish. If you are a frequent
Plan‐G user, you can also copy it to the taskbar so that it is always visible. That
completes the installation process.

Figure 1 The Plan-G User Interface at First Startup

Plan‐G3 stores all its database files in a folder called “Plan‐G Files” within your “My
Documents” Folder. If you have installed earlier versions of Plan G3, you can either
delete the previous contents of your Plan‐G folder completely, or you can if you wish
leave the files, and the unzip routine will overwrite the files which need to be
overwritten, but will retain your data files intact without modification.

4.5

The Data
Because Plan‐G3 stores all its database files in a folder within your “My Documents”
Folder, away from the program installation folder, updates to the program do not
affect that data. This makes it easy to maintain backups and other housekeeping
tasks. If you have created user waypoints in an earlier version of Plan‐G3 that you
want to keep, they will be maintained intact with any new version you install, stored in
this folder, either in the file UserWpts3.sdf, or in your own user‐defined file in comma
separated value (CSV) format.
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With Plan‐G3, there is no longer the need to rebuild the main database when you
install a new version. However, you will need to build the main database if you are
installing Plan‐G for the first time, or on a new computer. A warning message to this
effect appears, if necessary, when you first start Plan‐G. However, many other
settings are reset in each new version such as the locations of the important FSX files
Plan‐G needs to access, (See Section 8.9.1 for details).
If you uninstall Plan‐Gv3, all your user data and your database remain in
Documents\Plan‐G Files and are unaffected. You can also delete the database files any
time you wish as long as Plan‐G is not actually running ‐ it will recreate them next time
it runs. Of course you will need to run the ‘Build Navigation Database’ option from
the ‘Data’ tab again to populate the database.

4.6

Adding New Scenery
If you add new 3rd party scenery to your simulator after having used Plan‐G for a
while, even if you add just a single airport, you MUST rebuilt the relevant database
otherwise Plan‐G cannot display it on the map, if it is an airport that hasn't existed in
your sim previously. If the new scenery only contains changes to the airport such as a
new runway, then the data for that airport, and the airport diagram will be incorrect
unless the database is rebuilt.
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FIRST RUN
The first time you run Plan‐G it opens with a map view centred on Enstone Airfield in
the UK. In addition the Flight Plan Window and the Information Window are open.
They can be closed by clicking the relevant icon on the ‘View’ ribbon, or you can move
them to one side of the map view if there is space on your screen. The ‘Data’ ribbon is
open by default which includes a tab which prompts you to build the Plan‐G internal
database before doing anything else. Once the database has been created you can
explore at leisure.

5.1

Single PC
To build the internal database with Plan‐G and a Flight Simulator on the same
computer, go to the Data menu and click on the Build Navigation Database icon. You
may then select the Flight Simulators for which you want to build databases. You can
build separate databases for any one, two, three or all four. Once they have been
built, you can switch between them and Plan‐G will load the correct dataset.

Figure 2 Database Build Options

5.2

Networked PCs -MSFS or Prepar3D
If FSX, Prepar3D or FS9 is installed on a separate, networked, computer to Plan‐G, you
must first follow the instructions in Section 8.9.1 below to set up the locations in Plan‐
G so that it knows where to get its Flight Simulator data. Once you have done this,
Plan‐G will be able to find the data it needs to build the database for the appropriate
sim. You can even have FSX on one PC, FS9 or Prepar3D on another, and Plan‐G on a
third. As long as the locations are set correctly, Plan‐G will build the databases.
Building the databases is not the same as connecting Plan‐G to your sim. To connect
FS to Plan‐G follow the instructions in section 19 ‐ “Flight Simulator and Plan‐G on
Separate Computers”. However, you must have first set the locations otherwise when
you try to connect FS to Plan‐G, you will get an error message.
You may find it simpler to install an extra copy of Plan‐G on your Flight Simulator PC
and build the database(s) there. You can then copy the Plan‐G Files\Data folder across
to your networked PC.

5.3

Networked PCs – X-Plane
First ensure that the folder containing X‐Plane.exe is shared with “allow changes”
ticked. Then set the location of X‐Plane.exe on the Plan‐G computer. There is no
equivalent to scenery.cfg in X‐Plane, so you don’t need to enter anything else. Full
details are given in Section 19.5.
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You may find it simpler to install an extra copy of Plan‐G on your X‐Plane PC and build
the database there. You can then copy the Plan‐G Files\Data folder across to your
networked PC.

5.4

Has it Worked?
Occasionally Plan‐G will appear to build the database very quickly. This usually means
that the build has failed, and you will have to build the database again. You can
quickly check whether a database exists, because the icon for any databases not
available are disabled and greyed out. If a database is installed, then when you move
the mouse over it’s icon, it will display an orange background (see Figure 2 above).
Note, however, that the FSX icon is coloured orange at startup, as that is the default
database build option.
If the database build appears to have stalled (typically builds take around 10 minutes),
check the log file – in Plan‐G Files ‐ for errors. If you can identify a particular scenery
that is causing the error, temporarily remove the scenery from your simulator and try
again. If the problem persists, please contact support via the forum.
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HAVE A LOOK AROUND
Most of the screen is occupied by a map. If you have used online maps before, moving
around the map – panning across the landscape and zooming to different
magnifications will be quite familiar. The level of detail changes at different zoom
levels – both the basic map features and the flight related overlays. The latter are user
configurable (See Section 10.1).
The second dominant feature is the menu ribbon at the top of the Plan‐G window.
There are four ribbon menus: ‐ Home, Map, Data and View. The Ribbon menu icons
will change size and position if the main window size is changed, although they stay in
the same logical part of the ribbon and sequence to avoid any confusion. The menu
ribbon may contain scroll bars at the ends if the Plan‐G window is contracted in width
to less than the minimum length of the ribbon.

Figure 3 The Menu Ribbon for the Map Tab

Figure 4 Menu Ribbon Scroll Bars

The status bar (bottom margin of the map) displays certain data continuously. From the
left ‐ first is a zoom level indicator with a minus and a plus button with which you can
zoom the map as an alternative to using the buttons on the View ribbon with the same
functions, or the mouse wheel. Next, the Latitude and Longitude of the mouse cursor
location (note: not the aircraft) location is always displayed. Depending on your user
preferences, it can display in decimal degrees or degrees, minutes and seconds.
With FS connected, the aircraft altitude, heading and groundspeed is shown next,
followed by a course deviation indicator (CDI). This is activated if a flight plan is loaded,
Plan‐G is connected to the simulator and an aircraft is following the course plotted. The
CDI shows the deviation from the planned course, with each dot representing a 2 degree
course correction to the next waypoint. If the yellow diamond indicator is two dots to
the left of centre, the course correction required is 4 degrees to the left, and so on.
Finally, the estimated time of arrival at the next waypoint and at the destination is
shown. Again these values can only be displayed if a flight plan is loaded and the aircraft
is in flight.

6.1

The Quick Access Toolbar
By default, this toolbar contains three items. However, ANY button on any of the
ribbons can be added to the Quick Access Toolbar by right‐clicking and selecting 'Add
to Quick Access Toolbar'.
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Figure 5 Quick Access Toolbar

The default icons are, from the left:
The Plan‐G “Aeroplane” icon – moves, resizes, minimises or maximises the whole Plan‐
G window (or closes the application).
The “Blank Page” icon − clears any elements of a flight plan in memory, allowing a
fresh start.
The “File Open” icon − opens the ‘My Documents\Plan‐G Files’ folder, allowing
selection and display of an existing Flight Plan file.
The “File Save” icon − opens the ‘My Documents\Plan‐G Files’ folder, allowing the
currently open Flight Plan to be saved.
The “Down Arrow” Icon − clicking this icon displays a small dropdown menu with six
options. In the picture below, an additional option, Save Flight Plan has been selected
as well as the default, and the relevant icon is shown on the Quick Access Toolbar.

Figure 6 The ‘Customise Quick Access Toolbar’ Dropdown

In addition to the five Quick Access Toolbar options, the Quick Access Toolbar itself
can be shown below the ribbon rather than above it. When the Quick Access Toolbar
is below the ribbon, the final item on the dropdown changes to “Show above the
Ribbon”, as you might expect.
The menu ribbon can be hidden by double clicking on one of the four ribbon tabs
(“Home”, “Map”, “Data” & “View”). To restore the ribbon, double click again any of
the ribbon tabs.
The ribbons can also be “auto‐hidden”. At the far right hand end of each screen,
above the ribbon and next to the question mark ‘Help’ icon, is a small up‐arrow icon
which hides the ribbon when clicked. The up‐arrow then changes to a down‐arrow.
When the ribbon is hidden, if you click on the down‐arrow icon, the ribbon is again
displayed. Double clicking any one of the Menu tabs has the same effect.
When the ribbon is “auto‐hidden”, if you click one of the Menu tabs once only, the
relevant ribbon for that tab opens temporarily for further user action. If you click
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away from the ribbon – on the map or window border – the ribbon is again hidden.
The Ctrl‐F1 key combination has the same effect as the Auto‐hide button.
The menu ribbon functions are not needed at all times, so minimizing the ribbon does
not necessarily reduce your options, but can free valuable screen space.
The “File” tab is a special case. Clicking once only opens the File screen. Clicking once
only again closes it. In this and in other ways, it functions differently from the other
tabs.

6.2

The Ribbon Menu Tabs
There are five Tabs, each of which when clicked, reveals its own Ribbon Menu (except
“File” which opens a page with a sidebar menu).

Figure 7 The Menu Tabs

The ribbon menus control almost all the functions of Plan‐G.

6.3

The Main Window
When Plan‐G starts, the main window displays the map location where you were when
you last exited the program, and at the same magnification. Features are displayed in
accordance with the user‐defined options on the Map ribbon.

6.4

The Pop-up Windows
When the main View tab is selected, the ribbon shows a row of ten icons which are
links to ten floating pop‐up windows. They can be opened, closed, resized and moved
as the user prefers. Each of these windows covers one of the following topics: ‐
• Plan:

The tabular Flight Plan,

• Plan Elevation

The terrain profile and vertical navigation profile if the
requisite Digital Elevation Model (DEM) files have been
downloaded and installed (See Section 12.3 below).

• Information:

Displays textual data about controlled airspace and other
details.

• Aerodrome:

If you right‐click an airport on the map and select “Show
Airport Chart” from the drop‐down, the aerodrome chart, with
runways and taxiways, is displayed beneath the Aerodrome
tag.

• Weather:

When Plan‐G is connected to FS, this window shows the FS
weather for the nearest weather station to the aircraft, and
the en route weather. This FS weather may of course be

Page 12 of 152

Plan G User Manual

V 3.1.1 July 2014

external real weather, depending on the source being used by
FS itself.
• Trail Analysis:

Displays a vertical profile of the currently selected trail shown
on the main map,

• PFD:

Displays five of the standard “six‐pack” flight instruments
which are fitted directly in front of the pilot in most modern
aircraft before the advent of “glass cockpits”. The missing one
is the Attitude indicator.

• Radios

Displays a conventional NAV/COM Radio Stack window as
found in most aircraft, including an autopilot, which can be
used instead of the aircraft’s own radio stack if preferred.

• Traffic

Displays on the main map a small red aircraft symbol for any
aircraft which satisfies the display criteria set on the
Files/Options/Traffic page.

• VATSIM

Opens a window which lists all Air Traffic Controllers and Pilots
currently connected to VATSIM in alphabetical order by call
sign.
The default view at startup displays the Plan and Information windows, and after the
initial startup, i.e. once the database has been built, the ribbon associated with the
Home tab. The function of each of these optional windows is described fully in Section
12.

6.5

Tool Tips
If you hover the mouse over any symbol, menu option, tick box, radio button or
aeronautical feature on the map, a context sensitive tooltip is displayed briefly
describing the item’s function or identity. Of course, many are obvious, but it
surprising how useful they can be when your mind goes blank (as it will sometimes,
fear not!).
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7

THE RIBBON MENU TABS

7.1

The File Tab
If you click the “File” tab, then the map
view closes and a new view opens
containing several file handling and
setup options shown as a menu on the
left hand side of the page.
The default view is of the Recent option
from the left hand menu, with, on the
right, a list of ten of the most recent
flight plans opened. The left hand
menu options are described fully in
Section 8 below.
Figure 8 The File Menu Page

The left hand menus offer a number of setup and printing options, plus access to a
copy of this manual via the ‘Help’ option.

7.2

The Home Tab
Selecting the Home Tab displays the Home ribbon, which contains a significant number
of options described fully in section 9 below.

Figure 9 The Home Ribbon

7.3

The Map Tab
Selecting the Map Tab displays the Map ribbon, which shows the items which are
displayed as standard at each scale (level of zoom) of the map. It is user configurable,
but the more detail displayed at the lower zoom levels (more map displayed) the more
cluttered the display will be and the slower to load and refresh following changes. If
the user selects too much data to be displayed, Plan‐G can sometimes display an error
message.

Figure 10 The Map Ribbon

The map settings are described in more detail in section 10.
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The Data Tab
The Data Tab displays the Data Ribbon which allows you to
•

Create the database for either FS9, FSX or X‐Plane, and

•

Select which simulator’s data displays on the map and for which you wish to create
a plan.

• Manage the User Waypoint database.
These options are of course only available for the simulator version(s) you have
installed.
Any current databases available are indicated by the relevant icon being a strong
colour. The icons for databases which have not been installed are greyed out. If you
pass the mouse over the icon for an installed database, that icon is displayed with an
orange background. The icons are the same as those used for the programs they
represent.

Figure 11 Data Ribbon

Further details of how to use these options is given in section 11 below.

7.5

The View Tab
The view tab displays options to customize some elements of what you see on screen.
Map overlays and the map graticule can be switched off to improve clarity and speed
map refresh rate, for example. There are also three customisable fixed zoom buttons
for quickly selecting a favourite zoom ratio. The ten icons commencing with ‘Plan’ on
the left and ending with ‘VATSIM’ on the right each enable a pop‐up data window.
These are resizeable with the exception of the Radio Stack and the PFD Windows.

Figure 12 The View Ribbon

7.6

Ribbon Auto-Hide
At the far right hand end of each ribbon is a small caret icon which when clicked hides
the ribbon (whichever ribbon you are viewing at the time). It hides the whole ribbon
system, not just the one you are currently viewing. When you click one of the Menu
tabs, the associated ribbon is displayed until you click on the map or window border,
when it is automatically hidden again. Alternatively, the hot key combination, Ctrl‐F1,
toggles hidden or displayed mode.
If Auto‐hide is enabled, The ribbon is “auto‐hidden” in this way on first installation.
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Figure 13 The ‘Minimise the Ribbon’ icon and Tooltip

Double‐clicking any of the tabs (except the File tab) will also auto‐hide the ribbon.
Double‐clicking a tab again will display the relevant ribbon and switch off the auto‐
hide feature.
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THE FILE MENU IN DETAIL
The File Menu isn’t a ribbon, but a page with a vertical sidebar menu. The page
default function is to display the last ten flight plans created or opened. A pushpin
icon on the right of each of these ten most recent flight plans allows the selected flight
plan to remain in the Recent files list while other flight plans may change as new flights
are created. All ten can be selected to be pinned if desired. A red cross icon will
delete that entry from the list, but it does not delete the flight plan itself.

8.1

New Plan
Selecting “New Plan” closes the menu and returns the user to the main map window,
where a new plan can be created as described in Section 14 below.

8.2

Open
Selecting the “open” option opens the Windows folder which contains all the Plan‐G
data. By default, this is the Plan‐G Files folder, located in “My Documents” (Windows
XP) or simply “Documents” in Windows Vista or Windows 7. The user can select a
flight plan from the list, or open a Trail file by opening the ‘Trail’ folder and selecting
one of the trail file options from the file type selection dropdown at the bottom right
of the window. The file type selection dropdown includes options for Plan‐G flight
plan files, (.PLG), (the default), Flight Simulator flight plan files, (.PLN), X‐Plane flight
plan files (.FMS); Plan‐G Version 3 Trail files (.IGC) and Plan‐G version 2 Trail files (.txt).

Figure 14 The File Open Window and Options
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If you store flight plans or other data files at some other location, you can navigate the
file browser there, using the usual Windows methods depending on your Operating
System.
Plan‐G "remembers" where you saved the most recent saved flight plans, and will
open the file browser at that folder, so you can select a previously created flight plan
from there. It also saves files in the last data folder you opened. For this reason you
do need to check that you are saving files in the folder in which intend to keep them,
otherwise you may not be able to find the plan you are looking for later. This is
because it was saved in the last folder opened rather than the folder in which you
expected to find it.
Once the flight plan is loaded, Plan‐G will change its map location and display the legs
and the waypoints of the whole of your selected flight plan.

8.3

Merge
Initially, this option is greyed out and unavailable. However, when you open a flight
plan, then this option becomes available. It functions as you would expect and joins
two (or more) flight plans together. Open one plan, then click merge, and the File
Open Window is again displayed and you can select the plan to merge with the first.
If the two plans are not contiguous, Plan‐G adds the missing flight leg required to join
them up. A little sanity is needed here, as merging a flight in the UK with one in
Australia will have an interesting joining up leg comprising a flight literally half way
round the world! Care is also needed to merge flights in the logical order that you
wish to fly them. If you load a flight from B to C, and then merge a flight from A to B.
Plan‐G creates a plan From B to C to A, not from A to B to C, so the flight created is
probably not what you intended. You can merge as many flights as you wish in this
way.

8.4

Save As
The “Save As” option allows you to save the plan as a Plan‐G extended flight plan
format (.plg) file, or to save a plan with a different name or format. Note that Plan‐G
format files cannot be used in the FS Flight Planner or the built in FS/Garmin GPS units.
When saving a plan,or exporting in a different format, Plan‐G opens a window to the
last folder you had open. For example, if you had previously saved a trail file to
..\Plan‐G Files\Trails, then that is the folder which will open, so you will need to
browse to the correct folder (Plan‐G Files for storing plans). Failure to check this may
mean that, later, you can't find the plan you are looking for, because it doesn't exist in
the folder you expect it to be in.
Note: If your PC or Plan‐G crashes, Plan‐G remembers the flight plan you are working
on, and will automatically reload the plan (including any unsaved changes) when you
restart Plan‐G.
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Recent
The File tab opens by default on the Recent option, displaying the ten most recent
plans opened, including newly created flight plans and existing saved plans. The
Recent option does not distinguish between them. Recent Flight Plans are displayed in
reverse chronological order.
A pushpin icon on the right of each of the ten most recent flight plans allows the
selected flight plan to remain in the Recent files list while other flight plans may
change as new flights are created. All ten can be selected to be pinned if desired. A
red cross icon will delete that entry from the list, but it does not delete the flight plan
itself.

8.6

Export
The “Export” option allows you to choose whether to save the plan as an FSX flight
plan which FS can use in it’s Flight Planner and GPS (.pln file); an FS9 flight plan (.pln
file); as an X‐Plane 9 or 10 Flight Plan (.FMS) or as a Plan‐G plan “snippet” (.snip) file, or
to save a Plan‐G format (.plg) plan with a different name.
Snippet files are typically a short flight plans containing two or three consecutive
waypoints which, if saved as type .snip, can be inserted into other flight plans. (See
Section 14.3.6 for details of how to use snippets). Plan‐G specific features (passing
altitudes, notes, cross‐references etc) are not saved in .PLN files. You must use ‘Save
as’ and save your plan as a .PLG if you wish to preserve this extra information.

Figure 15 The Flight Plan Export Options

Note 1: Flight plans in .pln format created by FS9 cannot be opened in FSX and vice
versa. The structure is different. Plan‐G plans (.plg) cannot be opened in FS9 or FSX.
Note 2: The FS9 flight planning tool treats user waypoints as intersections. Although
user waypoints can be added to FS9 flight plans in Plan‐G, they cannot be added
directly to a flight plan within FS9.
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Print
There are three print options in all, though only two are shown in Figure 16 below: ‐ to
print the map or the flight plan. Each selectable option includes a description. When
you select an option, the preview is displayed with a series of small icons at the top of
the print preview window to set the page parameters before printing, e.g. whole page;
page width etc. Each icon has a tooltip, so you can quickly select which one you need.
You can of course print both map and flight plan, and they print sequentially. Once
the options have been set, clicking the small printer icon will open the familiar
Windows Print window, so you can select all the usual options – portrait/landscape;
colour/greyscale; bordered/borderless etc. Clicking the “Print” button in that window
will start the printout.
If no flight plan has been loaded or newly created, the “Flightplan” print button is
greyed out.

Figure 16 Print Options

The third print option is available if the Plan Elevation Window is opened. At the top
right of that window is a small printer icon, which when clicked prints the Plan
Elevation Window exactly as displayed on screen. Again, the conventional Windows
Print window opens first, so you can select all the usual options – portrait/landscape;
colour/greyscale; bordered/borderless etc.

8.8

Help
The help Page provides four options: ‐
About Plan‐G provides information about the current build of the program.
User Manual opens the Adobe Acrobat format Plan‐G User Manual (this document).
Technical Support is a link to the TA Software forum, where all the experts, including
Tim Arnot, the Plan‐G creator, are ready and eager to solve your problem.
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Check for Updates will automatically check for updates to your currently installed
version.

8.9

Options
Selecting “Options” opens an Options window, with a second sidebar menu which
gives access to nine different dialogue panes. When you open Plan‐G, the first time
you visit the “File/Options” menu selection, the right hand area of the page is blank,
and remains so, unless you select one of the nine options. Plan‐G keeps open the last
selected pane for the duration of the Plan‐G session.
The options panes are reasonably self explanatory. Default values are included which
can help decide appropriate values.
You may not wish to change the defaults, but when things get busy, for example, you
can de‐clutter the screen by selecting the ‘Traffic’ option and switching off AI, or
parked aircraft, or limit the range within which they are shown. If you want to see
your own aircraft when Plan‐G is connected to Flight Simulator you clearly have to
have the first box ticked in “User Aircraft”, but there may be occasions when you only
want to see everyone else. This element of Plan‐G allows you to choose. Of course
these options only apply to Plan‐G itself. What you see in your Flight Simulator is
unaffected by these selections.
The nine options are: ‐
•

Locations

•

Units

•

Sounds

•

FS Connections

•

GPS Panel

•

User Aircraft

•

Traffic

•

Weather

• General
The options are described in detail below.
8.9.1

Locations
The Locations menu option allows Plan‐G to locate the FS files it requires in order to
build its internal database of airports and navaids, and to communicate with a running
instance of Flight Simulator on either the same computer or a networked PC running
FS.
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Figure 17 The Locations Page

Section 8.10 "More on Locations" describes in more detail the several options for
pointing Plan‐G at the correct data sources for different simulators.
8.9.2

Units
Because different nationalities use different measuring systems, especially the
difference between the USA/Canada and Europe, in order to be as universal as
possible, Plan‐G can display measurements in Stateside units (feet and inches/Hg); or
European units (Metres/Kilometres/Hectopascals).
Note: From 17th November 2011 the U.K. adopted the use of Hectopascals instead of
Millibars.
Units can be selected for Runway Dimensions, Speed and Distance, Altimeter Setting,
Time and Date, and Latitude and Longitude in degrees, minutes and seconds, or in
decimal degrees. (25o 30' 45.5" = 25.51264 o for example), for English, American, or
European preferences. The rest of the world tends to adopt one of these three
systems, although Plan‐G allows you to select a non‐standard hybrid if you wish.
The default system used is the English system, with local time and date used in the
printable Nav Log. Just click the relevant radio button to change a setting. Settings
are remembered by Plan‐G, so it will probably be a once‐only operation.
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Figure 18 The Units Page

8.9.3

Sounds
You can choose to play alert sounds for three situations where your attention is
primarily on another task.
You can accept the Windows default (illustrated in Figure 19 below) or choose your
own, as long as Plan‐G is told where to find the sound files.

Figure 19 Sounds Page

The three alert sounds available are: ‐
1.

VNAV Profile Alerts: The alert sounds:
•

2.
3.

One minute before Top of Descent, and

• When you reach 500ft above your target altitude.
Waypoint Alerts: Waypoint alerts sound approximately 30 seconds before
reaching a waypoint.
Minimums Alert: This sound is played on final approach, 200ft above the airfield
elevation. It is not set by default.

Page 23 of 152

Plan G User Manual

8.9.4

V 3.1.1 July 2014

FS Connections
There are a number of important configuration options within this tab. They are
explained in detail for the various connection options in Section 17 “Connection to A
Flight Simulator”.

Figure 20 FS Connections Page

The following tables are a simple summary of the most commonly used of those
options for FS9, FSX, P3D and X‐Plane.
FS9 & Plan-G on
same PC

FS9

FS9 & Plan-G on
network

Connect with

FSUIPC

FSUIPC

Network Mode

Not used

Not used

FSX Computer

Not used

Not used

Server Port/Pipe

Not used

Not used

FSX

FSX & Plan-G
on same PC

FSX & Plan-G on a
network with
SimConnect

FSX & Plan-G on a
network with FSUIPC

Connect with

SimConnect

SimConnect

FSUIPC

Network
Mode

Not used

IPv4 (Win. XP)
IPv6 (Vista/W7/W8)

Not used

FSX
Computer

localhost

IP Address (192.168.0.2
etc) Value must be
same as in
SimConnect.xml

Not used

Server
Port/Pipe

Not used

Range 4500 to 4510
Value must be same as
in SimConnect.xml

Not used
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P3D & Plan-G
on same PC

P3D & Plan-G on a
network with
SimConnect

P3D & Plan-G on a
network with FSUIPC

Connect with

SimConnect

SimConnect

FSUIPC

Network
Mode

Not used

IPv4 (Win. XP)
IPv6 (Vista/W7/W8)

Not used

P3D
Computer

localhost

IP Address (192.168.0.2
etc) Value must be
same as in
SimConnect.xml

Not used

Server
Port/Pipe

Not used

Range 4500 to 4510
Value must be same as
in SimConnect.xml

Not used

X-Plane
Connect with

X-Plane & Plan-G
on same PC
XPUIPC

X-Plane & Plan-G on
network
XPUIPC

Note: Connection Protocols are fully described in Section 17.2. If installing FS9, FSX or
P3D with Plan‐G on a network, you need Peter Dowson’s WideFS, as well as FSUIPC.
There are more details about WideFS in section 19.2.1.
8.9.5

The GPS Panel
The GPS Panel option allows you to configure some of the Primary Flight Display limits
and set the trigger values for position and altitude alerts. (See Section 12.9 for details
of using the GPS panel).

Figure 21 GPS Panel Configuration Page

Max Airspeed
Determines the displayed range (0 to <value>) of the Airspeed Indicator.
CDI Sensitivity
This is the course deviation that can be tolerated before Plan‐G will update the CDI
bar. Choices are (deviation from flight plan track): ‐
Page 25 of 152

Plan G User Manual

•

Auto

•

5 nm

•

1.25 nm

•

0.5 nm

V 3.1.1 July 2014

VNAV Targets\VNAV Profile
VNAV stands for Vertical Navigation, more familiar to those who fly high and need to
plan how to get down, than the VFR flyer cruising at 2000 feet. IFR pilots must
descend at a rate not less than 500 feet per minute, so the profile value is important to
them too. These parameters determine where and when Plan‐G will issue its popup
warning windows and sounds, if enabled, to alert the pilot to his progress along the
planned route.
Waypoint/ETE Display
These two selections determine the additional information Plan‐G displays at the top
and bottom of the GPS panel. Choices are:

8.9.6

•

Distance to Waypoint

•

ETE (Estimated Time En Route) to Destination (how long will it take from here to
get to the final destination)

•

Time to Waypoint

•

Heading to Waypoint

User Aircraft
This page sets up options about your own aircraft. Firstly you can choose whether to
display your own aircraft or not.
You have the ability to show your flight “trail” or “track made good” (what it is called
depends on who you talk to). You can also record and save your trail for future
analysis. Practice those overhead joins or procedural turns and then see what flight
profile you actually achieved against the neat version on the approach chart! You can
change the colour and line width of the live trail displayed as you fly, and also the
colour and line width of a selected trail analysis display if the defaults are not to your
liking.
Note: Flight trail display and recording is selected “On” by default when Plan‐G is first
installed.
The three radio buttons; Free, Sync and Lock describe how the yellow user aircraft
behaves in relation to the map. These functions are also available and the option can
be changed from the Home ribbon. The tooltips describe exactly the behaviour in
each case.
Free: The Map and user aircraft are not synchronized. You can move the map
wherever you like, and it won't be synchronised with the plane. If you don’t move the
map, the plane will fly off the edge.
Sync: The Map will move as necessary to ensure the yellow aircraft remains visible on
screen. You can move the map, but if you move it so that the yellow aeroplane symbol
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goes off screen, it will re‐centre on the yellow aircraft when it is refreshed a few
seconds later (5 seconds is the default, but it can be changed in the FS Display
window.) If you leave the map alone, it will stay where it is until the plane reaches the
edge, when it will re‐centre.

Figure 22 User Aircraft Options

Lock: The user aircraft icon stays in the centre of the Map which is re‐centred on the
user aircraft at every refresh. The default refresh rate is 5 seconds, so this option can
degrade Plan‐G’s performance on some less powerful computers.
If the “Update TAS from FS” tick box is ticked, and if a flight plan is loaded, and if Plan‐
G is connected to FS, then Plan‐G shows the true airspeed (TAS) in the Airspeed
dropdown (accessed from the Home Ribbon), taken directly from FS. The user will
have entered an estimated indicated airspeed in the Airspeed dropdown while
compiling a flight plan, but if the “Update TAS from FS” tick box is ticked, that value is
replaced by the TAS from FS. Effectively the flight plan is updated dynamically during a
flight. The “Update TAS from FS” status is unticked by default when Plan‐G is first
installed.
If the “Show Waypoint Alerts” tick box is ticked an alert is displayed before reaching
the next waypoint on your flight plan.
7000 is the International Civil Aviation Organisation (ICAO) standard code for VFR
where no other code has been assigned. This applies throughout Europe. In the UK it is
a general conspicuity code and does not necessarily imply VFR. In the US, Canada,
Australia and some other countries, the VFR code is 1200.
Select the appropriate radio button for the country you are flying in, or perhaps set it
for your home country and change it on the Radio Stack as required. Which ever is
selected becomes the default in the Radio Stack Transponder, and is the value sent to
your Flight Simulator when the “VFR” button is pressed on the Radio Stack
Transponder. The Radio Stack is a new feature in Plan‐G version 3. See Section 12.11
for full details.
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Traffic
This page sets up options about other aircraft when connected to FS. These may be
aircraft artificially generated by FS, (known generally simply as “AI”) or other aircraft
being flown on a multiplayer network such as VATSIM or IVAO, when you are logged in
to one of their servers.
Firstly you can choose whether to display AI/multiplayer aircraft or not. You can
decide the range within which they will be displayed, and if the apron is full of aircraft,
you can turn off “Show Parked” aircraft, by unticking the relevant tick box.
In the same way as for your own aircraft, you can show the flight trail for each of
these. You can change the colour and line width if the defaults are not to your liking.
You can also record and save the trails for future analysis. See the chaos you caused
ploughing through Heathrow’s Class A airspace, VFR in your microlight, forcing all
those IFR go arounds and aborted takeoffs!!!!

Figure 23 Traffic Options

Note: AI flight trail display and recording is selected “Off” by default when Plan‐G is
first installed.
8.9.8

Weather
The “Display Nearest Weather” tick box makes Plan‐G get the weather from FSX. This
may be user generated within FS, or may be from an online system, e.g. if FSX is set for
"Jeppesen", then that is the weather station data displayed. If connected to VATSIM
or IVAO, the weather fed to FS from VATSIM or IVAO via the pilot client software, is in
turn passed to Plan‐G.
Note: There is no "Jeppesen" weather data link in FS9, Prepar3D or X‐Plane.
“Update Local” updates Plan‐G with the wind setting from FS at the user’s location,
when connected to an online weather service.
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Figure 24 Weather Parameters

8.9.9

General
There are five options in this section most of which are self explanatory.

Figure 25 Options / General Screen

Automatically Check for Updates
Plan‐G will automatically check for updates at the intervals shown when one of the
“Automatically Check For Updates” options is selected. The default is once per week.
With Plan‐G being such a dynamic application, it is probably unwise to select “Never”,
but the other options, even the most frequent, do not add any identifiable delay to the
programme's function.
If the Keep Tool Windows on Top tickbox is ticked, the windows which open when a
ribbon option is selected will remain on top of all other windows – Flight Simulator
included. This can be useful to monitor a flight plan or airport data on a single monitor
when Plan‐G is open but overlaid by Flight Simulator. The option becomes effective
after ticking the box, only after Plan‐G has been closed and reopened.
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Plan‐G menu labels can be displayed in English, French, German or Italian. Because
Plan‐G is connected to the Internet at all times when in use, the Auto option will try
and select an appropriate language from the location identified by the computer's
external IP address.
Note: The map textual data is always in English, and the aviation overlay data is
always in the language used by the User’s version of Flight Simulator. Most commonly
of course, this will be English; the international language of aviation.
Map Provider
The Map Provider option allows the selection of several different map styles on which
the aviation data is overlaid. Each of the providers uses a protocol known as Tile Map
Service (TMS). Pick a provider, and when you return to the map view, it will be
redrawn using tiles from that provider.
Note 1: MapQuest Open Aerial is currently not available (March 2013).
Note 2: Mapbox is NOT free. It is a subscription service and requires you to make
your own map styles, although doing so is quite straightforward. They can be terrain
or satellite view or simple OSM. The satellite maps cost from $5 per month, at the
time of writing, while the others are free for up to 3000 tile views per month (that's
around 100 per day). For further details see https://www.mapbox.com.
A map at the default Plan‐G Window size (zoom level 9) consumes 15 tiles. Even
though Plan‐G caches tiles it has downloaded by default, it is possible to use up your
allocation very quickly, especially if you zoom or move the map about a lot. You are
responsible for keeping track of your tile usage and payment of any associated costs.

Figure 26 Map Provider Options

The tile data is cached locally as it's downloaded, so there are options to draw the map
only directly from the Internet, (Online Server Only); only from the cache (Local Cache
Only), or mixed source (Server and Cache).
Page 30 of 152

Plan G User Manual

V 3.1.1 July 2014

In Local Cache Only mode, if the cache is empty, the map background is shown as a
series of dark coloured tiles with with a warning message "Exception: No data in local
cache". in each tile. The aviation overlay data is still displayed. Obviously this is not a
useful mode of operation. In Server and Cache mode Plan‐G will use cached data
where it can and only go to the Internet for data it doesn't have locally.

Figure 27 MapQuest OSM Map Style

In MapQuest OSM style, terrain shading is absent above zoom level 9 in some locations.

Figure 28 Open Street Map Style
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Figure 29 Open Cycle Map Style

Figure 30 Mapbox Relief Map Style

8.10

More on Locations
This section describes in more detail the several options for pointing Plan‐G at the
location of the simulator program and the correct data sources for different
simulators.

8.10.1 Single Computer – FS9 & FSX
The two directories Plan‐G needs to “know about” are:
•

The main Flight Simulator directory, which, by default, is C:\Program
Files\Microsoft Games\, but this is often changed by users during FS installation,
(e.g. C:\FSX as shown below).

• The directory containing FS's scenery configuration file (scenery.cfg).
For Windows XP users, this is usually
C:\Documents and Settings\<user name>\Application Data\Microsoft\FSX
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For Windows Vista, Windows 7 and 8 users, this is usually
C:\Program Data\Microsoft\FSX.
In most cases, these directories will be in these “default” locations, and Plan‐G will be
able to automatically locate the correct location, but if your FS installation differs from
the default, you will need to point Plan‐G at the correct locations on your FS PC.

Figure 31 The Locations Page

Figure 32 Browsing for the Location of Scenery.CFG

The scenery configuration file C:\ProgramData\Microsoft\FSX\scenery.cfg links Plan‐G
to the default scenery and any third party airstrip scenery you have installed. Make
sure you have installed your scenery properly and make sure any airstrips you have
installed can be found within the Flight Simulator airports list.
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Note: Be careful not to point Plan‐G at the scenery.cfg file to be found in the FS
directory itself. This is an FS generated backup copy and is often not up to date. One
tip you may consider is to copy the scenery.cfg file from
C:\ProgramData\Microsoft\FSX\ to the main FSX folder each time you add new
scenery to FSX, keeping a backup of course.
8.10.2 Single Computer – Prepar3D
The two directories Plan‐G needs to “know about” for P3D are:
A) The main P3D directory, which, by default, is C:\Program Files (x86)\Lockheed
Martin\Prepar3D v2, but this may be changed by users during P3D installation, (e.g.
E:\P3D).
B) The directory containing P3D's scenery configuration file (scenery.cfg) will normally
be found in: ‐
C:\ProgramData\Lockheed Martin\Prepar3D v2 or, if you are familiar with
environment variables: ‐
%ProgramData%\Lockheed Martin\Prepar3D v2.
If you run P3D v1, then those file paths should end with "v1" rather than "v2",
obviously.
8.10.3 Single Computer – X-Plane
There is only one X‐Plane directory Plan‐G needs to “know about”, which is the
location of X‐Plane.exe. The default location is C:\X‐Plane, but being user configurable,
it may be different from that.
Click in the X‐Plane Location box, then enter or browse to the location of your X‐
Plane.exe file. e.g. D:\X‐Plane 10.
8.10.4 Networked Computers
The simplest, and preferred method of creating a database on a networked computer
is to create that database on a single computer, i.e. one with your flight simulator and
Plan‐G both installed, and then simply copy the folder (My) Documents\Plan‐G
Files\Data to the networked PC.
Note: This method does not enable Plan‐G to be connected to Flight Simulator for
data transfer during flight. That is a separate function which requires the correct FS
Connection data to be set up (See section 8.9.4 below).
8.10.5 Networked Computers using a Network Drive
If you are reasonably computer‐literate, another reliable way to get Plan‐G to find a
networked computer is to map a Network Drive to the location of FSX.EXE. This has
the advantage that you can at any time, build the database on the Plan‐G PC which is
going to use it, and Plan‐G will use the Network Drive to connect to FS during a flight.
To “map” (create a short cut to) a network drive, do the following.
Windows XP
1.

Open “My Computer”

2.

Click the Tools menu, and then click Map Network Drive.
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3.

If you don’t see the Tools menu, press ALT.

4.

In the Drive list, click a drive letter. You can choose any available letter. Starting
from Z: and working backwards is recommended for network drives; only to avoid
confusion with the “normal” hard disks, DVD drives etc., which start from C:

5.

In the Folder box, type the network path of the folder or computer, or click
Browse to find the folder or computer.

6.

To connect every time you log on to your computer, select the Reconnect at
logon tick box.

7.

Click Finish.

Windows Vista, Windows 7 and 8
Open “Computer”
1.

Click Map Network Drive on the Command Bar.

2.

Continue as for Windows XP.

Your computer is now connected, or mapped, to the network drive.
So once you have successfully created a network drive; say Z:\ which points to the
network location //MyFSXPC\C:\Program Files\Microsoft Games\FSX, you only need to
enter Z:\ in the FSX Program: dialogue box.
In the example path above MyFSXPC is the “Network name” of the FSX PC, created
when your network was first set up. (Of course you must use the network name of
your FSX PC). You can repeat the process for another network drive Y:\ to point to the
location of FS9, if you have it installed. The location of Scenery.cfg, is usually the same
Networked drive as the main FS program location.
You can of course simply enter the full path to these locations, but it is more prone to
typing errors than the network drive method, although Plan‐G does remember them
between sessions and between program updates. Other FS applications can also often
make use of network drives.
The default paths in Windows XP and Windows Vista are different, so be careful to
map to the correct location. Unlike setting up Locations on a single PC, Plan‐G cannot
automatically find FSX on a network, so it is important that you point Plan‐G at the
correct locations on your FS PC.
Some PCs won’t reveal the target of the networked drive to Plan‐G (and other
applications – it isn’t just a Plan‐G problem). The only solution of which TA Software is
aware is to go to (My) Computer, locate the network drive and open that drive in
Windows Explorer, i.e. just open the folder to view the contents, no more than that.
You can then close the window. Once that is done, Plan‐G will be able to find your
networked drive by its drive letter. The problem has only been identified in Plan‐G
when building a new database following a new release. Once this “trick” has been
done once, Plan‐G always does seem to be able to find the necessary drive and its
database when you start it up afterwards.
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8.10.6 J Allard Charts
What are J Allard charts? One of John Allard's sub‐hobbies, as he describes it is to
make airport diagrams from FS9 data. He has uploaded around 200 world wide to the
Mutley's Hangar site at: ‐
http://forum.mutleyshangar.com/index.php/files/category/3‐airport‐diagrams
Registration is free and the site contains a wealth of flight simulator material for all
platforms.
The diagrams are jpg images and are relatively compact, usually only around 100K, and
they come directly from FS data. Real world airport diagrams do not always accurately
reflect what you encounter in your simulator because of expansions, runway closures
etc over time.
Once you have downloaded a few of these chart images, place them in a suitable
folder within the Plan‐G environment. One recommendation is ..\My
Documents\Plan‐G Files\Charts\JAllard. Once you have done this, simply browse to
that location and enter the path to the charts in the J Allard Charts dialogue on the
Locations screen. This then enables the Plan‐G feature to display the relevant chart
when you right‐click on an airport for which you have downloaded a chart (see Section
13.2.5).
8.10.7 Adding Additional Scenery Locations on the Same PC
The Additional Scenery Locations box enables the Microsoft FS9 or FSX user to include
scenery which has been removed from the scenery.cfg file, but the files themselves
are still in place on the system. Some scenery managers switch scenery entries in or
out according which region is being used, and therefore the scenery.cfg file may never
actually contain the entire scenery library at any one time. By specifying additional
locations in this box, which are to be added to the database, the user can have a
complete list of all their sceneries in Plan‐G.

Figure 33 Adding Additional Scenery Locations
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In addition, Additional Scenery Locations box can be used to add scenery held on a
different disk drive on the same PC, and not mapped to the simulator.
Click the ‘Add’ button to open a file browse dialog, and select the required scenery
folder – that is the folder which contains the “Scenery” (and usually but not always)
the “Texture” sub‐folders. To delete that entry, click the Delete button – the one
containing the red ‘X’ on the left of the entry.
8.10.8 Adding Additional Scenery Locations on a Networked PC
If you store all your addon scenery on a different drive to your simulator but on the
same computer, e.g. C:\FSX and D:\Scenery, you can build the Plan‐G database across
the network if you create a network drive on the Plan‐G computer to pointing to
D:\Scenery on the FS computer (see Section 8.10.5 above). Alternatively, you can
change the paths in scenery.cfg from absolute, e.g. D:\FS_Scenery\<my addon
scenery> to relative paths, e.g. ..\FS_Scenery\<my addon scenery>. This has to be
done manually using a text editor, so may not be a simple task.
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THE HOME RIBBON IN DETAIL
The "Home" ribbon menu contains the options you need to set up the parameters of
your new flight plan. Changes made here will be displayed in the "Plan" window, and
they will be saved to your new Flight Plan when you click the "Save" or “Export "
buttons.
Those ribbon buttons with a small down arrow beneath the label (e.g. Find, Bookmark,
and KML on the Home ribbon), are "split buttons". Clicking the icon itself will activate
the default action (e.g. Find Airport), while clicking the bottom half which has the label
and the arrow will display a menu of choices (Find VOR etc.).

Figure 34 The Home Ribbon

9.1

Find
The "Find" button allows you to search for an airport or radio navigation aid. The Find
button is a “Split” button. Clicking the icon, (top half of button) activates the default
action, in this case Find Airport. Clicking on the lower half of the button drops down a
list of objects you can search for.
If the searched‐for item exists in your simulator’s database, it will be found, and the
map will centre on it. If the item does not exist, Plan‐G does nothing. You can select
“Cancel” to return to the map view, or enter some search text that Plan‐G can find.
Search text is NOT case sensitive.
The filters at the bottom of the Airport selection screen are used to narrow your
search, if you do not know the precise location you are looking for. If you know an
airport’s ICAO code, it is best to enter this in the appropriate box, as this is of course a
unique identifier. The options are: ‐
•

Find Airport (Search by ICAO code, by airport name, or by city name)

•

Find NDB (Search by 3‐letter identifier or by name or partial name)

•

Find VOR (Search by 3‐letter identifier or by name or partial name)

•

Find Intersection ‐ GPS intersections. Search by the 2‐5 character identifier, the
national 2‐letter identifier (e.g. EG for the UK) or the 4‐letter ICAO designator for
the airport with which the intersection is associated.

•

Find User Waypoint (User Waypoints are other points of interest that can be
created by the user and added to a Plan‐G database.)

•

Address is the option you select to plan a flight over your home (in MSFS anyway)!
Enter the address and Plan‐G will move the map centre to that address. It may be
used to find any address in the world, although it is only as precise as the data the
mapmakers can provide, so entering 137, Lansdowne Road, South Perth displays
just the city of Perth and its surroundings, although it is clever enough to find the
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city of Perth in Western Australia rather than Perth in Scotland.
This feature is limited in X‐Plane because the X‐Plane database does not contain
“City” or “State” fields.
The Find Airports dialog includes a “CSV” button. This button allows the user to save a
list of the airports in the table above it. This may be the whole FS database of airports
(may be a very large file) or just a small number, depending on the search criteria and
the Country, State and City filters applied. Clicking this button opens a “Save As”
dialog for the user to select a filename for the CSV formatted data and a location to
store it. By default these .csv files are stored in Documents\Plan‐G Files, and can be
opened in Notepad, or a Spreadsheet program such as Excel.

Figure 35 Using the Find Function to Locate an Airport

Figure 36 Selecting an Intersection

A Note About Intersections
Intersections are displayed in Plan‐G only at zoom level 9 or higher. They are of
limited value to VFR pilots, but are used principally by Flight Management Computers
on heavy aircraft. However, they can be displayed on most GPS receivers. They have a
unique 2‐5 character identifier, and a national 2‐letter identifier (e.g. EG for the UK).
En route intersections are shown as red triangles in Plan‐G (if the option to display
them is selected). Those associated with an airport are shown as blue triangles in
Plan‐G, and have an additional identifier, which is the 4‐letter ICAO designator for the
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airport with which the intersection is associated. There are a large number of them
and the map can become cluttered and partly illegible at zoom level 9 or 10.

9.2

Start Position
Plan‐G extracts the runways and parking spaces available at your planned departure
airport from the FSX or FS9 database. Initially, the icon background is a faded blue,
(i.e. "greyed out") but once you have selected the starting airport for a flight plan, or
have loaded an existing flight plan, it is displayed with a strong blue background
colour. This indicates that it is available for use.

Figure 37 Start Position Window

Click on the icon to display a window containing the options. Some airports have more
options available than others, usually depending on how big the airport is in terms of
runways, taxiways, importance even. When the Flight Plan is exported to the Flight
Simulator .pln format, then loaded into FSX, FS9 or P3D, this will be the location on the
airport from which your simulated flight will depart, if you select the option within FS
"Do you want Flight Simulator to move your aircraft to the departure airport listed on
the flight plan?. The elapsed time is zero'd from this departure location.

9.3

Altitude
Here you can set the overall planned altitude for your new flight plan, after consulting
the Plan‐G map for airspace and terrain constraints.
"Passing Altitudes" can be set for individual waypoints, by editing the plan table
directly, although these altitudes cannot be used directly by FS.

Figure 38 Cruising
Altitude Window

9.4

Figure 39 Cruising Airspeed
Window

Airspeed
Your planned airspeed is entered here so that Plan‐G can calculate the duration of
each leg and the complete flight. Plan‐G uses true airspeed not indicated airspeed. If
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you then change for a faster aircraft in FSX/FS9 after creating your plan, you will have
to manually change your estimated true airspeed here. With a flight plan open,
changing true airspeed recalculates the leg times and the flight total elapsed time.
Of course, if the “Update TAS from FS” tick box is ticked in the File/Options/User
Aircraft screen, then the true airspeed is constantly updated from FS.

9.5

Winds
A wind value entered in this window will be used to calculate the heading required to
maintain your planned track. If a wind value is entered, Plan‐G will also calculate and
display your ground speed.
If you are connected to FS9/FSX, and provided you have “Update local” ticked in
File/Options/Weather, then the FS9/FSX ambient wind will be automatically passed to
Plan‐G for use in flight plan calculations, as well as being displayed in the top left
corner of the map as a yellow wind arrow in a small black box, and in the Winds
dialogue box when you open it. Although real world printed weather sources report
the wind in degrees true, Plan‐G displays the ambient wind in degrees magnetic, as
would be reported to the pilot by ATC.

9.6

Aircraft Profile
Creating an aircraft profile is an optional feature which influences how Plan‐G fits a
flight plan to the aircraft which is going to fly the route. What is its best rate of climb;
how fast can it fly on final approach; what is its fuel endurance? No point in trying to
fly a Tiger Moth over the Alps, or land a 747 on a 700 metre grass strip.

Figure 40 Piston Aircraft Profile Dialaogue
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Plan‐G can create flight plans and vertical navigation profiles more accurately if it
knows more about your aircraft than simply that it is, say, a Beech Baron.
Performance values can be found in the Pilot Operating Handbooks and other sources
on the Internet, or from Pilot Supplies retailers, if you want a pukka hard copy. From
any of these sources, you can complete the form in Figure 40 below. You may need to
adjust some real world values if Flight Simulator doesn’t perform to those values (and
it sometimes doesn’t).
You can save profiles, which are stored in Documents\Plan‐G Files\Profiles, with a
.profile file extension. They can be opened in Notepad, as they are actually xml code
files.
If your aircraft is a turbine powered propellor aircraft or a jet (turbofan) powered
aircraft, then if you tick the turbine/jet tickbox at the top right of the dialogue box
then the lower half of the dialogue changes to present you with data boxes
appropriate to those power plants.

Figure 41 Turbine/Jet Aircraft Profile Dialaogue

See section 14.1.3 for information on using aircraft profiles in flight plans.

9.7

VFR/IFR
A flight is conducted either under Visual Flight Rules or Instrument Flight Rules. The
VFR and IFR buttons on the ribbon select the flight rules you have chosen for your
flight. Plan‐G will then estimate a suitable altitude, taking flight rules into account.

9.8

Quick
Clicking the “bow and arrow” icon (officially called the “direct to” icon by GPS
manufacturers) reveals a neat feature for a quick and dirty “A to B” plan. Enter the
ICAO codes for departure and destination, and Plan‐G quickly generates a Great Circle
direct track between the two. This is very handy for short flights or answering
questions such as “Have I got time to fly from A to B this evening?”

9.9

Random Destination
There will be times when you simply cannot decide where to fly, but you want to go
somewhere. Plan‐G can decide for you! Open the Quick Plan window by clicking the
“Direct to” icon, enter a start location ICAO code, then click on the "R" button to the
right of the destination box. Plan‐G will enter a destination for you. A route box
allows you to fine‐tune the route if you wish. If you like the suggestion, click the OK
button, otherwise click the "Clear" button for another suggestion, or to give up on the
idea, click "Cancel".
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Figure 42 Random Destination Dialogue

You can set limits on the type of destination you wish to visit, so that Plan‐G does not,
for example try and suggest landing at Montreal in your microlight, or at Florence in
your Floatplane. To open the options dialogue box, click on the small launcher icon at
the bottom right of the Flight Plan section of the Home ribbon.

Figure 43 Random Destination Options Dialogue

To close the dialogue, click the red Close button top right of the window, or click the
launcher icon again.

9.10

Reverse
This button reverses the sequence of waypoints in a loaded flight plan. This is useful
for creating a new flight plan for the return trip. The window title in Plan‐G will reflect
a new name for the reversed flight plan, and when you save it, Plan‐G automatically
changes the name for the new, reversed plan.

9.11

Edit
This is a most useful feature for tweaking a flight plan to improve its accuracy to "hit" a
user waypoint missed perhaps because it was created at a low zoom level, to avoid
obstacles, or pass round controlled airspace, or any other adjustments you may wish
to make to get it just right. It also gives a quick way to change your mind. You can of
course change your route by selecting new waypoints, moving them up or down the
plan table, removing redundant ones etc., but how much easier it is just to drag the
route line around the map as the impulse takes you.
If a Flight Plan is loaded and displayed on the map, clicking the Edit button puts a "drag
handle" at each waypoint in the plan, plus an intermediate one between each
waypoint. The Edit icon background changes colour to orange. It is a simple process
which needs little explanation. The following sequence of screenshots illustrates the
procedure.
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When a drag handle is dragged to a new position, a new waypoint is inserted in the
plan, as illustrated in Figure 48 plus a new grab handle is created at the midpoint of
each of the two new legs. To remove the drag handles when editing is complete,
simply click the Edit button again. The icon background returns to the "inactive"
colour.

Figure 44 The EDRK to EDKV Leg Passes Through Controlled Airspace

Figure 45 Clicking the Edit Button Reveals Grab Handles
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Figure 46 Grab Handles Can Be Dragged Anywhere on the Map

Figure 47 The Route is Moved to Avoid the Controlled Airspace
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Figure 48 The Flight Plan Table Gains a New Waypoint

9.12

The Frame Button
If a flight Plan is loaded and displayed on the map, clicking this button will move the
map view to centre the displayed flight plan into the middle of the map area, and will
adjust the zoom level to include the whole of the plan in one view. If no flight plan is
loaded, clicking the Frame button has no effect.

9.13

Copy Route
This option copies the flight plan route to the windows clipboard from where it can be
pasted into VATSIM or IVAO Flight Plans, or used for generating Pilot Reports (PIREPS)
for your Virtual Airline. If you want to exclude the departure and destination points
(for flight plans), press SHIFT as you click the button. The button is greyed out if no
Flight Plan is loaded. The copied data is simple text, e.g. (From Perth International to
Jandakot via two local NDBs) “YPPH CVM PRL YPJT”

9.14

Range Rings
Range Rings can be useful for estimating distance or time to run, if you are connected
to FS9/FSX. There are two modes: distance mode and time mode. The rings display in
yellow, centred on the current cursor position. The default distance range is 20 miles,
the default time range is 30 minutes. For VFR flying, you may prefer these values to be
10 miles and 10 minutes respectively. You can display 1, 2 or 3 rings, selectable from
the ribbon menu. Range rings do not require you to be connected to FS. They are
purely a mapping display function. You can display as many sets of range rings as you
wish.
Switching Range Rings on or off is achieved from the right‐click dropdown menu. See
section 13.1.6 for further details.

9.15

Bookmark
This is a most useful feature if you are in the habit of flying to and from places
scattered round the globe. Click the Bookmark button to open a files window. If you
enter a file name (of your choice) the current map view is saved with that name as a
bookmark.
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When you are elsewhere in the world, and want to quickly return to a bookmarked
map view, just click the small dropdown arrow to the right of the Bookmark button on
the ribbon, and select “Open” from the two available choices. The files window again
opens, but this time, locate and click on the bookmarked file name of the location you
wish to go to, and click the “Open” button at the bottom right of the files window. The
window immediately closes and the map view changes quickly to the selected
location.
Bookmark files have the extension .bmk. You can if you wish store your bookmark files
in their own sub‐folder within Plan‐G Files to keep all your bookmarks in one place.
Plan‐G remembers the last folder opened, so be careful to check, when saving flight
plans, that you don't accidentally save them in one of your sub‐folders, and then not
be able to find them again.

9.16

KML
KML is a file format used to display geographic data in an Earth browser such as
Google Earth, Google Maps, and Google Maps for Mobile. Just as web browsers
display HTML files, Earth browsers such as Google Earth (and of course Plan‐G) will
display KML files. KML and KMZ files are stored locally on the User’s PC and can be
copied, emailed or shared with other users as required.
You can create KML files with the Google Earth user interface, or you can use an XML
or simple text editor to enter "raw" KML from scratch. KML files and their related
images (if any) can be compressed using the ZIP format into KMZ archives. KML code
is based on the XML standard and adds features that can be created with the Google
Earth user interface. These features include placemarks, descriptions, ground
overlays, paths, and polygons. When a text file is saved with a .kml or .kmz extension,
Earth browsers know how to display it.
In Plan‐G, .kml or .kmz files can be opened and the features coded therein will be
displayed as an overlay on the Plan‐G map. KML or KMZ files used can be located on
your PC. You only need to tell Plan‐G where to find them.
When the user clicks the KML button, the Documents\Plan‐G Files folder window
opens by default. So it is a good idea to store your KML and KMZ files there, perhaps
in their own sub‐folder such as is shown in Figure 49 below.
Select the file you want to display and click ‘Open’ in the file window, Plan‐G will
display the KML overlay. The KML window also opens if you click the small dropdown
arrow to the right of the KML button on the ribbon, and select “Show” from the two
available choices.
If you select “Clear”, the overlay is removed from the map.
Note: Opening a KML overlay does not remove any existing overlays. You can have
more than one displayed at a time. The Clear command however, will clear all KML
overlays from the display. Be aware that loading and display of KML files may be quite
slow on some systems, which could make it seem as if Plan‐G has stopped working.
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The "P" and "M" tickboxes to the right of the KML icon simply tell Plan‐G to display
polygons (P) or markers (M) or both, when a KML file is loaded.

Figure 49 A User-Created KMZ_Files Folder in Plan-G Files

Figure 50 Locally stored KMZ Files in a User-created Folder

9.17

Connect/Disconnect
These two buttons connect Plan‐G to a running instance of Flight Simulator (FS9, FSX,
X‐Plane, or P3D). This very important option requires initial configuration and is
described fully in section 14.3 below.

9.18

Map Panning Control
If the user is connected to Flight Simulator, the Plan‐G map display update can be
controlled in one of three ways: ‐
•

Lock: The User Aircraft remains in the centre of the map area, and the map moves
as the aircraft progress through the flight. This is very processor intensive and may
slow the computer down. The map refreshes every 5 seconds by default.
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•

Sync: When the User Aircraft reaches the edge of the map area, the map refreshes
with the aircraft now in the centre of the map area.

•

Free: The aircraft moves independently of the map display, and may “fly off” the
edge of the displayed map. Dragging the map will bring the aircraft back into view.

VATSIM
Selecting this option will display all VATSIM controller positions which are active, the
boundaries of the airspace they cover (Tower, Approach, Centre etc., and small blue
aircraft symbols for all connected pilots. Hovering the mouse over a connected
position or aircraft symbol displays a tootip showing details of the connected position
or flight. It functions, therefore, in a similar way to the map view of Servinfo and
Vatspy.

Figure 51 VATSIM Controllers and Traffic
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THE MAP RIBBON IN DETAIL
The map Ribbon allows the user to configure the level of detail shown on the map.

10.1

User Configured Settings
At every zoom level, the default structure is designed to maintain the speed of map
refreshing by turning off more and more detail as you zoom out. However, the
settings for each item can be user configured for each zoom level to be displayed or
hidden according to preference.

Figure 52 The Map Ribbon

User configured settings for each zoom level are set using the Marker pop‐up boxes.
There is a marker pop‐up for each of the groups; Airports, Navaids, Airspace and User
Waypoints. The marker popup boxes are opened by clicking the small diagonal arrow‐
shaped ‘launcher button’ at the bottom right of each section. Change the values as
required and close the Pop‐up.

Figure 53 The Airports Marker Options Pop-up

So, in the example above,
• Large airports will be visible at zoom level 7 or higher,
• Medium airports will be visible at zoom level 8 or higher, and
• Small airports will be visible at zoom level 9 or higher.
• Helipads and Float Plane Bases will not be displayed, and
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• Farm Strips will be displayed at zoom level 10 or higher.
The Airports ‘launcher button’ is boxed red in Figure 53 above.
User configured settings for each zoom level are remembered for the next time you
open Plan‐G, and unless or until you change them. So every time you return to zoom
level 8 the large and medium airports will be visible, but the small airports will not.
This same principle applies to each of the four map ribbon sections.

10.2

Airports
The Airports in Plan G are extracted from Flight Simulator and stored in the relevant
database. Airports close in the real world, and new ones are built. Flight Simulator is
however frozen in time (FSX is frozen at 2005, FS9 at 2004) so there will be differences
from the real world in Plan‐G as there are in FS. For X‐Plane, you can obtain airport
data updates from http://data.x‐plane.com/, roughly in line with the Aeronautical
Information Regulation And Control (AIRAC) cycle of updates.
At each zoom level, airports are selectively displayed as described in Section 10.1
above. The as‐installed default display levels for airports are: ‐
•

No Airports are displayed at zoom levels 1‐6

•

Large Airports are first displayed at zoom level 7

•

Medium Airports are first displayed at zoom level 8

• Small Airports are first displayed at zoom level 9
The airport size reference used in Plan‐G refers to the length of the longest runway.
•

Large:

Longest runway is 3,000m or more in length;

•

Medium:

Between 800m and 2,999m in length

• Small:
Less than 800m in length
You can also select which airports you wish to see by clicking the appropriate tickboxes
at the left hand side of the Map Ribbon. However, options selected by this method
are fixed across all zoom levels.
In this section of the Map Ribbon there is also a slender green arrow symbol labelled
ILS/LOC. This symbol, called “ILS feathers” is used on aeronautical charts to denote an
Instrument Landing System (ILS). If this button is pressed, those airports that are
selected for display (Large, Medium and/or Small), where those airports have runways
equipped with ILS/LOC in FS, will have “feathers” displayed against them on the
appropriate approach bearing.
Note that if a real world airport runway has an ILS which is not featured in FS9/FSX,
then the feathers are not displayed. (remember: FSX is frozen at 2005, FS9 at 2004),
so because real world approach aids are changing year on year, such differences may
become more common over time.
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Navaids
The radio navigation aids (Navaids) in Plan G are also extracted from Flight Simulator
and stored in the database and subject, naturally, to the same obsolescence as
Airports.
The Navaids Marker Options pop‐up is opened by clicking the small arrow‐shaped
launcher button at the bottom right of the Navaids section. The Navaids Marker
Options allows the user to select which navaids are visible at each zoom level.

Figure 54 Navaid Marker Options

The tick boxes on the Ribbon also allow you to display or hide navaids. However,
options selected by this method are fixed across all zoom levels.
Very High Frequency Omni‐Range beacons (VORs) and Non‐Directional Beacons
(NDBs) are probably familiar to most Sim‐pilots. There is an excellent tutorial on the
theory and practice of using these on the Cix VFR Club website at:
http://www.cixvfrclub.org.uk/training/tutorials/pdftutorials/The%20IMC%20Rating.pdf

ISEC is the standard aviation abbreviation for Intersections. Intersections exist in two
forms, named (normal) and unnamed. Named intersections are the standard type of
intersection. On the Navaids section of the Map Ribbon, the “ISEC” tick box switches
on or off named intersections, and the “ISEC (unnamed)” tick box switches on or off
unnamed intersections .

Figure 55 The ORTAC Intersection In the English Channel

Named Intersections are now commonly used in VFR flight, resulting from the
increasing use of GPS worldwide. Some are included in GPS Databases and VFR pilots
can navigate to them simply. Because it isn’t easy to discriminate between those
useful to VFR pilots and those which are not, Plan‐G includes all the ones identified in
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FS. (e.g. ORTAC at N50.00o W002.00o well known to VFR pilots crossing the English
Channel).
Unnamed intersections are computer generated 'infill' intersections. They still have
names, but these names are generally not memorable. Unnamed intersections are
generally not valid for use as a turning point on an IFR flight plan.
The intersection symbol is a small triangle. Blue triangles denote 'terminal'
intersections, i.e. they are "owned" by an airport, and typically form part of an
approach procedure. Magenta intersections are 'En Route' intersections, and typically
are associated with an airway.
In addition to the above, user intersections can be defined, and these are denoted by
green triangles.
Plan‐G can display Lower Airway routes if the Lower Airways tick box is ticked. Airways
are radio and area navigation routes within which ATC ensures smooth and orderly
traffic. Lower Airways are routes up to a 24,500 feet ceiling above sea level, primarily
used for smaller aircraft or short flights. Upper airways are reserved for larger jets on
long flights, and are not provided in Plan‐G.
By default, intersections and Lower Airways are not displayed at any zoom level.

10.4

Airspace

10.4.1 FS9, FSX and P3D
Airspace options are selected via the tickboxes in the Airspace Layer Options pop‐up,
which is opened by clicking the small arrow‐shaped launcher button at the lower right
corner of the Airspace section of the Ribbon.
All airspace is classified according to a system defined by ICAO. The table below
(Figure 57) provides an overview of the classes, and the specifications for each.
Plan‐G displays Classes A to E if the “ICAO Airspace” tick box is ticked. Classes F & G
are commonly referred to as the “Open F.I.R.” (Flight Information Region) and is
principally the domain of light aircraft, microlights, balloons etc. Most commercial
flights and all “heavy” category aircraft almost exclusively conduct their flights in
Controlled Airspace (CAS) under ATC control. When planning your flights it is essential
to know, therefore, where you can and cannot go, and Plan‐G provides the
information.

Figure 56 Airspace Layer Options
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In addition, Plan‐G can show controlled airspace either below 10,000ft for VFR traffic,
above 10,000ft for IFR traffic, or both.
Class Controlled IFR SVFR VFR

ATC
Clearance

Separation

Traffic Information

A

Controlled

Yes Yes

No

Required

Provided for all flights

N/A

B

Controlled

Yes Yes

Yes

Required

Provided for all flights

N/A

C

Controlled

Yes Yes

Yes

Required

Provided for all IFR &
SVFR

Provided for all VFR

D

Controlled

Yes Yes

Yes

Required

Provided for IFR/SVFR to Provided for all IFR and
other IFR/SVFR
VFR

E

Controlled

Yes Yes

Yes

Required
for IFR

Provided for IFR/SVFR to Provided for all IFR and
other IFR/SVFR
VFR where possible

F

Uncontrolled Yes No

Yes

Not
Required

Provided for IFR/SVFR to
Provided where
other IFR/SVFR where
possible
possible

G

Uncontrolled Yes No

Yes

Not
Required

Not provided

Provided where
possible

Figure 57 ICAO Airspace Classification

In the real world, unpressurised aircraft are not permitted to maintain sustained flight
above 10,000 feet, (12,500ft in some countries), because the crew cannot take in
sufficient oxygen to maintain their mental faculties, and are prone to make irrational
decisions. Not good in an aeroplane! So if you are a light aircraft enthusiast, you can
switch off controlled airspace (CAS) boundaries above 10,000ft, and reduce Plan‐G’s
processing workload. And if you are crossing the USA in a 747 at 35,000ft, you can
save Plan‐G some work by switching off the “Below 10,000ft” CAS tick box.
The “Centre” tick box displays or hides the Air Route Traffic Control Center (ARTCC)
boundaries. Generally referred to as “Centre” they are responsible for controlling
instrument flight rules aircraft en route in a Flight Information Region at high altitudes
between airport approaches and departures. In the UK the National Air Traffic Service
(NATS) combines the London Terminal Control Centre (LTCC) and London Area Control
Centre (LACC) at the Swanwick facility. Centre is unticked by default at all zoom levels.
RPDM Airspace is shorthand for “Restricted, Prohibited, Danger Areas and Military”
The latter are areas where the RAF does it’s much of its training; military low flying
areas, air to air refueling areas, high altitude danger areas etc.. For VFR pilots, these
are not normally an issue, and for IFR pilots, IFR routes invariably avoid these areas.
RPDM Airspace is either bordered in red or coloured red with a red border and is
switched off by default at all zoom levels.
In addition to the classified airspace, there is a “Special Use” tick box. “Special Use”
includes Areas of Intense Aerial Activity (AIAI) which are also RAF training areas but
where General Aviation traffic is not likely to cause too many problems. Special Use
airspace is coloured grey with a grey border and is switched off by default at all zoom
levels.
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The Airspace Colour Guide icon displays a pop‐up window when clicked, which gives
an example of each of the colours used to define airspace boundaries on the UK Civil
Aviation Authority published 1:500,000 and 1:250,000 scale General Aviation charts. It
is purely an aide memoire and has no function within Plan‐G.

Figure 58 Airspace Colour Guide

As with the other marker pop‐ups, you can select the Airspace you wish to see by
clicking the appropriate tickboxes in the Airspace section of the Map Ribbon. Options
selected by this method are visible at the zoom levels set in the Airspace Layer Options
as shown in Figure 56 above.
10.4.2 X-Plane
There is no airspace data included in X‐Plane. Plan‐G can import Airspace data from
Flight Simulator to display on the map, assuming that X‐Plane users have access to a
legitimate copy of Flight Simulator. Data transfer between MSFS and X‐Plane is
described in detail in Section 11 below.

10.5

User Waypoints
User waypoints may be created in 12 different types

Figure 59 The 12 Predefined Types of User Waypoint

User Waypoints are stored in a User Waypoint database. Many of these are provided
in the Plan‐G package in the file UserWaypoints.sdf. These can be optionally displayed
or hidden by ticking the relevant tick box on the Ribbon. All except IFR waypoints are
displayed by default, the icons showing with an orange background colour.
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Figure 60 Selected User Waypoint Types

If you add your own waypoints (see Section 11.4) they can be categorised in one of the
12 options shown above. This also means that only selected ones are displayed, in the
same way as other features.
Note: Whenever a new version of Plan‐G is issued, the file UserWaypoints.sdf is
overwritten, so if you create your own waypoints, be sure to keep a safe copy
somewhere outside the Plan‐G folder. Further details are included in section 11.4.
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THE DATA RIBBON IN DETAIL
This is the ribbon which allows you to create the database for the simulator you have,
and to select which database to use. You can create a database for FS9, FSX, P3D or X‐
Plane, for any or all of them. These database options are only available for the
simulator version or versions you have installed. The icons are greyed out for any
simulators not installed. If you do have more than one simulator installed, either on
the same computer or on separate networked computers, then as well as creating a a
database for each, you can create flight plans for each one too in Plan‐G format, or the
relevant format for that simulator.

Figure 61 The Data Ribbon

11.1

Building a Navigation Database
When you first install Plan‐Gv3, this screen is presented, with a warning “First Data”
tab above the ‘Build Navigation Database’ icon. You must build a valid database
before you can use Plan‐G. See Section 5 above.
When you click on the ‘Build Navigation Database’ option, the following window is
displayed in which you can select which database to build, if that simulator is installed
on the same PC or a networked machine. (Networking is fully covered in a later
chapter).

Figure 62 Database Build Options

Plan‐G detects which simulator is installed on the PC and the options window reacts
accordingly, greying out any simulator option which is not available. In Figure 62
above, the FSX and FS9 options are shown black, but the P3D and X‐Plane options are
greyed out. On the PC from which this screenshot was taken, both FSX and FS9 are
installed, but P3D and X‐Plane are not.
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If you click the ‘Settings’ button at the right of the options window, a new dialogue box
opens containing the current paths to the simulator Program, and Scenery.cfg (for FS9,
FSX or P3D). These are exactly the same options and serve the same purpose as the
options accessed from the “File” menu, (see section 8.9.1 above) and give the user the
opportunity to change the paths if one or more is incorrect.

Figure 63 Simulator Paths Dialogue Box

If you click the small diagonal arrow‐shaped launcher button at the bottom right of the
‘Nav Database’ section of the Data Ribbon the same Simulator Paths Dialogue Box
opens as shown in Figure 63 above.

11.2

Selecting Which Database to Use
You can select which database is used for the map display (airports, navaids controlled
airspace etc.) by clicking one of the ‘Display…’ icons at the left hand side of the Ribbon.
If the database for that simulator exists, the icon is shown in strong contrast. If it does
not exist, the relevant icon(s) will be greyed out. The selected database icon is shown
with an orange background when its icon is clicked, and the map will display data from
that database.
If no airports, controlled airspace or navaids, or any other aeronautical data appear on
the map when the correct “Active FS Version” for your sim is displayed, then you
should rebuild the database.
Note that for networked PCs, the icons will only display in the “Active” (black on
orange background) mode if the correct communication protocols are in place (see
section 17.2 below).

Page 58 of 152

Plan G User Manual

11.3

V 3.1.1 July 2014

Data Tools
This option allows Plan‐G data to be moved from one database to another. It is
particularly useful for exporting Airspace data from FS9, FSX or P3D to X‐Plane, which
does not contain Airspace data. In this way, a map showing X‐Plane Airports, can be
made to also show Airspace boundaries.

Figure 64 Database Tools

You can export the Flight Simulator Airports from FSX or FS9, for use in a different
application. The data file is saved in Comma Separated Value (CSV) format in your
Plan‐G Files folder. The default filename is Airports_Export(PG).csv, and it contains the
airport Name, City, State and Country only. The data within Flight Simulator is not
affected.
If you have an existing CSV file of airports, you can merge your exported data into that
file. When the Plan‐G files window opens, select your existing CSV file. Duplicate
records are removed.
If you import a CSV file of Airport Data, the data is again merged, and duplicate
records are removed.
In a similar manner you can export Airspace data from FSX or FS9. As mentioned
above, this can be imported into Plan‐G when an X‐Plane database is active, to
populate the map with airspace data which doesn’t exist in X‐Plane. The X‐Plane files
are not changed.
Caution - Important
The FSX airspace file contains over 21,000 records and the file size is approximately
8Mb. Be careful not to reimport the file into the FSX database otherwise the records
are duplicated.
If you select “Clear” the Airspace data in Plan‐G is cleared ready for importing fresh
data. If you are going to re‐import the Airspace.csv file, then it is important that you
click ‘Clear’ first to avoid this duplication problem.

Page 59 of 152

Plan G User Manual

11.4

V 3.1.1 July 2014

Managing the User Waypoint Database
To view the User Waypoint database and manage it directly, (adding, editing or
deleting waypoints), open the Data Ribbon at the top of Plan‐G, and select the Manage
Database button. The “Manage User Waypoints” window will open.

Figure 65 The Manage User Waypoints Window

11.4.1 Editing Records
If you double click in any “cell” in the database, its row is highlighted in blue. A second
click on the cell highlights it in white surrounded by a heavy black border. The text or
numerical value in that cell can then be changed. Clicking “OK” will save the changes.

Figure 66 Editing The User Waypoint Database

11.4.2 Deleting Records
Left‐clicking a record will select (highlight) it. If Shift is pressed while selecting records,
multiple contiguous records can be selected. If control (Ctrl) is pressed while selecting
records, multiple non‐contiguous records can be selected.
If you right‐click a record, a pop‐up menu appears which has two options: ‘Centre on
Map’ and ‘Delete Waypoint’. Shift‐right‐click or Ctrl‐right‐click will select contiguous
or non‐contiguous records as in the paragraph above, but in this case, the pop‐up
menu is also displayed rather than the highlight alone. When multiple records are
selected, only one option ‘Delete waypoint’ is offered.
Thus either a single record or multiple records can be deleted with one key press. The
deletion is not reversible, therefore a warning is displayed “This action will delete
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row(s) from the database. Do you wish to proceed?” as a protection against accidental
deletion.
11.4.3 Importing Records
You can import or export data files containing user waypoints so long as the number of
fields matches exactly the number of fields in the User Waypoint database (9). These
files must be comma separated value (CSV) files of the form
[CATEGORY],[NAME],[IDENTIFIER],[LATITUDE],[LONGITUDE],[ELEVATION],
[MAGVAR],[TAG],[NOTES]
e.g. VRP,BOLAM LAKE,NEWCASTLE,55.1254997253418,‐.87133300304413,0,4,UK,
Note: ‐ The order of fields that you must create isn’t exactly as displayed in the Plan‐G
User Waypoint Database. Also note that the final comma denotes that the 9th field
[NOTES] is empty in the example above, but must be accounted for by that final
comma after “UK”. In other words, in any record you wish to import, you must have 8
commas otherwise the import will fail.

Figure 67 A User-Created Folder Holding User Waypoints

Clicking the ‘Import’ button opens a folder window for the user to select the (correctly
formatted) User waypoint CSV file. Double clicking the CSV file, or clicking once and
selecting ‘Open’ starts the import process. Duplicate records are not copied.
11.4.4 Exporting Records
With the User Waypoint Window open, highlight the records you wish to export and
only those will be exported. Contiguous records can be selected by holding down the
Shift key as you click each record. Non‐contiguous records can be selected by holding
down the Ctrl key as you click each record.
Once a number of records have been highlighted, clicking the ‘Export’ button opens
the Plan‐G Files folder window. Enter a suitable file name and the records will be
saved to that file with a .csv extension. A pop‐up window appears in Plan‐G on
successful completion of the export. If no records are highlighted, clicking the ‘Export’
button does nothing.
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Figure 68 User Defined Records Imported

Figure 69 User Defined Records Exported

Technical Note: When you export user waypoints, The [CATEGORY] field as shown in
Section 11.4.3 above is a number, since that’s how the data is stored internally. But an
ENGLISH language text string is acceptable when importing waypoints. The
[CATEGORY] field is localized in non‐English languages.

11.5

Adding New Scenery
If you add new third party scenery to your simulator, that hasn't existed in your sim
previously, even just a single airport, you MUST rebuilt the relevant database
otherwise Plan‐G cannot display it on the map. If the new scenery contains changes to
an airport which already exists in the database, such as a new runway, then the data
for that airport, and the airport diagram will be incorrect unless the database is
rebuilt.
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THE VIEW RIBBON IN DETAIL
Plan‐G can be configured to show as much or as little detail as you wish. Different
features are switched on or off depending on the zoom level chosen, to avoid
excessive data processing delays and of course map clutter. As a general rule, the
default settings are optimum for most users, but invariably each will have their own
preferences. The View Ribbon allows the user to filter unwanted general display
features, with the ability to turn them on or off as they wish.

Figure 70 The View Ribbon

12.1

Map Graticule
The Map can be displayed with a grid if desired, by ticking the higher of the two
tickboxes at the top left of the ribbon. This tickbox toggles on or off the graticule. This
option is unticked by default.
The graticule is drawn along map tile boundaries.

12.2

Map Overlays
This option is ticked by default. All the overlay features can be switched off by
unticking the lower tickbox. If you want to just look at the map without any
aeronautical information displayed at all, click this tick box to remove the tick. Click
again to replace the tick and all the overlay data will be redisplayed.
The ten control icons to the right of these tickboxes each opens a pop‐up window
showing additional information to that provided on the map by default. The next
section of the ribbon controls the zoom level and the final section will lock or unlock
any selected control window so that it remains on top of all other windows (or not)
when Plan‐G is minimised or overlaid with another application such as Flight
Simulator.

12.3

The Plan Window
The Flight Plan Window is open by default when Plan‐G is first run after installation.
The table contains the conventional flight plan headings, although initially when it
opens, it is empty, with a brown bar line across two thirds of the way down. Below
this bar appears the summary of your planned flight, above it the details of each leg.
As you build a flight plan, each new entry is added to the window in sequence and the
summary information is updated.
A vertical scroll bar will appear on the right of the details section if necessary, as new
legs are added. To view the complete plan, either drag the brown bar line down, or
drag the lower border of the window down to reveal the whole plan. If the window is
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reduced in width, a horizontal scroll bar allows all 14 data fields in the plan to be
shown.
Plan‐G remembers the window size last used, so if you open an existing Flight Plan,
and the window was left expanded when Plan‐G was last closed, the window opens
expanded with the flight plan details visible.

Figure 71 The Plan Window Before a Flight Plan is Created

Figure 72 Plan Window Expanded to Reveal All Flight Plan Details

MEF (the ninth and last column populated by Plan‐G) stands for the Maximum
Elevation Figure, and is the highest point (not including masts, skyscrapers etc.,) in a
0.5o square through which the track passes. The MEF for a leg analyses all the grid
squares through which the leg passes, and uses the highest value. The source data is
the National Oceanic and Atmospheric Administration (NOAA) 1.2km GLOBE dataset –
the same source as the DEM tiles described in the next section.
When your plan is expanded, you can add or delete waypoints, move the waypoints up
or down the plan, add snippets and an alternate destination by right clicking the
relevant entry in the plan to reveal the dropdown menu of options.

Figure 73 Flight Plan Editing via the Dropdown Menu
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Plan Elevation Window
This feature requires the optional download and installation of one or more Digital
Elevation Model (DEM) tiles from the NGDC 'GLOBE' (Global Land One‐km Base
Elevation) website at http://www.ngdc.noaa.gov/mgg/topo/gltiles.html. There are
sixteen files covering the whole world, each one downloadable from one of a row of
links labeled A to P below the diagram of the world. Do not click on the graphic as that
results in you being navigated away from the page.
The tile files are TAR compressed files with the extension “.gz” or “zip”. Both can be
extracted with Winzip or Winrar. The extracted files have no extension. You need to
download and install a minimum of one tile to enable the Plan Elevation Window
functionality in Plan‐G, but you do not need to download and install every tile. No
elevation data will be shown in Plan‐G where tiles are not installed. The extracted files
must be placed in your Documents\Plan‐G Files\DEM folder.
For example, Documents\Plan‐G Files\DEM\b10g is the file for the tile that covers the
western half of the USA and south‐western Canada.
When the Plan Elevation icon is selected from the View Ribbon, an elevation window
will open at the top of the Plan‐G screen.
If no tile files exist in the folder Plan‐G\DEM the Plan Elevation tick box is displayed in
a faint grey and cannot be selected. If no flight plan is loaded the elevation window is
displayed, but contains no elevation data.
The Flight Plan Elevation window shows the total profile for the flight as a continuous
profile even if the flight Plan comprises multiple legs which are not in a generally
similar direction.
In the example below, a flight plan has been created across Canada from Port Hardy
British Columbia to Calgary, Alberta, crossing the Rocky Mountains. As you would
expect, the elevation profile is quite interesting.

Figure 74 Flight Plan Elevation Window overlaying the Map Window

In the example above, the DEM profile is shown green, the Flight Plan altitude is
shown as a solid blue line, (at an impractical 2000ft), and the highest point on track –
the Maximum Elevation Figure (MEF) is shown as a solid maroon line, at approximately
13,000ft. The distance is shown along the x‐axis.
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If, for example, the flight crosses a range of mountains and includes a return track
reversing the outbound leg, such as the one shown below between Hawarden EGNR
and Caernarfon EGCK crossing Snowdonia in North Wales, the same mountain range
will be shown twice, the second being a mirror image of the first. It is important to
realise this when interpreting the diagram.

Figure 75 A Mirrored profile for an “Out and Back” Flight Plan

12.5

The Information Window
By default on first loading a new version of Plan‐G, this panel is shown expanded. It
provides important information (as its title implies) about the feature currently
beneath the mouse pointer. This may be aerodrome data, (active or disused),
controlled airspace data (name, type and boundary altitudes) or radio navigation aids,
type and frequencies, or all of these, for example, at a major airport.
The context menus vary in content, but the Lock Info Panel is
always the last item.

Figure 76 Lock Info Panel in Dropdown menus

Figure 77 The
Information Window

As the mouse pointer moves across the aeronautical symbols on the map, the
information displayed constantly changes, so you can check out such information to
help create a flight plan, e.g. avoiding certain controlled airspace or finding out which
runways at an airport have an ILS.
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The information displayed is colour coded: A white background is used for airport
data, a pale green for VORs, a darker green for NDBs and orange for controlled
airspace. Of course not all these items are included in every display.
The information displayed can also be locked so that the data for a particular area is
constantly displayed even though the mouse pointer is moved away. Right click on the
feature for which you wish to lock the information and the context sensitive dropdown
menu includes the option as the last item.

12.6

The Aerodrome Window
If you right‐click an airport on the map and select “Show Airport Diagram” (second
option) from the dropdown, the Aerodrome Diagram is displayed.

Figure 78 Airport Diagram
Window

Figure 79 Airport Diagram
Window with Overlay

If you click the small blue Information icon at the bottom left of the window, the
relevant information for that airport is displayed as an overlay on the Airport diagram.
No airspace or navaid information is included in this option – to see that detail you
have to use the Information Window (See Section 12.5 above). This function is
available in all supported simulators.

12.7

The Weather Window
With Plan‐G connected to FSX/FS9, and showing the user aircraft position, the
Weather drop‐down data expander reads the weather data from FS9/FSX and shows
everything that FSX/FS9 “knows” about the weather conditions for the aircraft's
current location, either on the ground or airborne. This FSX/FS9 weather data may be
one of the built in weather themes, user modified weather, weather from an online
server such as VATSIM or IVAO (if connected to such a server), or real‐world Jeppesen
weather (FSX only). Plan‐G displays all the available weather data, as shown in the
following extract.
In Prepar3D, the weather may be set up for a required flight, and this is passed to
Plan‐G in the same way as for FSX. Weather may be taken from VATSIM if connected
to a VATSIM online server, but the "Jeppesen" weather option in FSX, which
downloads real time weather directly from the web is not available in P3D.
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If you select "Download Weather from NWS" (access via the File tab, in
Options/Weather), weather from the NOAA National Weather Service (NWS) will be
displayed without having to be connected to FS. The format displayed in the table is
very slightly different however, since it comes from real METARs, rather than the
adapted data provided by FS. The NWS weather data is downloaded for all airports
worldwide which have a weather reporting facility, and stored as two contiguous text
files in the folder Plan‐G Files\WX while the program is running. There is one file for
METARs and another for TAFs. When Plan‐G is closed, the two files are deleted
automatically.
If you have a flight plan loaded, the weather is shown for the departure and
destination airports, whether your Flight Simulator is connected or not.

Figure 80 Weather Table

A yellow wind arrow is displayed in the top left‐hand corner of the main Map window
whenever Plan‐G is connected to Flight Simulator. It indicates the strength in knots
and the magnetic bearing of the wind. This function is available in all supported
simulators.

12.8

Trail Analysis
Trail plotting is enabled from the “File” tab, in Options /User Aircraft (See section 8.9.6
above). If Trail plotting is enabled, and Plan‐G is connected to Flight Simulator, a trail
of the flight of the user’s aircraft is displayed on the map during the flight, and saved
as an International Gliding Convention (IGC) file. IGC files are an international
standard recording protocol designed for use in competitive gliding, but which can be
used to record any flight. The log records the callsign of the aircraft flown, the
flightpath, elevation and elapsed time.
If you wish to analyse a flight afterwards, and automatic logging is enabled, then you
can reload that flight and examine it. Select the ‘File’ tab, then ‘Open’, and select the
sub folder of Plan‐G Files. Click the “Aircraft Breadcrumb Trail Files (.IGC)” from the
file type dropdown box at the lower right of the Trail Files Folder window. A list of your
saved logs is displayed from which you can select the one you wish to view.
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Figure 81 Loading a Logged Flight Trail

When the trail loads (it takes a few seconds) it is displayed on the map, which is
moved to display the whole route, and the vertical profile is also displayed.

Figure 82 A Trail Analysis Example

The example above shows a flight by an aircraft with the callsign CXA470 flying a route
from Pitt Meadows, British Columbia to Calgary, Alberta, in Canada. The pilot was
attempting to cross the Rockies below 8000 feet all the way, hence the very
convoluted trail towards the end. The vertical profile shows that he was forced to go
higher at times. The vertical profile window title is generated as part of the IGC
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protocol and comprises the aircraft callsign, the date of the flight and departure and
arrival airports.
To close the vertical profile window, click the Trail Analysis icon on the View ribbon.
To close both the trail and the vertical profile, click the large red cross at the top left of
the Vertical Profile window.
Note that although a trail is generated during a flight when connected to FS, the
vertical profile is only created from the saved log file, so that, if selected, the vertical
profile window remains empty during a flight.

12.9

Primary Flight Display
Selecting the Primary Flight Display (PFD) icon displays your aircraft’s performance
instruments. This can be useful, for instance, where you have only one monitor, but
you need to check out progress on Plan‐G and also make sure your hand flown VFR
aircraft doesn’t suddenly enter a spiral dive while your attention is elsewhere. If used
in conjunction with the Radio Stack Autopilot (See Section 12.11 below), it is possible
to conduct almost an entire flight from Plan‐G and not look at the aircraft in Flight
Simulator at all, not that this is recommended.

Figure 83 PFD Panel

Figure 84 The PFD Panel “Alive” during a Flight with a Flight Plan Loaded

Figure 83 above shows the PFD Panel as it appears when no flight plan is loaded.
Figure 84 shows the PFD panel during a flight with a Flight Plan loaded.
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The instruments are not labeled, but it is obvious which they are – the basic “6‐pack”
except for the Horizontal Situation Indicator (HSI) which has additional features
described below. Airspeed and altitude are also shown digitally.

12.10 The Horizontal Situation Indicator
A unique feature of Plan‐G is a Horizontal Situation Indicator with more than attitude!
It incorporates four navigational features.
a) A Direction Indicator (DI)
b) A Course Deviation Indicator (CDI), and
c) An Automatic Direction Finder (ADF)
d) A Descent Profile Indicator
These features are only available, however, if a flight plan is loaded and Plan‐G is
connected to Flight Simulator.
12.10.1 Direction Indicator
Most virtual pilots should be familiar with a DI. This one is identical to that found in
your aircraft, except that it doesn’t precess with time. If precession is not a term you
are familiar with, look up “Direction Indicator Precession” on the internet and read all
about it. The DI compass rose shows the magnetic heading you are flying against the
red lubber line at the top.
12.10.2 Course Deviation Indicator
The yellow needle and the central bar form a CDI with a slight difference. It isn’t tuned
to a VOR, but is indicating your deviation from the flight plan track line displayed on
the map. The sensitivity varies with distance from destination. Full Scale Deflection
(FSD) for various distances is shown in the table below.
Distance from Waypoint

Sensitivity

More than 35nm

FSD = 5nm from track

Between 2nm and 35nm

FSD = 1.2nm from track

Less than 2nm

FSD = 0.25nm from track

This is the same as the sensitivity of an ILS localiser, so is very precise.
12.10.3 Automatic Direction Finder
This is an ADF with a difference. The small green arrow works exactly like an ADF
tuned to an NDB, but it points directly to your next waypoint. It is not influenced by
thunderstorms or mountains of iron ore, so is more reliable than a real world ADF (not
that magnetic mountains are simulated in FS!)
It does get more sensitive as you get nearer to the waypoint, and swings round in the
normal way an ADF needle does as you pass the waypoint. When Plan‐G decides it is
time to look for the next waypoint, it will swing round automatically to point to the
new one. If you are directly on track, this will be the instant that the aircraft passes
over the waypoint. If you are off track a little, it will swing round to about 150o or 220o
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(depending whether you are left or right of track), before changing to the next
waypoint, so don’t chase the needle as you near the point of changeover.
12.10.4 Descent Profile Indicator
The fourth feature is the descent profile indicator. Whether you create an altitude
profile or not, Plan‐G will calculate a Top of Descent point along your route. As you
near the Top of Descent, the profile bar (a small green letterbox shaped rectangle)
appears on the HSI dial, and descends downwards.
This is similar to a glideslope indicator and shows the rate of descent you need to
achieve to maintain your VNAV profile. It works in the same sense as an ILS glideslope
indicator. If the bar is below the centre, you should increase your descent rate, and if
it above centre you should slow your descent rate.
Full scale deflection on the profile bar is 1 degree above or below the profile (the same
as a normal ILS). This mimics the standard handheld Garmin (e.g. 296, or 496) VNAV
functionality. If you wish to disable the profile bar, set the Profile to 0ft/minute,
accessed from the “File” Tab in Options/GPS Panel.
The HSI tooltip contains context information about your position on the profile.

12.11 The Radio Stack
The inclusion of a radio stack in Plan‐G might at first
seem incongruous. However if you can recall any
occasion when you have needed to adjust a radio
frequency; transponder or autopilot setting but either
you are in the wrong window of Flight Simulator and you
need to make the change quickly in busy traffic, or the
aircraft designer has made changing frequencies tricky
because the numbers are too small to be resolved
clearly by your slightly antique graphics card, or the
clickable hotspots aren’t quite in the right place – then
you will have wished for a radio stack outside the
Simulator, with easy manipulation. The less financially
challenged can buy hardware units, but Plan‐G provides
a similar, free, option. If you have Plan‐G on a separate
monitor with the Radio Stack displayed, you almost have
the luxury of the hardware option, and certainly have
the ease of use.
The panel does not function (no numbers visible and
nothing is clickable) unless Plan‐G is connected to Flight
Simulator.

Figure 85 The Plan-G
Radio Stack

Changing the numbers in Plan‐G changes the numbers in the aircraft radios and also
works with VATSIM or IVAO ATC when connected to those networks. In fact it works
in precisely the same way as any Flight Simulator radio stack, so it will not be further
described here except to explain the convention of changing numbers. Click above the
numbers to increase them; click below the numbers to decrease them.
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12.12 The Traffic Window
The Traffic Window shows a table of all the Flight Simulator “artificial intelligence” (AI)
or online traffic within a defined distance of your aircraft. The maximum distance for
the display of AI traffic can be user‐defined on the Options page under the ‘File’ tab.
The default setting is 100 kilometres, approximately 50 nautical miles.

Figure 86 Traffic Window

12.13 VATSIM
Opens a window which lists all Air Traffic Controllers and Pilots currently connected to
VATSIM worldwide, in alphabetical order by call sign. A separate tab is used for pilots
and controllers. All available data is displayed if the window is expanded in width, or
scrolled with the horizontal scroll bar. The vertical scroll bar allows the often very long
list to be fully explored.

Figure 87 VATSIM Pilots World-wide

Figure 88 VATSIM Controllers Worldwide

12.14 Zoom Controls
There are two zoom controls on the View Ribbon. A single click on either changes the
zoom level by one. If the View Window isn’t active, there are a pair of zoom buttons
at the bottom of the map window at the left of the status bar. For those with a mouse
which includes a scroll wheel, the scroll wheel will also zoom the map window.
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In addition there are three configurable preset zoom buttons. By default they are set
to 8 times, 10 times and 12 times zoom level. Clicking the small diagonal arrow‐
shaped launcher button at the bottom right of the preset zoom buttons group opens a
“Set Zoom Presets” window, where you can change the default settings to your choice.

12.15 Keep Window on Top
Click the pushpin icon and Plan‐G stays on top of all other windows. This can be handy
if you are running with two monitors, (you wouldn’t want to use this feature while
flying, with a single monitor), if you have other windows getting in the way on
occasion. It can be a bit unnerving if you have Plan‐G in full screen mode, as it can at
first seem that your computer is not responding to mouse clicks on other running
applications in the task bar.
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CONTEXT MENU OPTIONS
Context menus with appropriate options are available in Plan‐G when you right‐click
on various elements of the display.

13.1

Right-Click on the Map
If you right‐click on any part of the map a dropdown menu is displayed containing
several commonly used functions. The options available from the dropdown vary in
accordance with the way in which Plan‐G is being used. If the DEM Elevation files have
not been loaded, then the version on the left below is displayed. If the relevant DEM
elevation file does exist in the Plan‐G Files\DEM folder, then the version on the right is
displayed, which includes a spot height value.

Figure 89 Right-Click Map Dropdown Menus

If you right click on an Airport. VOR or NDB etc., the dropdown menus are changed
with additional options added appropriate for those features,. If Plan‐G is connected
to FS, P3D or X‐Plane, the right‐click menu has two additional options "Get Fly‐to
Heading, Distance and Time", and “Move FS Aircraft to here”.
13.1.1 Create User Waypoint
You can create custom waypoints anywhere you like on the map without restriction.
This is particularly useful for VFR flight where towns, lakes, hills and other features are
requires as points of navigational reference.
This subject is dealt with in detail in section 14.2.1 below.
13.1.2 Get Fly-to Heading, Distance and Time
If Plan‐G is connected to FS, this option provides a useful quick check on things like
What is the flight time remaining to <the point clicked> from my aircraft, given my
airspeed and the current weather? Will I have enough fuel to get to <the point
clicked>? How far have I come? The option also appears in the dropdown menu
displayed when you click anywhere on the map during a flight. The information is
displayed in a small pop‐up window in the centre of the map window. Clicking ‘OK’ in
the window closes it.
13.1.3 Move FS Aircraft to Here
This can actually be a faster way of relocation to a new airport than can be achieved
via the Flight Simulator menus. However, it is actually a slew manouevre (the ‘Y’ key in
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FS, a feature not implemented in X‐Plane), with some of the quirks of that action such
as blurred scenery (trying to catch up!) and your aircraft sometimes being airborne
when it was previously parked.
13.1.4 Spot Elevation
If the user has downloaded the optional Digital Elevation Model (DEM) tiles from the
NGDC 'GLOBE' (Global Land One‐km Base Elevation) website (see section 12.3 above),
then Plan‐G will display the elevation above sea level of the point which has been
right‐clicked, as the second item on the right‐click dropdown menu (see Figure 89
above).
13.1.5 QDM Range and Bearing
In the early days of radio, when transmission was carried out entirely in morse code,
the “Q‐Code” was a series of letter groups starting with Q, each of which had a specific
meaning. A few, including QNH, QFE and QDM are still used in aviation. QDM means
"What is the Range and Bearing TO a distant point FROM a fixed origin (usually your
aircraft)".
For completeness, you should know that the Bearing FROM a distant point to the
origin, (again usually your aircraft), is QDR. It is sometimes used by real world pilots.

Figure 90 QDM Display

The example above shows the distance from Tokyo’s Shimofusa Air Base to the nearby
Iruma Air Base. The QDM feature can also be usefully used to measure any straight
line distance in Plan‐G, such as the distance between two airports as above. Place the
cursor at the point on the map where your aircraft or selected feature is, and right
click to display the dropdown menu (see Figure 93 below). Select ‘QDM: Range and
Bearing’. A red line will be drawn from the right‐click point to whereever you move
the mouse cursor, with the range and bearing values displayed in the Information
Panel at the top with a grey background to separate it from other information which
may be valid for the point you have selected.
Right‐clicking on the map again will show a check mark on the dropdown menu against
the QDM: Range and Bearing line, indicating that QDM Line drawing is ON. Clicking on
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‘QDM: Range and Bearing’ again on the dropdown menu will remove the check mark
and switch OFF the QDM feature.

Figure 91 Select the Ticked QDM Option to Switch it Off

If you wish to draw a new line, then you must close the QDM option, and right click
again from the new point.
13.1.6 Display and Hide Range Rings
Place the “hand” cursor at the point on the map where you want the range rings to be
centred, and right click. Select ‘Display Range Rings’ from the dropdown menu.
If you want to move them, simply move the cursor to the new location and select
“Display Range Rings” again.
To hide the range rings, right click anywhere on the map and select ‘Hide Range Rings’
from the dropdown menu. Range rings are hidden by default, so if you exit Plan‐G,
they will not be displayed when you re‐start the application.

Figure 92 Displaying Range Rings

Range rings can be set to display in units of distance or time. If time is chosen, the
rings will automatically be distorted to take account of any wind entered in the Winds
dialogue box (see sections 9.5 and 14.1.2).
Range rings do not require you to be connected to FS. They are purely a mapping
display function. You can display as many sets of range rings as you wish. The
example above shows one selection of two rings at 10 and 20 nautical miles radius
centred on Sydney Charles Kingsford‐Smith Airport, with another ring at 10 nautical
miles radius centred on Hoxton Park Airport.
13.1.7 Lock Info Panel
The information displayed on the Information Panel as you move the mouse round the
map can be locked so that the data for a particular area is constantly displayed even
though the mouse pointer is moved away. To lock information, hover the mouse over
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the area on the map which displays the information required, then right click and
select “Lock Info Panel” from the dropdown.

Figure 93 Lock the
Info Panel

Figure 94 Unlock
the Info Panel

To return to changing data as the mouse is moved, right click and select “Unlock Info
Panel”.

13.2

Right Click on an Airport
Right clicking the mouse on an airport symbol opens a different dropdown menu from
the one which is displayed when you right click on the map.

Figure 95 Right-click on an Airport

The dropdown menu shows some options specific to that airport, some to any airport,
and some which also appear on the map right‐click menu. The options are described
below.
13.2.1 Start Flight Plan at Airport
If you right‐click on the departure airport on your plan, selecting “Start flight plan at
airport <ICAO code>" (Plan‐G fills in the ICAO four‐letter code for the selected airport)
is self explanatory. If you right‐click an airport after your departure airport, this option
changes to “Add airport <ICAO Code> to plan”. Figure 95 above has been deliberately
chosen to display almost all of the possible dropdown menu options. If the
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information is not available for an airport, then that option is not included in the
menu. If, as in the example, a VOR is located at the airport, then the option “Add
VOR….” will also be included in the menu options.
13.2.2 Select Alternate Destination
What if you arrive at your destination and you cannot land there? In the real world,
there can be many reasons for this, but in FS, especially when flying on line with
VATSIM or IVAO, etc., there may be an aircraft already on the runway which does not
move as you fly your final approach. You clearly have to land somewhere, and that is
what the “Alternate” box is for in the online flying pilot client flight plans (though it
does not feature in FS created flight plans).
If you select this option, an additional line, but in red, is drawn on the plan from your
destination to the airport you select as your alternate. Importantly, because you don’t
want to be calculating distance, heading and ETA etc., while going around because of
that unmoving aircraft on the runway, the plan displayed in the Plan Window includes
this necessary information for flight to your alternate from your destination. The line
of data for the destination to the alternate leg is shown in red.
Note: The alternate heading and distance is always calculated from your destination,
because standard aeronautical practice worldwide assumes that you fly to your
destination before diverting to your alternate.
13.2.3 Set COM Frequencies
This option is only available when Plan‐G is connected to FS. If you select "Set
frequency on the COM1 Radio", a list of the applicable radio frequencies that have
been defined by FS for that selected airport. (e.g. Tower, Ground, Approach etc.) are
displayed to the right of the drop‐down menu. Selecting the frequency will set the
STANDBY radio display for COM1 in your aircraft radio. You will need to press the
‘Toggle Active‐Standby’ button to activate the frequency, either within FS, or on the
Plan‐G radio stack. If the COM Radio only has an active frequency, such as in the FSX
default AirCreation Trike, Plan‐G cannot set the frequency.
You can select the frequency on COM2 in a similar manner.
13.2.4 Show Airport Diagram
If you select ‘Show Airport Diagram’ from the dropdown menu, the Aerodrome
Diagram is displayed as a pop‐up window (see also Section 12.6 above). You can use
the mouse wheel to zoom in/out, and if you hover the mouse pointer over the parking
spots, runways & taxiways the relevant details are displayed.
13.2.5 Charts
If you create a folder called Charts within the Documents\Plan‐G Files Folder, you can
store charts & instrument diagrams (known as "plates") there. Airport charts may be
stored as pdf files or as jpg image files. Other formats will not be recognised by Plan‐
G.
The usual source of pdf airport charts is the Civil Aviation Authority, or similar
Government Agency for your country. Most countries now store airport charts on
their Civil Aviation Authority websites, including runway and taxiway layouts,
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instrument approach plates, parking diagrams etc. Because these charts often have
coded filenames and there may be many of them for a particular airport, in order for
Plan‐G to display them, you must create a sub‐folder for each airport and put all the
relevant charts in that folder.
Note: The subfolders must be named using only the ICAO code for the airfield, (e.g.
Charts\EGBJ, Charts\EIDW, Charts\KLGA, etc.) otherwise charts will not be displayed.
If you use John Allard's airport diagrams, downloadable from the Mutley's Hangar
flight simulator community website, these comprise only one file per airport in jpg
format, which is simply a drawing of the data stored in FS9. They have standard
filenames <ICAO Code>.jpg. e.g. EDDG.jpg. Plan‐G can identify these files without
needing them to be stored in a subfolder. For convenience, however, it is
recommended that they are all stored in a single subfolder of your Charts folder.
Section 8.10.6 above describes how to set up the path for the Allard charts so that
Plan‐G can find them.
The context menu for any airport for which you have stored a chart or charts, will
include the option "Charts" when you right‐click on that airport. Then if you hover the
mouse over "Charts", the file name(s) of any charts thus stored are displayed alongside
the context menu and can be selected with the mouse. Selecting one of the charts
from the context menu will display it in its own window.

Figure 96 Plan-G finds the Allard Chart for Friedrichshafen EDNY

13.2.6 Instrument Approaches
If an airport has instrument approaches built into FS, then there is an option in the
airport right‐click dropdown menu to display them. They are much simplified versions
of real world Instrument Approach Plates, but if you are unfamiliar with instrument
approaches, then you will want to know what the diagrams mean.
When you first click on the Instrument Approach option, there may be a pause while
Plan‐G loads the information, then a small “Approaches” window is displayed showing
all the approach procedures available for that airport in FS. (There may be several
others available for real world flight.)
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Figure 97 Instrument Approaches Pick-list for Mombasa Airport, Kenya

The window is split in two by a black divider bearing the word “Transitions”. If you
click on one of the displayed approach procedures, two things happen: ‐
•

A blue line and a red line appear overlaid on the Plan‐G map at the airport

•

Some codes appear below the “Transitions” divider in the Approaches box.

Figure 98 Runway 21 ILS Procedure, Mombasa

The blue line is the track the aircraft should be flying inbound to the airport on the
runway heading, approaching the Final Approach Point (FAP). In the UK, this is
typically between 4 and 7 nautical miles from touchdown, depending on how cramped
the airspace is around the airport. In the USA and Canada, where congested airspace
is less of a problem, this can be 10 or more nm from touchdown.
The red line is the Missed Approach track. If you do not have the runway in sight by
about 2/3rds of a nautical mile before touchdown (200ft above the airfield elevation),
called the Missed Approach Point (MAP), then you must carry out a Missed Approach.
As illustrated, you fly the runway heading outbound for 3 or 4 nautical miles, climbing
to, typically, 1,500 feet above the airfield elevation, then make a rate one turn
inbound back to the beacon (followed in the illustrated case by a “racetrack” holding
pattern, which is flown until cleared by ATC to “continue with the procedure” in which
case you fly the blue trackline once more in the hope of seeing the runway second
time around. Alternatively, and actually more commonly, ATC will vector you to a new
approach, as this saves time overall.
The codes below the “Transitions” divider, in the lower half of the Approaches
window, may be 2, 3, 4 or 5 characters, and are the ICAO identifiers for the transition
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points. Typically, if a transition point is an NDB, it will be two letters, a VOR, three
letters and so on.
If you click on one of the Transition Points, then the blue line gains an extra line,
which is the lead in from the Transition point to the Initial Approach Fix (IAF) and
continuing on to the FAP. It may be a “procedural turn”, which is typically teardrop
shaped, or an inbound track from a VOR to the FAP.

Figure 99 Lead in Procedural Turn to the MOV VOR Transition Point

The transition points are the points at which your en route navigation ceases and you
begin to fly the Instrument Approach Procedure (IAP) or “the procedure” as it is
popularly known. Transition points will always be a VOR, an NDB, or an intersection
(see section 10.3 above for an explanation of an intersection).

Figure 100 Instrument Approach fixes added to a Flight Plan

If the transition point is an NDB or VOR located on the airfield, (e.g. Manchester) then
the procedure will be a procedural turn. If, as is sometimes found, there is an NDB on
the runway extended centreline and approximately 3 nautical miles from the
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threshold, (e.g. East Midlands), the transition point, and the IAF, will both be the NDB,
and the procedure will start from there.
FSX includes RNAV approach procedures for the USA and Canada, but UK transition
points will almost always be VORs or NDBs.
Clicking the 'Clear' button removes the instrument approach procedures from the
map. 'Add to Plan' adds the transition point fixes to your plan before the destination
airport. They are displayed in a lighter colour to differentiate them from en route
waypoints.
13.2.7 METAR and TAF
One of the minor miracles of Plan‐G is its ability to fetch both the current real world
weather (METAR) and forecast weather (TAF) for any airport within its database which
has an associated weather station. Figure 95 above shows the one‐line METAR,
followed by a two‐line TAF, although it is not always two lines. It may only be one line
or even three. The weather information is incorporated within the right‐click drop‐
down menu and information for that airport. For airports which do not have an
associated weather station, or for which there is no current information, Plan‐G
displays no weather, rather than use the nearest available.
Note: the "Download Weather from NWS" option must be set (access via the File tab,
in Options/Weather), for METARS and TAFs to be shown. There is a short delay after
initial startup before weather data is available. There is also a slight delay when right‐
clicking an airport, before the dropdown menu displays, while Plan‐G gets the weather
information.
13.2.8 Other Selections
The other selections in the Airport right‐click dropdown are: ‐
•

Get Fly‐to Heading, Distance and Time

•

QDM Range and Bearing

•

Move FS Aircraft to Here

•

Display Range Rings

•

Spot Elevation

•

Hide Range Rings

These options are also available on the Map right‐click dropdown and are described in
section 13.1 above which deal with that function.

13.3

Right-Click on a VOR or NDB
If you right‐click on a VOR or NDB rather than an airport or an undefined point on the
map, several more options are available.
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Figure 101 Right Click Menu on a VOR with FS Connected

13.3.1 Set VOR Frequency on NAV Radio
This option is only available when Plan‐G is connected to FS. If you right‐click on a
VOR, the context menu will also include the option to set the selected VOR frequency
on the NAV1 or on the NAV2 radio. Selecting the NAV1 option will set the STANDBY
radio display for NAV1 in your aircraft radio if it has active/standby options, (such as
the default Cessna 172). If necessary, you will need to press the ‘Toggle Active‐
Standby’ button to activate the frequency, either within FS, or on the Plan‐G radio
stack. If the radio only has an active frequency option, such as in the default Beech
Kingair, then Plan‐G cannot select the frequency in this way.
You can set the frequency on NAV2 in a similar manner.
13.3.2 Set NDB Frequency on ADF Radio
If you right‐click on an NDB, the context menu will include the option to set the
selected NDB frequency on the ADF radio.
13.3.3 Show Radial
When ‘Show Radial’ is selected. A small sub‐menu appears which allows you enter a
radial and distance FROM that navaid. On clicking ‘OK’ the radial line is displayed on
the map as a thin purple line. You can repeat this multiple times from the same or
other navaids, allowing you to plot the intersection data of a point you may wish to fly
to. You can create as many radial lines as you wish. A single 'Clear All Radials' option
on the dropdown menu will remove all radial lines from the map. Radials are entered
and displayed are in degrees magnetic. A checkbox allows you to select the radial as
'inbound' which shows the radial line TO the navaid from the point the specified
distance from it..

Figure 102 The "Show Radial" Dialogue
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Figure 103 The Radial Displayed

13.3.4 VOR Range
If you right‐click on a VOR or NDB there is another option ‐ VOR Range (or NDB Range).
This option is context sensitive as you would expect. Selecting the option shades the
map a pale blue in a circle which represents the guaranteed range of transmission of
the Navaid signal. For VORs this is commonly 195 nautical miles. For NDBs 10 nautical
miles is typical, but there are some longer range NDBs (and some shorter range VORs
too ‐ only 75 nautical miles). To clear the range display, right‐click the Navaid again
and select the VOR/NDB Range option. Alternatively you can open the View ribbon
and click the "Map Overlays" tickbox twice. The first click clears ALL overlays; the
second click restores the aeronautical data without the VOR range display.
These options are also available if you right‐click on an airport which has a VOR or NDB
located at the field or, in the case of a VOR, within 10 nautical miles of it.
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FLIGHT PLANS
This section describes the all important procedures for creating, amending, saving,
loading and deleting flight plans. There are two basic methods of creating flight plans:
a) Graphical
b) Tabular

14.1

Creating a Flight Plan Graphically
This method is intuitive and fast, and will almost certainly be the choice of most users
for creating a new flight plan.

14.1.1 New Flight Plan
When Plan‐G is started, the Home ribbon and map are displayed. The map opens with
the view and zoom level that was current when Plan‐G was last closed. No flight plan
will be shown, but the normal overlay data will be displayed. Plan‐G is ready to create
a new flight plan.
If a flight plan has been loaded and is displayed, this can be erased, ready to create a
new plan, by one of the following actions: ‐
a) Click the “File” tab at the top left of the main Plan‐G window to open the drop‐
down menu, then click on “New Plan”, or,
b) Click the New Plan icon on the Quick Access Toolbar (See Section 6.1 above for
details of the Quick Access toolbar).
14.1.2

Flight Conditions
The “Home” ribbon menu contains the options you need to set up the conditions for
your new flight plan. The selections made here are used to calculate the headings and
elapsed leg times, and are dynamically adjusted in the Flight Plan if you make changes.
These conditions are saved to your new Flight Plan when you click the "Save" or “Save
As" buttons.
Altitude, Cruising airspeed, Wind and VFR or IFR can be entered before or after
creating the plan, but Start Position (e.g. Parking, Ramp, Active Runway) can only be
entered once the start location of a flight plan has been created (see section 14.1.6
below).

Figure 104 Setting Flight Plan Conditions

14.1.3 Aircraft Profile
Using an aircraft profile is an optional feature which influences how Plan‐G fits a flight
plan to the aircraft which is going to fly the route. You can build a plan without using
Aircraft profiles at all, and make your own judgements on how to execute the flight
with regard to the aircraft’s performance characteristics, or you can load the
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performance characteristics of your favourite aircraft, and Plan‐G will attempt to tell
you whether you can fly from New York to San Francisco in 6 hours in a Beech Baron
(very unlikely).
To use an aircraft profile, select the Aircraft Profile icon from the Home ribbon. The
Aircraft Profile dialogue screen is then displayed overlaid on the map. Click the
"Open" button in that screen to display a file window from which you can select a
suitable aircraft profile. The aircraft profile window will be populated with data. Now
close the window by clicking the usual "Close" icon at top right. You will know when
the profile is being used, because the small Plan‐G version "label" at the centre top of
the header will include the aircraft type and registration that you have selected. Plan‐
G will now use that aircraft profile to help calculate your route parameters such as
climb and descent profiles, fuel performance etc.
Note: Throughout this manual, with this one exception, the Plan‐G Version label is omitted on
screenshots where it would normally appear, in order to avoid having to unnecessarily update many of
the otherwise unchanged screenshots when a new version of Plan‐G is published.

Figure 105 The Beech Baron Aircraft Profile

See section 9.6 for information on creating aircraft profiles.
14.1.4 Departure Airport
First find your departure airport on the map. If it is visible on the current map, then
move the mouse pointer over the airport icon, and right‐click. If it is not visible on or
near the current map display, you can zoom out or pan by dragging the map with the
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mouse. Alternatively, you can click on the “Find” button on the Home menu ribbon
(far left).
Clicking on the upper half of the "Find" button allows you to search for your starting
airport. If the searched for item exists in your simulator’s database, it will be found. If
you enter only part of the ICAO code, Plan‐G will list all airports whose ICAO codes
start with that combination of characters. Search text is NOT case sensitive.
The "Add to Plan" and "OK" buttons in the Find Airport window are greyed out until
you have selected at least one airport in the list. When you click on the ‘OK’ button on
the Find Airport window, the map is centred on that airport.

Figure 106 Using the Find Function to Locate an Airport

Now right‐click on the required departure Airport on the map and select “Start flight
plan at airport <ICAO code>". (Plan‐G fills in the ICAO four‐letter code for the selected
airport).

Figure 107 Right-Click Dropdown - Start Flight Plan
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14.1.5 Continue to Add Waypoints
You now can add further waypoints which may be any map
feature you wish. If it is an aeronautical feature and you can see
it on your map, simply right‐click on the feature and select the
first option ‘Add <Feature> to Plan’.
If you can’t see your next waypoint, then either pan the map
with the mouse or use the ‘Find’ function on the Home ribbon.
Clicking on the lower half of the "Find" button drops down a list
of objects you can search for:
•

Find Airport. (In MSFS and P3D, you can search by ICAO code,
airport name, or city; and in X‐Plane, you can search by ICAO
code or Airport name).

•

Find NDB (Search by 3‐letter identifier or by partial name).

•

Find VOR (Search by 3‐letter identifier or by name or partial
name).

Figure 108 Find
Options Dropdown
List

• Find User Waypoint
Once the feature is displayed on the map, right‐click on it and select ‘Add <Feature> to
‘Plan’ from the dropdown.
The Feature can be an airport, an NDB, a VOR, or a User Waypoint. Its name and ICAO
code are displayed in the dropdown menu, so that you know you have selected the
right one. The example below shows the result of right‐clicking on the Clonmel NDB
(CML) near Waterford, Ireland.

Figure 109 Right-click Dropdown – Add Waypoint to Plan

The map will now show a track line from your start location to the new waypoint, and
the new waypoint will appear in the Plan table when the ‘Plan’ icon is clicked on the
‘View’ ribbon. Continue with each subsequent waypoint in the same way until you
have added your arrival airport. At each step, the track line will update and each
waypoint will be added to your Flight Plan.
Note that waypoints are added to the Plan in sequence, so if you decide to add an
intermediate waypoint after you have “gone past it”, your track line will double back,
which is probably not what you intend. See Section 14.4.3 “Moving and Deleting
Waypoints” below for the way to correct this.
Once you have selected your starting airport, if you click on another airport as a
waypoint, the second option on the right‐click dropdown is “Select Alternate
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Destination”. See section 13.2.2 above for details on adding an alternate. It is good
airmanship, if not mandatory, to always enter an alternate.
14.1.6 Insert an Intermediate Waypoint
If, as many pilots do, you decide your departure and arrival points before looking at
what intermediate waypoints you wish to go to, then you can do this on the map.
Once the basic plan has been created, open the Plan Window if it isn’t already open,
and click on the waypoint of the plan before or after which you wish to add a
waypoint.

Figure 110 Insert Intermediate Waypoint

Then go to the Map and right click on the intermediate waypoint you wish to insert. A
pop‐up menu appears which provides two options for inserting an intermediate
waypoint – either before or after the waypoint on the plan which you had selected in
the tabular Plan.
Note that in Figure 110 above, the Plan‐G generated user waypoint label BC03 has
been added to the screenshot alomngside the waypoint symbol near the top to identify
the waypoint mentioned in the dropdown menu. Normally it is not displayed unless the
mouse is hovered over the waypoint.
14.1.7 Start Position
A Start Position on your departure airfield can be entered once the Start Airport of
your plan has been created. Until then, the ‘Start Position’ icon on the Home ribbon is
greyed out. You can of course complete your plan, be it a direct track plan, or one
involving a number of waypoints, and add the Start Position at the end of the process
just before saving the Plan. This feature is available in all supported simulators.
To use this option your plan must be exported to a .PLN file. Then, if you have added a
start position in Plan‐G and load your .PLN format plan into Flight Simulator, when FS
asks if you want to move your aircraft to the departure airport listed on the flight plan,
and provided you click “Yes” your aircraft is moved in FS, not to the active runway,
which is the FS default, but to the start position you selected in Plan‐G. If you are
flying online, then this position should be a starting gate or GA ramp, and definitely
NOT the active runway.
This option is only available in Microsoft FS9 and FSX.
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Figure 111 Move your Aircraft, but not to the Active!

14.1.8 Save your Plan
Once you are satisfied with the sequence of waypoints, passing altitudes and notes in
the Plan table, save the plan as described in section 8.3.
However, you will have noticed that there are blank fields in the plan. These fields;
Passing Alt, ATA, XRef1, XRef2 and Notes are not filled in when creating a Flight Plan
graphically.

Figure 112 The Completed Flight Plan - So Far

14.1.9 Passing Altitudes
Passing altitudes cannot be done graphically, but requires the parameters to be
entered from the keyboard. It can be done by entering the details in the Plan, once
the flight plan route has been completed graphically. See section 14.2.3 below for full
details.
14.1.10 ATA
ATA is the standard aviation abbreviation for Actual Time of Arrival. This field cannot
be edited by the user. The ATA times (UTC) are entered by Plan‐G as the flight
progresses. The time is recorded in the plan if the aircraft passes within 5 nautical
miles of the waypoint. On departure, the time that the aircraft starts to move (brakes
off) is recorded. On approach to the destination, the time is recorded when the
aircraft is still airborne and 5 nautical miles away, so cannot be used for accurate flight
time logging, which is normally calculated from brakes off to brakes on.
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14.1.11 Cross References
XRef1 and XRef2 are automatically entered if you right‐click on a waypoint and select
"Set Waypoint Cross References" from the dropdown menu. They cannot be set
graphically. See section 14.3.4 for full details.
14.1.12 Notes
Adding notes to a flight plan is carried out from the keyboard. It can be done by
entering the details in the Plan, once the flight plan route has been completed
graphically. Open the Plan Window. Scroll across to the “Notes” column and double
click the appropriate cell. You can now enter free text to add any important
information for that leg of the route. The cell expands to accommodate the text
entered.
14.1.13 The Reverse Button
This button automatically reverses the sequence of waypoints in a loaded flight plan
and recalculates the bearings to create a new flight plan for the return trip, assuming
you want to go back along the very same route. The window title in Plan‐G will reflect
a new name for the reversed flight plan, and when you save it, Plan‐G automatically
changes the name for the new, reversed plan.

14.2

Creating a Flight Plan in the Plan Window
Although you may find it less intuitive, Plan‐G nonetheless allows you to add, move or
delete waypoints directly in the Plan Window. This could be convenient, for example,
when transcribing a flight plan from a printed form or a handbook.
First click the ‘New Flight Plan’ icon on the Quick Access toolbar to clear any loaded
data from Plan‐G. The departure airport must now be chosen by either right‐clicking
on its symbol on the map, or by using the ‘Find’ menu at the top left of the Plan‐G
window. Now that there is a single waypoint in the new flight plan, the ‘Plan’ window
will contain a single line containing the departure airport, plus a line in the summary
box below the brown divider bar, although it won’t be meaningful at this point.

14.2.1 Adding Waypoints to the Plan Table
The next waypoint, or the destination airport, can now be entered into the table.
Right‐click on the table entry for the departure airport, and select ‘Insert Waypoint
Below’.
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Figure 113 Adding a Waypoint to the Plan Table

This pops up an ‘Insert Waypoint’ panel, where you can select the type of waypoint
(Airport/VOR/NDB/User Waypoint) to add. The waypoint to be added can be found
either by its ICAO code or by its name. If it exists in the Plan‐G database, then as you
type, Plan‐G will find all relevant entries and display them below the entry line. As you
enter a few letters of the name or ICAO code, Plan‐G will display only those entries in
the database containing those letters (in any position and in either the ICAO code field
or the Airport Name. In the example above, the letters ‘Eidel’ were entered which
showed a list of airfields, not starting with those letters, but containing those letters,
from which the one required can be chosen.
Once the desired waypoint is found, clicking ‘OK’ will insert it into the Plan table, and
will extend the track line on the Plan‐G map to the new waypoint.
14.2.2 Add Further Waypoints
You can continue to add waypoints in this way to build a complete route. You can add
Airports, VORs, NDBs, or predefined User Waypoints from the 'Insert Waypoint’ panel.
However, this method of building a flight plan does not permit the addition of
temporary user waypoints. Temporary user waypoints ‐ those which are not saved in
the database ‐ can only be created by right‐clicking the map and selecting 'Add User
Waypoint to Plan' from the dropdown menu.
14.2.3 Passing Altitudes
The altitude at wish you wish to pass each waypoint may be added to the Plan table by
clicking the "Passing Alt" cell for each waypoint in the table. These values are targets
only; the aircraft will only pass the waypoint at the set altitude if you fly it at that
altitude.

Figure 114 Inserting Passing Altitudes in a Plan Table

Passing altitudes must be entered in the Plan table. They cannot be added by clicking on
the map. The passing altitudes are displayed in the Plan Elevation window as part of the
'Planned Altitude' line (see Figure 115 below).
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Figure 115 Passing Altitudes in the Plan Elevation Window

See also Section 14.5 which describes a more developed use for Passing Altitudes
14.2.4 Notes
Open the Plan Window. Scroll across to the ‘Notes’ column and double click the
appropriate cell. You can now enter free text to add any important information for
that leg of the route. The cell expands to accommodate the text entered.
14.2.5 Save Your Plan
Once you are satisfied with the all the information in the Plan table, save the plan in
the usual way.
Note: If you export it as a .PLN file for use within Flight Simulator, cross references,
passing altitudes and notes cannot be saved. All these are saved only in .PLG files.
Therefore it is recommended that you save the Plan as a .PLG file first to preserve all
that additional Plan‐G data, and then export it.

14.3

Right-Click Options in the ‘Plan’ Window
As well as adding new waypoints to a Plan table, there are a number of other options
for modifying your plan.

14.3.1 Set This as the Active Leg
Clicking this option sets the 'active' leg for calculating time & distance to next
waypoint. It is only useful if connected to FS and where you may have opened a flight
plan part way through a flight. Setting a new active leg allows you to “pick up” the leg
in the flight on the flight plan which your aircraft is currently flying. Put another way,
(and it is not exact of course) it “sort of” synchronises your flight to the plan. It can
also be useful if
•

The pilot misses a waypoint completely, and wants to tell Plan‐G to forget pointing
to the last waypoint, but to now help get to the next one, or

•

The flight plan has been changed mid‐flight, or

•

The leg sequencing goes awry in Plan‐G for some reason

14.3.2 Centre on Map
If you right click on a waypoint in the plan, the map moves to position that waypoint in
the centre of the map.
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14.3.3 Insert, Move or Delete Waypoint
Waypoints can be inserted or moved up or down in the table, or deleted from the
plan. Right click the entry in the table you wish to move or delete, and select the
appropriate menu option from the dropdown. See Figure 116 and Section 14.4 below.

Figure 116 Flight Plan Waypoint Dropdown Options

14.3.4 Cross References
Cross references are useful for defining a waypoint precisely using vector geometry.
For the non‐mathematically inclined, it means that any point on a map can be
precisely identified by an angle and distance from a point. You can also get a “fix” if
you have only the angle from two known points relative to a common axis. That
principle is called “Triangulation”. In aviation, the angle is of course the Magnetic
Bearing from the waypoint (QDR) and the common axis is Magnetic North.
In flight, if a pilot tunes in a VOR on his NAV1 radio, then turns the Omni‐bearing
selector (OBS) until the CDI needle is centred and the “TO” flag is displayed, and also
observing the DME instrument, the pilot is able to obtain a “position fix” for the
aircraft, which will be, for example, 262o TO the VOR (i.e. broadly to the west of the
aircraft) and 22.4 miles from it. In other words, In aviation terminology, the QDM to
the VOR is 262o, range 22.4 nautical miles.
By selecting a second VOR within range and carrying out the same exercise, the
position fix may be confirmed, or the accuracy of the pilot’ s rough plot on the chart
improved (remember he/she is flying the aircraft at the same time!) Ideally the radials
from the two VORs should intersect as nearly at right angles as possible.
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Figure 117 Position fix from two VORs

In Plan‐G, if you select “Set Waypoint Cross References”, you can enter two radio
Navaids in the dialogue box which opens. Click the “Add” button for the first cross
reference then select the table you wish to search – either VOR or NDB, by clicking the
appropriate tab at the top of the window. Now select a Navaid, either by typing in the
ICAO Identifier, e.g. BPK for Brookmans Park VOR, or pick the one you need by scrolling
down the (very long, worldwide) database of Navaids displayed.

Figure 118 Set Waypoint Cross References

Figure 119 Waypoint Cross References Dialogue
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The vector lines are drawn on the map, and the bearing TO the Navaid (QDM remember)
and distance are shown in the flight plan, in the Information Window, and included in
the Pilot’s Log (PLOG). To use this information to arrive at the waypoint, you need to
turn the Omni‐bearing selector (OBS) until the “TO” flag is displayed, and the CDI needle
is centred. Note the bearing indicated at the top of the instrument. Turn the OBS again
until the Plan‐G QDM is indicated and fly a closing heading until the CDI needle is again
centred. Observe the distance on the DME instrument and turn onto the QDM heading,
keeping the CDI needle centred until the Plan‐G distance is displayed on the DME. Then
you will be at the waypoint. For example: the Plan‐G QDM is 262o and you are south of
VOR1 in Figure 117 and flying heading 030o. Turn the OBS to 262o, turn the aircraft onto
a closing heading between 45o and 90o towards it, say – 350o and then turn heading 262o
as the needle starts to centre. (see section 13.1.5 above for an explanation of “Q
codes”).
When using two NDBs for cross references, Plan‐G is a bit smarter than real world NDBs,
because it provides distance information, which real world NDBs do not. If you use two
NDBs in the real world your fix is provided entirely by the intersection of the two
indicated ADF bearings.
Warning: Make sure if you enter an ICAO code that you have selected the correct
waypoint type. In the flight plan below, someone selected “CAM” for the Cambridge
NDB, but from the VOR table, and got a silly result ‐ 2,895.3nm! The CAM VOR happens
to be near Schenectady, New York State, USA, not near Cambridge, England! It is the
CAM NDB which is on Cambridge (UK) Aerodrome, and which makes a good cross
reference for Duxford!

Figure 120 The Wrong CAM!

14.3.5 Quick Snippet
This is a time saving feature for inserting intermediate waypoints in a tabular Plan.
Open the Plan window and right‐click the waypoint AFTER which you wish to insert the
intermediate waypoints and select the ‘Insert Quick Snippet’ option. The Quick
Snippet dialogue opens. Enter the identifier of the waypoint(s) you wish to insert,
separated by space characters as shown in Figure 121 below. The waypoints will be
inserted in your Plan, and the map updated, with the new waypoints. If you try to
enter a text string other than the waypoint identifier, such as its name, or if you
separate the waypoints by commas, dashes or any other character, Plan‐G complains
by turning the dialogue box pink. However, it will not complain if you enter them in
the wrong order – it is up to you, the user, to get that right.
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Figure 121 The Quick Snippet Dialogue

Figure 122 Entry Text Format Error Alert

Figure 123 Part of a Direct Route Popham to Perranporth

Figure 124 The Modified Route via Henstridge and Dunkeswell

Some third party scenery developers sometimes add non‐standard identifiers to their
products such as 4 character codes for NDBs. These are not recognized in Plan‐G.
There is technically no limit to the length of the inserted text; the number of
intermediate waypoints you can add. The limitation will be one of practicality.
14.3.6 Insert Snippet File
If you have exported a flight plan as a snippet (See Section 8.6 above) , it can be
inserted into other flight plans. Snippets can be any length, any number of waypoints,
but again, the limitation will be one of practicality.
Open the Plan window and right‐click the waypoint AFTER which you wish to insert the
intermediate waypoints and select the ‘Insert Snippet File’ option. The
Documents\Plan‐G Files Folder window opens. Select the file you wish to insert and
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click ‘Open’ at the bottom right of the window. After a slight pause, the Folder
window disappears and the Plan Window will be displayed with the waypoints from
the snippet inserted in your Plan, and the map updated with the new waypoints,
exactly the same as shown in Figure 124 above.
14.3.7 Add Alternate
This option is described at section 13.2.2 above.
14.3.8 Set Author
If you want to be recognised as the world leader in creating Plan‐G flight plans, then
click this option and enter your name in the dialogue box. Now when you send your
plans to others, your fame will go with you.

14.4

Modifying Existing Flight Plans
With a previously‐created flight plan opened in Plan‐G, you can either: ‐
•

Add one or more waypoints to the end of the existing chain of waypoints,

•

Insert a new waypoint between two existing waypoints.

14.4.1 Adding a New Waypoint to the End of a Plan
Adding a new waypoint to the end of the sequence is just a matter of right‐clicking it in
the map and selecting "Add <waypoint ID> to plan". You then "Save" or “Save As" the
changed flight plan, as described above.
14.4.2 Inserting a New Waypoint
Inserting a waypoint between two others in a flight plan must be done in the Plan
Window. Open the Plan window and right‐click on the entry above or below which
you wish to insert a new waypoint. Select either ‘Insert Waypoint Above’ or ‘Insert
Waypoint Below’ according to where you wish to insert the new waypoint. This pops
up an ‘Insert Waypoint’ dialogue, where you can select the type of waypoint to be
inserted (Airport/VOR/NDB/User Waypoint).

Figure 125 Inserting a Waypoint
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The waypoint to be inserted can be found either by its ICAO code or by its name. If
the desired waypoint exists in the Plan‐G database, as you type, Plan‐G will find all
relevant entries and display them below the entry line. As you enter a few letters of
the name or ICAO code, Plan‐G will display only those entries in the database, not
starting with those letters, but containing those letters, from which the one required
can be chosen.
Select the one you want (often there will be only one if you enter a unique identifier)
by clicking on it to highlight it, then click ‘OK’. Clicking ‘OK’ will insert it into the Plan
table, and show it on the Plan‐G map, and will move the track line to match the order
of entries in the table.
14.4.3 Moving and Deleting Waypoints
You can of course move waypoints up or down in the table, or delete them. See
section 14.3.3 above for details.
14.4.4 Save Your Edited Plan
If you have edited your Flight Plan by adding or inserting new waypoints, for example,
and wish to keep the original as well, then go to the File Tab and select “Save As”,
select either a .PLG or a .PLN file, and give the modified plan a new name.

14.5

Vertical Navigation Profiles

14.5.1 User Defined VNAV Profile
You can build a custom vertical navigation (VNAV) profile in Plan‐G if you wish. At key
waypoints, where altitude is critical, such as controlled airspace boundaries or high
terrain, you can fix the altitude to fly. Plan‐G will not fly the profile for you, but will
Plan‐G calculate a Top of Descent (ToD) point based on your current altitude and true
airspeed. Load a flight plan and open the Plan Window. Scroll across to the right of
the plan to the “Passing Alt.” column. Double click the appropriate cell in the column
and enter the desired altitude. Enter the value without a comma separator for 000s,
although if you do include a comma separator, Plan‐G will remove it.
If you now open the Plan Elevation window, you will see your Vertical Navigation
Profile displayed as a solid orange line. If the Plan Elevation Window is open when you
enter passing altitudes, the VNAV profile is not displayed until you close and reopen it.
When you fly the route, one minute before the ToD point, an alert sound is played and
a popup message, “One minute to VNAV Profile” is displayed.
14.5.2 Default VNAV Profile
If you choose not to build a vertical navigation profile, Plan‐G builds a default one
anyway, based on the diagram below.
Plan‐G calculates a Top of Descent (ToD) point based on your altitude and true
airspeed. For example, if you are flying at 120 knots (2nm per minute) at 3,000ft, and
the rate of descent is set at 500ft per minute, then to descend to 1000ft will take 4
minutes, in which time you will have travelled 8 nautical miles. The target position is
normally 1000ft above the destination and 3 miles before it – i.e. at circuit height and
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in a comfortable position to join the visual circuit. So the ToD point in this case would
be 8nm + 3nm = 11nm from your destination.
One minute before the ToD point an alert sound is played and a popup message, “One
minute to VNAV Profile” is displayed. In the example above, this would be 13nm
before touchdown.

Figure 126 Vertical Navigation Profile Diagram

A second alert sounds at a specified altitude above the target altitude, and a further
popup “,specigfied altitude> to target altitude” is displayed.
The default <specified altitude> is 1000ft above the target altitude. Vertical navigation
profile parameters are all user configurable via the File tab, in Options/GPS Panel, see
section 8.9.5 above).
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USER WAYPOINTS
Plan‐G builds an internal database (PlanG_FSX.sdf or PlanG_FS9.sdf) of airports and
navaids based on a scan of the FS scenery configuration file. User Waypoints together
with official “Visual Reference Points” are contained in a separate database within
Plan‐G, namely, UserWaypoints.sdf. Plan‐G includes a large number of pre‐defined
User Waypoints, as shown in Figure 127 below and you can also add your own.

Figure 127 The User Waypoint Database

15.1

Creating User Waypoints
You can create custom waypoints anywhere you like on the map without restriction.
This is particularly useful for VFR flight where towns, lakes, hills and other features are
required as points of navigational reference.
Right click the map at the point where you want to create a user waypoint to display
the dropdown menu which includes the Create User Waypoint option.

Figure 128 User Waypoint Dropdown

Click the Create User waypoint option and a dialogue window opens for you to enter
the details.
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Figure 129 Create User Waypoint Dialogue

Enter the waypoint name and an identifying code ‐ which can be up to 8 characters in
length. The magnetic variation (Variation) at that point and the Latitude and
Longitude are automatically added by Plan‐G, but you can edit them to fine tune a
waypoint position to an exact spot if your mouse clicking isn’t so accurate.
If the appropriate DEM files are installed (as described in Section 12.3 above), Plan‐G
will automatically fill in the Elevation for the new User Waypoint.
Click “OK” to save the waypoint.

Figure 130 User Waypoint Created

The waypoint symbols which are shown on the map depend on the type defined in the
dialogue (Figure 129 above). Figure 130 shows that the Olga Range of Hills in South
Australia are a Point of Interest

Figure 131 User Waypoint Type Symbols
The waypoint is saved in the User Waypoint Database which can be manipulated in a
similar way to a spreadsheet (see Section 11.4 below). Go to the ‘Data’ tab, click on
‘Manage User Waypoints’ to open the User Waypoint Database as shown in Figure 132
below.
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Figure 132 User Waypoint Added to Database

15.2

Adding a New User Waypoint to a Flight Plan
Right click the new User Waypoint on the Map, and the Name of the waypoint will be
displayed as the first item on the dropdown menu, as ‘Add User Waypoint The Olga
Hills to Plan’.

Figure 133 Add User Waypoint to Flight Plan

Select this option and the waypoint is added to the Flight Plan. The new waypoint is
added as the last item. Right click on the flight plan to display the dropdown menu
which allows you to move the new waypoint into its correct position. The track line
will adjust accordingly. (See section 14.4.3 above for more on editing flight plans.)

15.3

Modifying User Waypoints
You may wish to move a waypoint slightly, change its name or identifier. If you right
click on the new waypoint, the dropdown has three new items which are reasonably
self‐explanatory. If you select “Edit User Waypoint” the Create User Waypoint
dialogue is again displayed, although now with the window title “Edit User Waypoint”
at the top. You can make changes directly in the text boxes, including moving the
waypoint by changing the Latitude and/or Longitude values.
If you rename a waypoint that is included in the current flight plan, the plan will be
updated to reflect the change. Any plan that is not currently open will, of course, not
be updated.
Note: New User waypoints cannot be created directly in the waypoint Table. You
must create them using the method described in section 15.1 above.
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Deleting User Waypoints
To delete a User Waypoint, right click on the new waypoint, and select ‘Delete User
Waypoint from Database’ from the dropdown menu. The waypoint is immediately
removed from the database, and the map, but not from the current flight plan or its
track line on the map.
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AN EXAMPLE FLIGHT PLAN
Much of Plan‐G is intuitive. You don’t need this comprehensive manual at all. So, for
those who don’t have time to read manuals, but just want to get going, here is a
worked example of a short VFR flight across some of England’s most beautiful and
famous landscapes. It introduces as many features of Plan‐G that can be reasonably
packed into a short 115 mile flight.

Figure 134 Carlisle to Liverpool – The Route

16.1

Preparation
Just as in the real world, there is a significant amount of preparation required before
flight. Of course we will start by creating a flight plan in Plan‐G.
1.

Open Plan‐G and on the Home Tab, click “Find”.

2.

Select Airport from the dropdown and enter EGNC in the ICAO Code box.

3.

Carlisle will be highlighted. Click OK.

4.

Right‐click the airport icon and select “Start Flight Plan at airport EGNC”

5.

Now set up the flight conditions. Open the Home Ribbon by clicking the Home
tab, and then click Altitude, and set 4,000 feet.

6.

Select Airspeed, and enter 100 knots for the default Cessna 172.

7.

Now that you have a Start Location, you can now add a Start Position for your
aircraft at Carlisle. In FS, you have already selected PARKING 1 ‐ RAMP GA
SMALL, so from the Home Ribbon, select “Start Position”. From the options
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shown in the pop‐up “Set Airport Start Position” window which appears, select
PARKING 1 ‐‐ RAMP GA SMALL again, and click OK.

16.2

The Scenic Route
You have established the flight pre‐conditions and now it is time to plot the route to
Liverpool.
1.

Find the Wigton VRP to the south‐west of Carlisle. Right click and select “Add
User Waypoint CARLISLE WIGTON to the plan. (Wigton is a Visual Reference
Point and included in the default Plan‐G database, although it is called a User
Waypoint).

2.

If you do not have photographic scenery for the UK, Wigton (the town) will not
be obvious, so you may wish to add a Cross Reference to it from Dean Cross VOR.
Right‐click the Wigton VRP symbol and select ‘Set Waypoint Cross References’

3.

In the Cross reference window, click ‘Add’ for the first point, and enter “DCS” in
the entry box. Select the Dean Cross (the only) entry, and click OK

4.

Observe the Cross reference red line from Wigton to Dean Cross VOR. In the
plan, note the bearing and distance (231º 8.7 nautical miles). When you fly the
route, you can compare your present bearing and distance from Dean Cross VOR
to find which way to fly to arrive overhead Wigton.

5.

From Wigton, you will fly over Keswick and admire the beauty of the Lake
District. You need to create a User Waypoint for Keswick (pronounced Kezzik, by
the way). You will find Keswick to the south east of Dean Cross, on the south
side of Bassenthwaite Lake and just north of Derwentwater.

6.

At zoom level 12, you will see the town clearly. Right click on the town name
Keswick shown on the map, and complete the User Waypoint Dialogue box.
Check that “Location” is set as the waypoint type. Enter Keswick Town in the
Name box, and KESWIK in the Identifier box. In the tag box, you could enter your
initials to indicate that it is one of your user‐created waypoints.

7.

Click OK and observe the small green waypoint circle appear on the plan. If it
doesn’t show, drag the map a small amount and it will be displayed as the map
refreshes.

8.

Now you can add another leg to the plan. Right click your new waypoint and
Select the option “Add user waypoint KESWIK Keswick Town to the Plan”

9.

Note that the newly added track line goes over some impressive looking high
ground. It is in fact Skiddaw, at 3,052 feet, the 4th highest mountain in England. If
you have downloaded the Digital Elevation Model (DEM) tiles from the NGDC
'GLOBE' website at http://www.ngdc.noaa.gov/mgg/topo/gltiles.html you can
now look at what this means in terms of vertical navigation. (See section 12.3 for
details of DEM.) If you haven’t downloaded the DEM tile for the UK, you really
ought to. It adds a great feature to Plan‐G. You need tile B, filename b10g.gz
which covers 90% of the UK.
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10. So you now have the DEM info installed. Open the View Ribbon, by clicking the
View tab, and tick the Plan Elevation Tick box at the top left of the ribbon.
11. Whoa! That is some mountain (in UK terms anyway) 24 nautical miles en route.
Note the Maximum Elevation Figure (MEF). You will now realise why the planned
altitude was 4,000 feet.
12. Now zoom the map to Level 13 or 14. The names of the Lakeland peaks are
visible at that scale. Move the cursor and observe the Latitude and Longitude
changing on the status bar at the bottom. Find the location which is at Latitude
N54º 27’ 15’’ Longitude W003º 12’ 42’’. You will see the name Scafell Pike –
England’s highest mountain at 3,210ft. Create another user waypoint at the top
of the mountain. Call the waypoint Scafell Pike, with the Identifier SCAFLPK. The
elevation of your waypoint should be 3,100 feet. If you have the downloaded the
DEM files, this value will already be set in the elevation box by Plan‐G.

Figure 135 Over the Lakeland Hills

13. Add Scafell Pike to your route, as before. When you fly this route, alongside
Bassenthwaite Lake, overhead Derwentwater and down the Borrowdale Valley to
Scafell Pike, you will find the view hereabouts quite spectacular in default
scenery, but with a good mesh and photographic scenery – simply stunning.
14. You now want to head more west to Ravenglass, Latitude N54º 24.00’ Longitude
W003º 29.00’. But there are some things you need to watch out for. Open the
Map ribbon, and switch on ‘RPDM Airspace’ by clicking in the tickbox. (RPDM
stands for Restricted, Prohibited, Danger, Military, which could be simply
translated “Don’t go there”).
15. At scale level 12, there is a large orange circle centred on Sellafield, and just south
of that, a very large red fan shaped area. Open the Information Window from
the View menu to see what is known about them. Click on the edge of the
orange circle. In the Information Window, you will see “Restricted Area Sellafield
SFC‐2200”. You cannot overfly one of Britain’s oldest and most famous Nuclear
Power Stations below 2,200 feet.
16. But note also, that if you move the mouse into the open area a little to the east,
the Information Window shows that you cannot fly above 5,500 feet because
that is the Warton Radar Advisory Service Area. You must contact Warton Radar
for permission to fly up there. Warton EGNO is an RAF station 6 nautical miles
east of Blackpool Airport EGNH.
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17. The big red area is Eskmeals Danger Area, from the surface upwards to the
stratosphere (that's what SFC+ means). Eskmeals is a weapons testing range
where, among other things, they fire big shells out to sea, and up as high as
80,000ft. Avoid!
18. It might be a better plan to route direct from Scafell Pike to Barrow and look at
nuclear submarines being built! Pan slowly down from Ravenglass and you will
see Barrow (Walney Island) Aerodrome EGNL and two NDBs WL and FN. Add
Barrow Aerodrome to your route.

Figure 136 Sellafield and Eskmeals “Don’t Go There” Areas

16.3

A Little Stick of Blackpool Rock
English comic singer George Formby made this song famous, along with his other
risqué songs such as “With me little ukulele in me ‘and”. You are probably not
interested in that, but to fly down the coast to Blackpool and beyond might be
interesting.
1.

From Barrow, looking south, you have the wide expanse of Morecambe Bay. The
famous comedian Eric Morecambe took his stage name from the place. When
the tide is out, this whole area is devoid of water; when the tide is in, it looks as it
does in FS, all water. The area is treacherous with quicksand, very fast flowing
tides and channels so that anyone caught out on the sands on an incoming tide
had better get out of there quickly. It has been the scene of many tragedies.
In Flight Simulator, where ditching in this dangerous area is not a consideration,
you might as well plan to go straight across to Fleetwood Golf Course, a Visual
Reference Point for Blackpool. Make sure you have Visual Reference Points
(VRPs) enabled on the Map ribbon, so that you can see the small orange circle
symbols for VRPs. Right click on the small orange circle to add Fleetwood to your
route.

2.

Fleetwood was once home to Britain’s second largest fishing fleet after Grimsby,
but fishing has declined to near zero and the harbour today is populated by many
smart yachts. If you intend to fly online and by chance Blackpool Approach is on
duty, this is where you will make your initial call to them. “Request transit your
Page 109 of 152

Plan G User Manual

V 3.1.1 July 2014

overhead at 4,000 feet”. So you had better add Blackpool EGNH to your Plan
now.

16.4

3.

The track line from Fleetwood to Blackpool is over land, but the “Left Hand Rule”
for VFR flight states that if you are following a line feature, you should keep it on
your left. This route is well used by light aircraft in the real world, who follow the
convention of keeping the shoreline on the left. Thus southbound traffic flies a
mile or so out to sea. Northbound traffic flies over the land. So although the
trackline is over land, when you come to fly the route, you should really do the
same, passing a mile or so west of the 08 end of Blackpool’s main runway.
Blackpool Approach will want you to call them at the “the tall tower”. They don’t
say “Blackpool Tower”, as you could well think they mean the building on the
aerodrome, not the world famous 518ft high lattice steel structure a couple of
miles further north.

4.

After Blackpool, add Marshside VRP to your route; (you can do this now without
help, surely) and then once more follow the coast to Woodvale.

5.

Now add Woodvale aerodrome EGOW to your plan. The airport symbol is red
because it is a military (RAF in this case) aerodrome. The track line is again
inland but you will want to fly on the seaward side of the shoreline.

6.

So why not fly over Birkdale Sands, a beach airstrip which was first used for
pleasure flights as long ago as 1919?
http://www.seftoncoast.org.uk/articles/01winter_aviation.html .

7.

Right‐click Birkdale Sands airstrip (EGCO) to add it to your plan. The track line
now goes from Marshside VRP to Woodvale then back to Birkdale Sands, a zigzag
line which is not what you want. So open the Plan Window from the ‘View’
ribbon and right‐click the new Birkdale Sands entry, and select “Move waypoint
up”. Now Birkdale Sands appears before Woodvale and your route is restored to
something sensible.

8.

Look now about 2.5 miles south of Woodvale. See the red line running
horizontally across the map? Move the mouse to that line and read the
information in the Information Window. Here you are at 4,000 feet. Is there
something you need to do?

Controlled Airspace
You are now getting close to Liverpool and things will change rapidly. You have
planned to enjoy a leisurely flight with that great sense of freedom which flying (real
or virtual) brings but what you will now have to plan for is controlled airspace and
procedures. If you plan to fly on line, you will quite possibly have an ATC position
manned – someone to talk to and give you instructions. You should be familiar with
correct ATC phraseology if you are planning to fly this route on line.
“Manchester TMA Class A 3500+” you should have read in the Information Window in
Section 16.3, numbered item 8 above. TMA stands for “Terminal Manouevring Area,
and being Class A Airspace, and you are flying VFR, you absolutely cannot go there, so
you must plan to descend.
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About 6 miles further south again is the Liverpool Control Area (CTA) from 2500‐
3500ft, with beneath it, the Liverpool Control Zone (CTR) which extends from the
surface to 2500 feet. Both are Class D airspace. You can go there, but only with
permission from Air Traffic Control.
Because IFR traffic inbound to Liverpool will be brought down to a minimum altitude
of 2,500 feet to capture the ILS, and required traffic separation is 1,000 feet IFR from
VFR in Class D Airspace, you will be given the instruction from Liverpool Approach to
fly “not above 1,500 feet.” So you must plan to descend from 4,000 to 1,500 feet in 8
miles or so, about 4 minutes. A quick calculation, tells you that that is 650 feet a
minute – quite a rapid descent in a light aircraft.

Figure 137 Controlled Airspace around Liverpool

Figure 137 is a composite graphic showing the complexity of controlled airspace round
Liverpool. Just south of Woodvale (EGOW) is the Manchester TMA boundary, and an
arrow points to the Seaforth VRP. The other four arrows represent mouse pointer
positions. The four Information Windows are shown which you will see if you place
the mouse pointer at each of those positions. Of course in Plan‐G you will only see
one set of information at a time in your Information Window.
9.

Fortunately, all you need to know, as a light aircraft pilot inbound to Liverpool, is
that you must only enter the Liverpool Control Zone (CTR) at Seaforth VRP, and
only then when ATC gives permission, and at an altitude at or below 1500 feet.

10. First, however, complete the next leg of the route. Find the Seaforth VRP just
west of Bootle. Add Seaforth VRP to your plan. On a VFR flight, when you first
contact ATC at Liverpool just after Woodvale, you will be told “Runway 27 (or 09)
in use, report at Seaforth, not above 1,500 feet”.
11. Now add Liverpool Airport to the plan. You now have a complete route airport to
airport.
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Change of Plan
However, you decide to practice flying the ILS and the procedural approach (called just
“the procedure” among pilots) rather than the norm of accepting vectors from Air
Traffic Control, so that changes the ball game completely. You will now deemed to be
flying IFR, and you need the Instrument Approach Charts, or “Approach Plates”. Plan‐
G can save you the trouble looking for those approach plates for the planning stage as
you will see. However, this manual isn’t going to tell you how to fly the procedure, but
just how to complete your plan to landing.
The procedure starts at the LPL NDB, so you can fly direct from Woodvale to the NDB.
No need to go via Seaforth, which is the VFR route, because you are now flying IFR.
1.

First, add the LPL NDB to your plan.

2.

Delete the waypoint “Liverpool‐Seaforth” from your plan, by right‐clicking it’s
entry and selecting “Delete Waypoint”. It is no longer relevant.

Figure 138 Seaforth VRP Deleted from the Plan

Figure 139 Instrument Approach Procedure

3.

Right‐click on Liverpool Airport, and select “Instrument Approaches”. Select “ILS
27” from the pop‐up window.

4.

Click on the transition “2. LPL” which is the one for Category A aircraft (that’s you
in your Cessna), and the procedure is displayed on the map.
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The blue line indicates the approach path on the ILS passing over the LPL NDB. The red
line is the missed approach procedure. It uses tighter radius turns and shorter distances,
but is otherwise the same as 1.LPL. If you select 1.LPL temporarily you can see the
difference.

16.6

VNAV Profile
The next task is to create a vertical navigation profile. You need to get safely over
those mountains, yet descend in time to get under the Manchester TMA near
Woodvale, and then be at 2,500ft on reaching the LPL NDB.
1.

Open the Plan in the Plan Window, and using the horizontal scroll bar if
necessary, find the “Passing Alt” Column. It is reasonable to assume that
climbing out of Carlisle at 500 feet per minute in your Cessna 172, that in the 13.9
miles to Wigton, you can easily reach 2,500ft. So double click in the cell on the
row CARLISLE‐WIGTON and type in 2500.

2.

Move down to the Keswick row and double click the cell in the “Passing Alt”
column. To make sure you clear Skiddaw and Scafell Pike, type in 4000.

3.

In the same way, enter 4000 for Fleetwood Golf Course VRP and Blackpool
Airport EGNH.

4.

Mindful of the Manchester TMA south of Woodvale, with its base at 3500ft, go to
the Woodvale row and the “Passing Alt” column, and enter 2500.

5.

To fly the Liverpool 27 procedure for the ILS, you need to be at the LPL NDB at
2500 feet. So move down to the LPL row and the “Passing Alt” column, and enter
2500 again.

When you fly the route, you will get “Top of Descent” alerts a mile before Woodvale,
and again a mile before reaching the LPL NDB.

16.7

Notes
You have read in the Flight Plans section (section 14 above) about how to enter notes.
It will be important not to forget to descend below the Manchester TMA floor south of
Woodvale, and to remind yourself that after Wigton, you need to be at 4,000ft.
1.

Scroll across to the right of the Plan table and in the Notes column for the
Keswick Row, double click and enter Continue climb to 4000ft.

2.

Then do the same for the Woodvale Row, double click and enter Manchester
TMA base 3500ft.

Remember that passing altitudes, cross references and notes will be printed on your
plog, and saved with your plan if you save the file as a .PLG file, but not if you save the
file as a .PLN file.

16.8

Alternate
What if you cannot land at Liverpool? What if some VATSIM or IVAO newbie is
plonked right on the runway and is disinclined to move. You need to add an
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“Alternate” to your plan – somewhere you can go to if Newbie is still there when you
are a mile from touchdown rapidly approaching the Missed Approach Point!
Look around the map, and select somewhere suitable. RAF Sealand is closed, and
anyway it was gliders only, Manchester won’t really welcome a slow Cessna 172, but
Hawarden, just to the southwest of Chester, is G.A. friendly.
Right click on Hawarden and select “Set EGNR as Alternate”. A red line is now drawn
on the map from Liverpool. Hawarden (pronounced “Harden” by the way) was, in
VATSIM’s early years, VATSIM UK’s busiest airport, with a controller on duty seven
nights a week.

Figure 140 The Track to the Selected Alternate Airport

So that is your planned flight, with some local knowledge thrown in to make it more
interesting. In fact, if you don’t fly VFR often, you may have discovered that short VFR
flights can be just as challenging as IFR flight across continents.

Figure 141 The Completed Plan

When you fly the route, don’t forget to complete the task properly by taxiing to
Liverpool’s General Aviation apron at the east end of the airport. Park on stand
Parking 1 ‐ Ramp GA Large, shut down and secure the aircraft.
If you need an Airport diagram to find out where MediumParking 1 ‐ Ramp GA Large is,
(it’s an FS parking spot, so won’t be shown on the official CAA Aerodrome Diagram,
will it?) right click the airport symbol once more, and select ‘Show Airport Diagram’.
This opens the Airport Diagram Window and after a second or two loading the data,
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the airport diagram appears in the window (See Section 12.6 above for more details.)
You can see the G.A. Apron at the eastern end of the airport, with small blue circles for
the parking stands, one of which is Parking 1. Zoom into the airport diagram with your
mouse wheel, hover the mouse over each of the blue spots, until you discover which
one it is.

16.9

Let’s Go Flying
You have printed out the Plog from Plan‐G so it is time to go flying.

16.9.1 Microsoft Flight Simulator

Figure 142 Forney Aircoupe G-ARHC Over Derwentwater in FSX

1.

Open Flight Simulator, and select Free Flight from the Main Menu.

2.

Set Country as United Kingdom, and select Current Location as Carlisle (EGNC).

3.

Select Starting position PARKING 1 ‐‐ RAMP GA SMALL.

4.

Select Aircraft type Cessna 172

5.

Set a suitable time and date for a daylight VFR flight.

6.

Click Fly Now.

7.

When the flight has loaded, save it as the default so that you can easily get back
to this position if you need to.

8.

Find the current weather for Newcastle EGNX (the nearest weather station to
Carlisle) from an Internet Aviation Weather site, such as
http://weather.noaa.gov/weather/coded.html .

9.

Set the Newcastle wind, cloud and precipitation information in FS.
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10. Alternatively, if you are a member of an online Flightsim community such as
VATSIM or IVAO, simply connect to the service and the weather at Newcastle will
be automatically loaded into FS.
11. Start up, taxi to the active and enjoy your flight over England’s highest mountains
to England’s second most famous city.
16.9.2 X-Plane

Figure 143 Heading towards Derwentwater in X-Plane 9

12. Start X‐Plane, and Open Settings/Quick Flight Setup
13. Set your Location as Carlisle (EGNC).
14. Select Aircraft type Cessna 172.
15. Find the current weather for Newcastle EGNX (the nearest weather station to
Carlisle) from an Internet Aviation Weather site, such as
http://weather.noaa.gov/weather/coded.html .
16. Set the Newcastle wind, cloud and precipitation information in the weather box.
17. Alternatively, if you are a member of an online Flightsim community such as
VATSIM or IVAO, simply connect to the service with XSquawkbox or X‐IvAp and
the weather at Newcastle will be automatically loaded into X‐Plane.
18. Go to Location/Local Map and move your aircraft to the main apron (if X‐Plane
has placed your aircraft in the default position at the center of the runway
intersections)
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19. Go to Environment/Date & Time and set a suitable time and date for a daylight
VFR flight.
20. Save the flight to avoid having to reset the many parameters such as QNH, and
weather, and you can easily get back to this position if you need to.
21. Start up, taxi to the active and enjoy your flight over England’s highest mountains
to England’s second most famous city.
Note: In X‐Plane non‐hard surfaces are generally best avoided for starting up or
parking, as the effect of soft ground is exaggerated.
16.9.3 Prepare3D
1. Open P3D and from the Flights Menu select "Create Scenario"
2.

Change Selected Vehicle to your choice of aircraft, set Airport to Carlisle and
location to Parking, 1,2, 3 or 4 as desired.

Figure 144 The Prepar3D Scenario Screen

3.

Set Date and Time as appropriate.

4.

Find the current weather for Newcastle EGNX (the nearest weather station to
Carlisle) from an Internet Aviation Weather site, such as
http://weather.noaa.gov/weather/coded.html.

5.

Set the Newcastle wind, cloud and precipitation information in P3D.
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6.

Alternatively, if you are a member of an online Flightsim community such as
VATSIM or IVAO, simply connect to the service and the weather at Newcastle will
be automatically loaded into P3D.

7.

Click OK.

8.

Start up, taxi to the active and enjoy your flight over England’s highest mountains
to England’s second most famous city.
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CONNECTION TO A FLIGHT SIMULATOR
Plan‐G can be connected to a running Microsoft Flight Simulator (MSFS), Prepar3D
(3D) or X‐Plane session, either on the same machine or on another PC connected via a
local area network.
When Plan‐G is connected to MSFS or P3D, the Weather, PFD Panel, Radio Stack,
Traffic & Trail Analysis View Windows functions are enabled. In addition, the user’s
aircraft and any AI aircraft or other aircraft in a Multiplayer environment are also
displayed. The status bar at the bottom of the map shows the basic flight data.
When Plan‐G is connected to X‐Plane, the same data can be displayed except weather,
which in this case, comes from the U.S. National Weather Service, not X‐Plane. Your
aircraft and any AI aircraft or other aircraft in a Multiplayer environment are also
displayed, and the information in the status bar is the same as that for MSFS.

17.1

Flight Data Transfer
The data passed to Plan‐G includes: ‐
As overlays on the basic Map : ‐
•

User’s aircraft icon (yellow)

•

AI aircraft icons (smaller, red)

•

Multiuser aircraft icons (also small and red)

•

VATSIM aircraft icons (smaller, blue)

•

User’s Aircraft trail (default colour red)

•

Multiuser and AI trails (default colour magenta)

•

Fly‐to Heading, distance and time en route from the user’s aircraft to any point on
the map by simply right‐click the point for which that information is required.

Optionally, switchable, in the View Windows
•

The Tabular Flight Plan

•

The Vertical Navigation Profile

•

Airspace and Aerodrome Information

•

Airport Diagrams

•

Weather

•

Trail Analysis

•

PFD data (airspeed, heading, altitude, rate of climb/descent)

•

Radio Stack

•

Traffic table (Multiuser & AI)

•

VATSIM (connected members)

And in the status bar below the plan
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•

Current position Latitude and Longitude (when the mouse pointer is placed on the
yellow aeroplane indicator)

•

Altitude

•

Heading

•

Groundspeed

•

Course deviation

•

Estimated Time of Arrival at the next waypoint

•

Estimated Time of Arrival at the destination airport

Figure 145 Connected to FS: - lots of valuable data about your flight

17.2

Communication Protocols
In order for Plan‐G to communicate with FS, data has to be transferred using a specific
set of rules – the communications protocol.

17.2.1 FSUIPC3 for FS9
FS9 users will need Peter Dowson's free FSUIPC 3 (“Flight Simulator Universal Inter‐
Process Communication”) program to be able to connect to Plan‐G, either on the
same PC or over a network. There are no other options available for FS9. FSUIPC may
be downloaded from http://www.schiratti.com/dowson.html free of charge.
Peter Dowson provides very friendly and attentive support for his programs on this
forum:
http://forums.simflight.com/viewforum.php?f=54
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The FSUIPC installer program copies a file called “FSUIPC.DLL” into the FS9/Modules
folder. After installing FSUIPC3, you will discover, when you run FS9, that there will be
a new entry in the “Modules” section of the FS9 top menu labeled FSUIPC. FSUIPC3
can be configured to do many things – it really is a most versatile tool. However, for
Plan‐G, you do not need to know how it works or configure it at all.
17.2.2 SimConnect for FSX
FSX normally uses a special Microsoft interface protocol, SimConnect, for
communicating with other Windows programs, either locally or across a network.
See http://msdn.microsoft.com/en‐us/esp/cc835021.aspx for an introduction to
SimConnect. SimConnect only works with FSX.
SimConnect is the preferred connection option for FSX. It is efficient, fast, and
provides optimal control over the information available.
There are three data transfer protocols available in Plan‐G for FSX and SimConnect: ‐
Pipe, IPv4 and iPv6.
•

Pipe is used only internally in a PC, but is the fastest of the three.

•

IPv4 is used by Windows Vista, XP and earlier versions of Windows. It can still be
used if your operating system is Windows 7.

•

IPv6 is installed in Windows Vista and Windows 7, (though it may not be enabled)
and may optionally be installed in Windows XP.

17.2.3 FSUIPC4 for FSX
Plan‐G has been designed to also communicate with FSX using Peter Dowson's free
FSUIPC4, which is an updated version of FSUIPC 3 specifically for use with FSX.
FSUIPC4 will also work with FS9.
If using SimConnect does not work for you, (SimConnect can be troublesome on some
computers, and solving the problem is not trivial, unfortunately) then use FSUIPC4
This uses SimConnect internally, and may be downloaded from
http://www.schiratti.com/dowson.html free of charge.
Peter Dowson provides very friendly and attentive support for his programs on this
forum:
http://forums.simflight.com/viewforum.php?f=54
The FSUIPC4 installer program copies a file called “FSUIPC4.DLL” into the FSX/Modules
folder, along with the FSUIPC4 User Guide.pdf. When you next run FSX, after accepting
the newly‐installed FSUIPC4 modules, there will be a new FSUIPC entry in the “Add‐
Ons” menu. FSUIPC4s first action will be to ask you to register the program. If you
simply want to use FSUIPC4 to connect FSX to add‐on programs on the same PC, you
do not have to continue with registration of the program.
17.2.4 SimConnect for P3D
Simconnect is described in section 17.2.2 above. Plan‐G will connect to P3D using
SimConnect in exactly the same way as it does for FSX.
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17.2.5 FSUIPC for P3D
FSUIPC Version 4.934 and later includes full support for P3D. The instructions for using
FSUIPC are contained within the download. With FSUIPC installed Plan G will connect
to a running instance of P3D immediately, providing FSUIPC has been selected as the
connection method, as described in Section 8.9.4 above.
17.2.6 XPUIPC for X-Plane
This requires the freeware program XPUIPC. XPUIPC is a plugin for X‐Plane which
emulates Peter Dowson’s FSUIPC interface for MSFS. It was written, with Peter
Dowson’s and others help, by Torsten Spiering who uses the pseudonym “Spyy”. The
current version of XPUIPC is 2.0.0.0 (June 2014), but it is continually being developed.
The program is a client‐server interface in which the Server is the computer running X‐
Plane and the Client is the computer running Plan‐G. These may be one and the same,
or two networked PCs. It is very easy to install and the manual is clear and
unambiguous.
Download XPUIPC from http://www.tosi‐online.de/XPUIPC/XPUIPC.html
The download is a zip file which can be unpacked to any folder you wish. The
download includes the excellent manual, an executable XPWideClient.exe, and a
plugin, XPUIPC.xpl.
Installation instructions for XPUIPC are simple and clearly explained in the manual, but
are repeated here for completeness.
Put the file XPUIPC.xpl in X‐Plane\Resources\Plugins.

Figure 146 Put the file XPUIPC.xpl in X-Plane\Resources\Plugins

if you only have one PC, XPWideClient.exe and XPWideClient.ini files are not needed
so can be left in the ‘XPUIPC Package’ folder.
If you intend to run Plan‐G on a network, the instructions for setting up
XPWideClient.exe and XPWideClient.ini files are detailed in section 19.5 below. These
two files must be in the same directory.

Page 122 of 152

Plan G User Manual

18

V 3.1.1 July 2014

FLIGHT SIMULATOR AND PLAN-G ON THE SAME
COMPUTER
This section will guide you through the configuration steps required to connect Plan‐G
to your simulator session.
Recommendation: Plan‐G does not always display correctly if your simulator is loaded
after Plan‐G. IF you start your simulator and allow it to load fully before Plan‐G, then
reliable operation of Plan‐G can be expected.

18.1

Connecting to FS9
This requires the freeware program FSUIPC3 described in Section 17.2.1 above.
With FS9 running, start the Plan‐G program, Click the File tab and select the “Options”
menu, and then the FS Connection tab.
The screen below is displayed.
The FS Connection Parameters dialogue (see Figure 147 below) can also be accessed
by clicking the small diagonal arrow‐shaped launcher button in the Flight Simulator
connections tab of the Home ribbon (below the Lock/Sync/Free buttons at the right).

Figure 147 File/Options FS Connection Tab for FS9

All the other settings in that window can be ignored. SimConnect is an FSX only
function and XPUIPC, the X‐Plane Version of FSUIPC, is the connection tool for X‐Plane.
Close the Options window by clicking “OK”, and return to the main window. With FS9
loaded, press the “Connect” button.

Figure 148 Connected to FS9

On connecting, the Plan‐G map will move so that your FS9 aircraft location is shown,
and a yellow User Aircraft Icon will appear. If AI aircraft are in the area, and as long as

Page 123 of 152

Plan G User Manual

V 3.1.1 July 2014

you have selected AI aircraft in the options panel to be displayed, they will appear in
red. If you are connected to VATSIM, IVAO or other multiplayer server, then Plan‐G
displays other connected aircraft rather than AI aircraft, and coloured blue rather than
red.
You can now set up Trail Analysis, import FS Weather data etc. as described above,
which significantly enhances the value of Plan‐G.
If you get a connection error, or a connection time‐out error, the most likely reason is
that you have not selected the correct connection option, which must be FSUIPC, on
the Options page under the ‘File’ tab. Less commonly, you may have installed FSUIPC
incorrectly. Be sure to read the FSUIPC installation instructions and follow them
carefully. It has to be said, though, that FSUIPC is almost always trouble free in use, so
if you don't get a connection, the problem is most likely to be something you have
done, or not done.

18.2

Connecting to FSX With SimConnect
With Plan‐G on the FSX PC, there is no setup required in FSX when using SimConnect.
However, in Plan‐G, the SimConnect settings will need to be configured before a
connection can be made. First, decide which is the appropriate SimConnect data
transfer protocol: ‐ Pipe, IPv4 or iPv6. Remember:
•

Pipe is used only internally in a PC, but is the fastest of the three.

•

IPv4 is used by Windows Vista, XP and earlier versions of Windows.

•

IPv6 is installed in Windows Vista Windows 7 and Windows 8, (though it may not
be enabled) and may optionally be installed in Windows XP.
To configure the settings, select “Options” from the File Tab, then open the FS
Connection tab. Check or amend the settings so that they correspond to one of the
three configurations below (also shown in Figure 149, Figure 150 and Figure 151
below).

Figure 149 SimConnect Settings for a Single PC Using Pipe
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The Connection Parameters dialog (see Figure 149 above) can also be accessed by
clicking the small diagonal arrow‐shaped launcher button in the Flight Simulator
connections tab of the Home ribbon (below the Lock/Sync/Free buttons)
18.2.1 Connection Using Pipe
Set “Connect with” radio button to SimConnect
Network Mode:

Select Pipe from the dropdown options.

FSX Computer:

Enter either “localhost” or “127.0.0.1” (without quotes)

Server Port/Pipe:

Leave blank (important)

18.2.2 Connection Using IPv4
Set “Connect with” radio button to Auto
Network Mode:
FSX Computer:
Server Port/Pipe:

Select IPv4 from the dropdown options.
Enter either “localhost” or “127.0.0.1” (without quotes)
Enter “0” (Without quotes)

Figure 150 SimConnect Settings for a Single PC Using IPv4

18.2.3 Connection Using IPv6
Set “Connect with” radio button to Auto
Network Mode:

Select IPv6 from the dropdown options.

FSX Computer:

Enter either “localhost” or “::1” (without quotes)

Server Port/Pipe:

Leave blank.

Figure 151 SimConnect Settings for a Single PC Using IPv6

As long as you set up Plan‐G as described here, it is unlikely that you will have any
difficulty connecting to FSX from Plan‐G on a single computer.
Close the Options window by clicking “OK”, and return to the main window. With FSX
running, press the “Connect” button.

Figure 152 Connected to FSX with SimConnect
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On connecting, the Plan‐G map will move so that your FSX aircraft location is shown,
and a yellow User Aircraft Icon will appear. If AI aircraft are in the area, and as long as
you have selected AI aircraft in the options panel to be displayed, they will appear in
red. If you are connected to VATSIM, IVAO or other multiplayer server, then Plan‐G
displays other connected aircraft rather than AI aircraft, and coloured blue rather than
red.
You can now set up Trail Analysis, import FS Weather data etc. as described above,
which significantly enhances the value of Plan‐G.
If you get a connection error, or a connection time‐out error, the most likely reason is
that you have not configured Plan‐G with the correct SimConnect parameters on the
Options page under the ‘File’ tab. Section 20 below deals with addressing SimConnect
problems. If the advice in that section does not result in SimConnect successfully
connecting, the problem may be tricky to solve. If you have other programs which use
SimConnect and you are unsure of how to correct SimConnect problems, please do not
experiment, but seek expert advice.

18.3

Connecting to FSX with FSUIPC
This requires the freeware program FSUIPC4 described in Section 17.2.3 above.
Start FSX and then start Plan‐G. From the ‘File’ tab, select Options from the menu and
then FS Connection, select “FSUIPC” as the connection method. There is no need to
change any of the other parameters; they are not used.
If all is well, close the Options window by clicking “OK”, and return to the Home ribbon
window. Now press the “Connect” button.
On connecting, the Plan‐G map will move so that your FSX aircraft location is shown in
the centre, and a yellow User Aircraft Icon will appear. If AI aircraft are in the area,
and as long as you have selected AI aircraft in the options panel to be displayed, they
will appear in red. If you are connected to VATSIM, IVAO or other multiplayer server,
then Plan‐G displays other connected aircraft rather than AI aircraft, but in blue rather
than red.
You can now set up Trail Analysis; import FS Weather data etc. as described above,
which significantly enhances the value of Plan‐G.
If you get a connection error, or a connection time‐out error, the most likely reason is
that you have not selected the correct connection option, which must be FSUIPC, on
the Options page under the ‘File’ tab. Less commonly, you may have set up FSUIPC
incorrectly. Be sure to read the FSUIPC installation instructions carefully. It has to be
said, though, that FSUIPC is almost always trouble free in use, so the problem is most
likely to be something you have done, or not done.

18.4

Connecting to P3D With SimConnect
The procedure for connecting Plan‐G to Prepar3D is exactly the same as for FSX. With
Plan‐G on the same PC as P3D, no setup is required on the P3D PC when using
SimConnect. The Plan‐G settings will, however, need to be configured before a
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connection can be made. First, decide which is the appropriate SimConnect data
transfer protocol: ‐ Pipe, IPv4 or iPv6. Remember:
•

Pipe is used only internally in a PC, but is the fastest of the three.

•

IPv4 is used by Windows Vista, XP and earlier versions of Windows.

•

IPv6 is installed in Windows Vista, Windows 7 and Windows 8, (though it may not
be enabled) and may optionally be installed in Windows XP.
To configure the settings, select “Options” from the File Tab, then open the FS
Connection tab. Check or amend the settings so that they correspond to one of the
three configurations shown in Figure 149, Figure 150 and Figure 151 above).
The Connection Parameters dialog (see Figure 149 above) can also be accessed by
clicking the small diagonal arrow‐shaped launcher button in the Flight Simulator
connections tab of the Home ribbon (below the Lock/Sync/Free buttons)

18.5

Connecting to P3D With FSUIPC
Plan‐G is connected to P3D via FSUIPC in exactly the same way as FSX. Remember that
FSUIPC Version 4.934 and later is required. Make sure that the option “FSUIPC” as the
connection method is selected from Options from the File menu. There is no need to
change any of the other parameters.
Start P3D and select the Home tab in Plan‐G. Press the “Connect” button, and your
aircraft should appear on the map centred in the display.

18.6

Connecting to X-Plane
Note: Plan‐G can only connect to X‐Plane installed on a PC running the Microsoft
Windows operating system at present.
With X‐Plane running, start the Plan‐G program.
From the ‘File’ tab, select ‘Options’ from the menu and then ‘FS Connection’, select
‘XPUIPC’ as the connection method. There is no need to change any of the other
parameters; they are not used.

Figure 153 XPUIPC is used with X-Plane

Page 127 of 152

Plan G User Manual

V 3.1.1 July 2014

The Connection Parameters dialogue can also be accessed by clicking the small
diagonal arrow‐shaped launcher button in the Flight Simulator connections tab of the
Home ribbon (below the Lock/Sync/Free buttons at the right).
Now close the Options window by clicking “OK”, and return to the Plan‐G Home
ribbon.
Now click the ‘Connect’ icon, your aircraft will be displayed on the map, and all the
functionality of Plan‐G described in this manual will be available.

Figure 154 Connected to X-Plane with XPUIPC

The text ‘Flight Simulator’ below the Connect/Disconnect buttons does not mean you
are connected to Microsoft Flight Simulator, but to a Flight Simulator – the word is
used generically in this instance. You will be connected to X‐Plane of course.
If either the ‘Sync’ or ‘Lock’ option is selected, then on connecting, the Plan‐G map will
move so that it is centred at the location saved in the X‐Plane flight you are loading,
and a yellow User Aircraft Icon will appear. If AI aircraft are in the area, and as long as
you have selected AI aircraft in the options panel to be displayed, they will appear in
red. If you are connected to VATSIM, IVAO or other multiplayer server, then Plan‐G
displays other connected aircraft rather than AI aircraft, but in blue rather than red.
You can now set up Trail Analysis, described above, which significantly enhances the
value of Plan‐G.
Because FSUIPC and XPUIPC were created by different authors, there are some
differences in the functionality between them. Some features in Plan‐G may therefore
be disabled or operate differently in X‐Plane from MSFS. XPUIPC is regularly updated
you should check the source site http://www.tosi‐online.de/XPUIPC/XPUIPC.html from
time to time for updates.
Be sure to read the XPUIPC installation instructions. It has to be said, though, that
XPUIPC is almost always trouble free in use, so the problem is most likely to be
something you have done, or not done. If you get a connection error, or a connection
time‐out error, the most likely reason is that you have either not selected the correct
connection option, which must be XPUIPC, in the File Options window, or you have
entered an invalid Ipv4 address for your PC in XPWideClient.ini.
Most people allow their internet router to assign an Ipv4 address automatically, and if
this is the case, and there is more than one device connected to the router, then the
Ipv4 address of your X‐Plane PC may not always be the same. This can be rectified by
reserving the Ipv4 address of your X‐Plane PC in your router. Read your router
documentation to find out how to do this. For X‐Plane enthusiasts, this is normally a
good idea anyway if other software needs to interface with X‐Plane.
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FLIGHT SIMULATOR AND PLAN-G ON A NETWORK
You can install Plan‐G on a second PC (the “Network PC”) that is connected to the
Flight Simulator PC through a home TCP/IP network, either wirelessly (WiFi, IEEE
802.11a/b/g/n/ac) or wired via Ethernet. Firstly, follow the steps in the Prerequisites
and Installation sections of this manual (sections 3 and 4) to install Plan‐G on the
Network PC. It does not need to be installed on the Simulator PC.
Firewall software must be configured to allow TCP communications on the port you
set below – this includes Windows Firewall and any router firewall – and applies to
both computers, Flight Simulator PC and Network PC.
FSX and P3D users can choose between using SimConnect, or using Peter Dowson's
FSUIPC4 program, the same choice (and for the same reason) as connecting on a single
PC – i.e. SimConnect may not always work, and finding out why isn’t always easy,
whereas FSUIPC almost always works. However, SimConnect is the preferred
connection option for FSX. It is more efficient, faster, and provides optimal control
over the information available.

19.1

First Find Your Sim
Section 8.9.1 above describes how to set up the locations in Plan‐G so that it knows
where to get its Simulator data. This must be done before attempting to connect the
Sim to Plan‐G, whether it be FS9, FSX, P3D or X‐Plane.

19.2

Connecting to FS9 from a Networked PC
FS9 users will have to install Peter Dowson's free FSUIPC (“Flight Simulator Universal
Inter‐Process Communication”) program
http://www.schiratti.com/dowson.html
on the FS9 PC to be able to connect to Plan‐G.
You will also need to buy Peter Dowson’s WideFS and use it with either with the
freeware FS9 version of Peter Dowson's FSUIPC ‐ FSUIPC 3, or you can, if you wish, buy
the full featured version of FSUIPC 3.
FSUIPC 3 may be downloaded from http://www.schiratti.com/dowson.html
Peter Dowson provides very friendly and attentive support for his programs on this
forum:
http://forums.simflight.com/viewforum.php?f=54
The FSUIPC3 installer program copies a file called “FSUIPC.DLL” into the FS9/Modules
folder, along with the FSUIPC User Guide.pdf. When you next run FS9, after accepting
the newly‐installed FSUIPC modules, there will be a new FSUIPC entry in the “Add‐Ons”
menu. FSUIPCs first action will be to ask you to register the program. If you simply
want to use FSUIPC3 to connect FS9 to add‐on programs on the same PC, you do not
have to continue with registration of the program.
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19.2.1 WideFS
In addition, you will need a second Peter Dowson program called WideFS, which
installs a server portion, WideServer.dll, on the FS9 PC, and a client portion,
WideClient.exe, on the Network PC. WideFS is available from
http://www.schiratti.com/dowson.html
Note that, in contrast to FSUIPC, WideFS is not free, and must be purchased and
registered, using an access key. There is an option to buy the registered version of
FSUIPC and WideFS as a bundle, which costs less than the two purchased separately.
Note that for FS9 you must buy the FS9 specific version.
Follow the instructions in the WideFS User Guide (a pdf document) to install the client
and server portions along with their configuration files (WideServer.ini on the FS9 PC,
and WideClient.ini on the Network PC). The two .ini configuration files have to be
edited to match your two PC names and IP addresses.
One of the WideFS installation options is to place an icon on your desktop. This is
strongly recommended that you do that so that you don’t forget to start it whenever
you want to run FS9 and Plan‐G on separate PCs.
19.2.2 Connection Steps
After the installation and configuration of FSUIPC and WideFS, you will be able to run
FS9 on the FS9 PC, and Plan‐G on the Network PC. There is just one extra step in the
procedure than for connecting on the same PC.
1.

Start FS9. Note that in the top frame of the FS9 Window you will see the words
“FS2004 with Wideserver: Waiting for clients”. This is your indication that the
WideFS server module is working.

2.

Start Wideclient on the Plan‐G PC – from the desktop icon if you have one. You
won’t see anything happen except a blank grey screen opens (unless you have
configured it to start minimized. If you maximize the Wideclient window from
the taskbar, you will see the word “Connected” in the top frame of the window.
That is your indication that Wideclient is working. You can now minimize
Wideclient to the taskbar again. Once you become familiar with WideFS you will
almost forget about it as it works silently and reliably in the background.

3.

Start Plan‐G

4.

From the ‘File’ tab, select Options from the menu on the left and then FS
Connection. Select “FSUIPC” as the connection method.

5.

Return to the Home ribbon in Plan‐G and click the “Connect” button. After a few
seconds, you will hear a “Connected!” sound from the Network PC, and the
Connect/Disconnect buttons will show that you are connected.

Figure 155 Connected to FS9
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In the FS9 window top frame, the wording will now have changed to FS2004 with
Wideserver: 1 connected.
All the additional data features mentioned above for connecting to FS will be available
in an identical way to connecting with only one PC, and it is highly unlikely that you will
experience any loss of FS9 performance.

19.3

Connecting to FSX from a Networked PC with SimConnect
There are three steps required to connect the two PCs with SimConnect. Don’t be put
off by the seemingly technical instructions which follow – The procedure is actually
quite easy: ‐
•

Decide the appropriate data transfer protocol (see section 17.2 above). Note that
Pipe does not work across a network.

•

Create or modify a special file “SimConnect.xml” on the FSX PC

•

Configure the SimConnect parameters in Plan‐G to match those in SimConnect.xml.

Note: You do not need to build a SimConnect.xml file if you are running FSX and Plan‐G
on the same PC.
19.3.1 Creating a SimConnect.xml file for the IPv4 Protocol
This file must be created on the FSX PC, in the same folder as fsx.cfg.
For Windows XP users, this is usually
C:\Documents and Settings\<user name>\Application Data\Microsoft\FSX

For Windows Vista users, this is usually
C:\Users\<Username>\AppData\Roaming\Microsoft\FSX.

SimConnect.xml is a text file which you can create using Windows NotePad or any
simple text editor (not MSWord). Plan‐G will not build a SimConnect.xml file for you.
The following is an example which has been proved to work for two networked
Windows XP machines. The red coloured text will not change in any SimConnect file.
The blue coloured text is the part which you may need to change to suit your set up.
<?xml version="1.0" encoding="Windows-1252"?>
<SimBase.Document Type="SimConnect" version="1,0">
<Descr>SimConnect</Descr>
<Filename>SimConnect.xml</Filename>
<SimConnect.Comm>
<Disabled>False</Disabled>
<Protocol>Auto</Protocol>
<Scope>global</Scope>
<Address>192.168.0.2</Address>
<MaxClients>64</MaxClients>
<Port>4506</Port>
<MaxRecvSize>4096</MaxRecvSize>
<DisableNagle>False</DisableNagle>
</SimConnect.Comm>
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<SimConnect.Comm>
<Disabled>False</Disabled>
<Protocol>IPv4</Protocol>
<Scope>global</Scope>
<Address>192.168.0.2</Address>
<MaxClients>64</MaxClients>
<Port>4506</Port>
<MaxRecvSize>4096</MaxRecvSize>
<DisableNagle>False</DisableNagle>
</SimConnect.Comm>
</SimBase.Document>
The example above includes two “profiles” (the blue coloured code between
<SimConnect.Comm> and </SimConnect.Comm>). One is configured for an “Auto”
connection, the other for an IPv4 connection. If you choose to use the example above,
then usually, only the computer address (in bold) needs to be changed to match your
FSX PC’s IP address. In most networks nowadays, the router’s IP Address is 192.168.0.1
or 192.168.1.1, and the PCs have similar addresses, with just the last of the four groups
of digits changed etc. e.g 192.168,0,2, but beware – occasionally default IP addresses
are different, so do check.
The Port value – 4506 – need only be changed from the example above, if you have an
existing SimConnect.xml file and you see that Port 4506 is already in use by another FS
addon. In that case, changing the port for Plan‐G to 4505 is quite sufficient, but don’t
forget to make the same change in Plan‐G. From the ‘File’ tab, select Options from the
menu and then FS Connection. Enter the changed port number in the Server Port/Pipe
dialogue box. The range of port values which you can use for Plan‐G is from 4500 to
4510 inclusive.
19.3.2 Creating a SimConnect.xml file for the IPv6 Protocol
Remember that IPv6 is installed in Windows Vista and Windows 7 by default, (though
it may not be enabled) and may optionally be installed in Windows XP. See the link at
the end of this section for further information.
The SimConnect file must be created on the FSX PC, in the same folder as fsx.cfg.
This is usually
C:\Program Data\Microsoft\FSX

SimConnect.xml is a text file which you can create using Windows NotePad or any
simple text editor (not MSWord). Plan‐G will not build a SimConnect.xml file for you.
The following is an example which has been proved to work for two networked
Windows 7 machines. The red coloured text will not change in any SimConnect file.
The blue coloured text is the part which you may need to change to suit your set up.
<?xml version="1.0" encoding="Windows-1252"?>
<SimBase.Document Type="SimConnect" version="1,0">
<Descr>SimConnect</Descr>
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<Filename>SimConnect.xml</Filename>
<SimConnect.Comm>
<Disabled>False</Disabled>
<Protocol>IPv6</Protocol>
<Scope>link-local</Scope>
<MaxClients>64</MaxClients>
<Address>fe80::899d:395:c919:168f</Address>
<Port>4506</Port>
</SimConnect.Comm>
</SimBase.Document>
The example above includes just one “profile” (the blue coloured code between
<SimConnect.Comm> and </SimConnect.Comm>). If you choose to use the example
above, then usually, only the computer address (in bold) needs to be changed to match
your FSX PC’s IP address. To find your Windows 7/Vista computer’s IP address:
•

On the Start menu, right‐click on ‘Network’

•

Select properties, then click on the active connection (‘Local Area Connection’ or
‘Wireless Connection’ for example.

•

This brings up the ‘Connection Status’ dialog. Click on ‘Details’ and all your
parameters are listed, including the IPv6 address, which always starts ‘fe’.
The Port value – 4506 – need only be changed from the example above, if you have an
existing SimConnect.xml file and you see that Port 4506 is already in use. Changing it
in that case for Plan‐G to 4505 is quite sufficient, but don’t forget to make the same
change in the Plan‐G. From the ‘File’ tab, select Options from the menu and then FS
Connection. Enter the changed port number in the Server Port/Pipe dialogue box. The
range of port values which you can use is from 4500 to 4510 inclusive.
Technical Note: IPv6 addresses are 128‐bit hexadecimal numbers. Each pair of bytes
(octets) is separated by a colon, viz: ab32:12cd. But they can be shorthanded so you
would rarely have to write out the full string.

•

Leading 0s in a pair can be omitted (:34d: is the same as :034d:)

•

Pairs that are all‐0s can be omitted (E3D7:0000:0000:0000:51F4 can be written as
E3D7::51F4), but you can only do that once per ip

•

Site‐Local (fec* through fef*) is the IP6 equivalent to the IP4 192.168.. and 10.0...
private subnets, ie they are not propagated onto the Internet. They will pass
through routers, so can span an entire organisation.

•

Link‐Local (fe8* through feb*) are also private addresses (like 192.168 etc) that
don't get propagated to the Internet, BUT they restricted to a single LAN, so they
will not pass through a router.
There is a checksum at the end of the address (%11, or %13 etc). This does not form
part of the address.

More information about IPv6 is available at http://ipv6int.net/systems/windows_xp‐
ipv6.html
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19.3.3 Modifying an Existing a SimConnect.xml file
It is strongly recommended that you make a copy of the existing file on your computer
before you modify it. The code in blue above should then be added to the existing file
just before the final
</SimBase.Document>
Do not copy the code in red into the existing file – once is enough! Save the file. Again
if you choose to use the example above, then only the computer address (in bold)
needs to be changed to match your FSX PC’s IP address.
Other examples are given in Section 20 below, with more detailed explanation, should
you be interested.
If you don’t wish to get as technical as this, simply ask for help on the very active Plan‐
G Forum. There are Techies by the score there who will be only too willing to answer
all your questions.
19.3.4 Configure the SimConnect Settings in Plan-G
Once you have the SimConnect.xml file created on the FSX PC, you can configure Plan‐
G on the Network PC to “find” the FSX data on the networked PC. In the Plan‐G
program, from the ‘File’ tab, select Options from the menu and then FS Connection.
Select “Auto”, preferably, or “SimConnect” as the connection method.
The SimConnect Settings should be set as described below.
IPv4 Setting
Network Mode:
FSX Computer:
Server Port/Pipe:

IPv4
IP address (e.g. 192.168.0.2) or computer network name
4506

Figure 156 A SimConnect Configuration for IPv4 with Windows XP

In Figure 156 above, the corresponding SimConnect profile would be: ‐
<SimConnect.Comm>
<Disabled>False</Disabled>
<Protocol>IPv4</Protocol>
<Scope>global</Scope>
<Address>192.168.0.2</Address>
<MaxClients>64</MaxClients>
<Port>4506</Port>
<MaxRecvSize>4096</MaxRecvSize>
<DisableNagle>False</DisableNagle>
</SimConnect.Comm>
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IPv6
IPv6 address, e.g. fe80::899d:395:b16c:168f
4506

Figure 157 A SimConnect Configuration for IPv6 with Windows 7

In Figure 157 above, the corresponding SimConnect profile would be
<SimConnect.Comm>
<Disabled>False</Disabled>
<Protocol>IPv6</Protocol>
<Scope>link-local</Scope>
<Address> fe80::899d:395:c919:168f</Address>
<MaxClients>64</MaxClients>
<Port>4506</Port>
<MaxRecvSize>4096</MaxRecvSize>
<DisableNagle>False</DisableNagle>
</SimConnect.Comm>
Note: Link‐local is an IPv6 mechanism for accessing computers on a network that does
not involve traversing a router. It is required for link‐local IP6 addresses (which start
fe80:....).
19.3.5 Connected
Close the Options window by clicking “OK”. Now press the “Connect” button.

Figure 158 Connected to FSX

After all the above, you may feel that you have achieved a minor miracle. The good
news is that, hopefully, you only have to go through that process once, unless you re‐
install FSX or something equally drastic.
On connecting, the Plan‐G map will move so that your FSX aircraft location is shown,
and a yellow User Aircraft Icon will appear. If AI aircraft are in the area, and as long as
you have selected AI aircraft in the options panel to be displayed, they will appear in
red. If you are connected to VATSIM, IVAO or other multiplayer server, then Plan‐G
displays other connected aircraft rather than AI aircraft and in blue rather than in red.
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You can now set up Trail Analysis, import FS Weather data etc. as described above,
which significantly enhances the value of Plan‐G.
If you get a connection error, or a connection time‐out error, the most likely reason is
that you have not configured Plan‐G with the correct SimConnect parameters on the
Options page under the ‘File’ tab. Section 20 below deals with addressing SimConnect
problems. If the advice in that section does not result in SimConnect successfully
connecting, the problem may be tricky to solve. If you have other programs which use
SimConnect and you are unsure of how to correct SimConnect problems, please do not
experiment, but seek expert advice.

19.4

Connecting to FSX from a Networked PC with FSUIPC
SimConnect is the preferred connection option for FSX. It is more efficient, faster, and
provides optimal control over the information available. FSX users should be able to
use FSX's built‐in SimConnect by carefully following the instructions in this manual, but
if you cannot get it to work for you, then you will need to buy Peter Dowson’s WideFS
and use it with either with the freeware FSX version of Peter Dowson's FSUIPC ‐
FSUIPC 4, which uses SimConnect internally, or you can, if you wish, buy the full
featured version of FSUIPC 4.
FSUIPC 4 may be downloaded from http://www.schiratti.com/dowson.html
Peter Dowson provides very friendly and attentive support for his programs on this
forum:
http://forums.simflight.com/viewforum.php?f=54
The FSUIPC4 installer program copies a file called “FSUIPC4.DLL” into the FSX/Modules
folder, along with the FSUIPC4 User Guide.pdf. When you next run FSX, after accepting
the newly‐installed FSUIPC4 modules, there will be a new FSUIPC entry in the “Add‐
Ons” menu. FSUIPCs first action will be to ask you to register the program. If you
simply want to use FSUIPC4 to connect FSX to add‐on programs on the same PC, you
do not have to continue with registration of the program.

19.4.1 WideFS
In addition, you will need a second Peter Dowson program called WideFS, which
installs a server portion, WideServer.dll, on the FSX PC, and a client portion,
WideClient.exe, on the Network PC. WideFS is available from:
http://www.schiratti.com/dowson.html
Note that, in contrast to FSUIPC, WideFS is not free, and must be purchased and
registered, using an access key. There is an option to buy the registered version of
FSUIPC (which has many more features than the free version) and WideFS as a bundle,
which costs less than the two purchased separately. Note that for FSX you must buy
the FSX specific version.
Follow the instructions in the WideFS User Guide (a pdf document) to install the client
and server portions along with their configuration files (WideServer.ini on the FSX PC,
and WideClient.ini on the Network PC). The two .ini configuration files have to be
edited to match your two PC network names and IP addresses.
Page 136 of 152

Plan G User Manual

V 3.1.1 July 2014

One of the WideFS installation options is to place an icon on your desktop. It is
strongly recommended that you do so, so that you don’t forget to start it whenever
you want to run FSX and Plan‐G on separate PCs (a very common user error).
19.4.2 Connection Steps
After the installation and configuration of FSUIPC and WideFS, you will be able to run
FSX on the FSX PC, and Plan‐G on the Network PC. There is just one extra step in the
procedure than for connecting on the same PC.
1.

Start FSX. Note that in the top frame of the FSX Window you will see the words
"FSX with Wideserver: Waiting for clients". This is your indication that the
WideFS server module is working.

2.

Start Wideclient on the Plan‐G PC – from the desktop icon if you have one. You
won’t see anything happen except a blank grey window opens (unless you have
configured it to start minimized. If you maximize the Wideclient window from
the taskbar, you will see the word “Connected” in the top frame of the window.
That is your indication that Wideclient is working. You can now minimize
Wideclient to the taskbar again. Once you become familiar with WideFS you will
almost forget about it as it works silently and reliably in the background.

3.

Start Plan‐G

4.

From the ‘File’ tab, select Options from the menu and then FS Connection. Select
“FSUIPC” as the connection method.

5.

Return to the Home ribbon in Plan‐G and click the “Connect” button. After a few
seconds, you will hear a “Connected!” sound from the Network PC, and the
Connect/Disconnect buttons will show that you are connected.

In the FSX window top frame, the wording will now have changed to FSX with
Wideserver: 1 connected.
All the additional data features mentioned above for connecting to FS will be available
in an identical way to connecting with only one PC, and it is highly unlikely that you will
experience any loss of FSX performance. In the FSX window top frame, the wording
will now have changed to FSX with Wideserver: 1 connected.
All the additional data features mentioned above for connecting to FS will be available
in an identical way to connecting with only one PC, and it is highly unlikely that you will
experience any loss of FSX performance.

Figure 159 FSX Connected via FSUIPC

19.5

Connecting to P3D from a Networked PC with SimConnect
The steps required to connect the two PCs with SimConnect are identical for P3D to
the instructions for FSX at Section 18.2 above: ‐
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•

Decide the appropriate data transfer protocol (see section 17.2 above). Note that
Pipe does not work across a network.

•

Create or modify a special file “SimConnect.xml” on the P3D PC

•

Configure the SimConnect parameters in Plan‐G to match those in SimConnect.xml.

A Typical Simconnect file for P3D is as follows: ‐
<?xml version="1.0" encoding="Windows-1252"?>
<SimBase.Document Type="SimConnect" version="1,0">
<Descr>SimConnect Server Configuration</Descr>
<Filename>SimConnect.xml</Filename>
<Disabled>False</Disabled>
<SimConnect.Comm>
<Disabled>False</Disabled>
<Protocol>IPv4</Protocol>
<Scope>Global</Scope>
<MaxClients>64</MaxClients>
<Address192.168.1.14</Address>
<Port>4506</Port>
</SimConnect.Comm>
<SimConnect.Comm>
<Disabled>False</Disabled>
<Protocol>Auto</Protocol>
<Scope>global</Scope>
<Address>local</Address>
<MaxClients>64</MaxClients>
<Port>4506</Port>
<MaxRecvSize>4096</MaxRecvSize>
<DisableNagle>False</DisableNagle>
</SimConnect.Comm>
</SimBase.Document>
You will note immediately that it is identical to the structure of a SimConnect.xml file
for FSX. It has been included here to reinforce the point. In P3D the SimConnect.xml
file is put in the main P3D Folder, e.g. C:\Program Files (x86) Lockheed
Martin\Prepar3D v2. With this file in place, and the Plan‐G locations page congured
exactly as Figure above, Plan‐G will connect to P3D.

19.6

Connecting to P3D from a Networked PC with FSUIPC
If you find setting up SimConnect too much like hard work, then you can use Peter
Dowson’s WideFS with either with the freeware P3D version of Peter Dowson's
FSUIPC, which uses SimConnect internally, or you can, if you wish, buy the full featured
version of FSUIPC for P3D. You must use FSUIPC 4.923 or later with Prepar3D version
2.0.
The method of installation and use of FSUIPC and WideFS for P3D is identical to that
for FSX as described in Section 19.4 above.
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Connecting to X-Plane from a Networked PC
Connecting to X‐Plane from a Networked PC with XPUIPC is very simple indeed. Just
put the file XPUIPC.xpl in X‐Plane\Resources\Plugins exactly as for a single PC setup.
Note, however, that Plan‐G can only connect to X‐Plane installed on a PC running the
Microsoft Windows operating system at present.

Figure 160 Put the file XPUIPC.xpl in X-Plane\Resources\Plugins

Put the XPWideClient.exe and XPWideClient.ini files in a directory of your choice on
the Plan‐G PC. These two files must be in the same directory on the Plan‐G PC.
If there is no XPWideClient.ini before you start XPWideClient, the program will create
it for you when you first start it. However the program generates the ini file with a
default IPv4 address for the server, 192.168.0.20, which almost certainly won’t be
correct for your PC.
So, you need to find the IPv4 address of your PC. There are a number of ways to do
this, but the easiest is to open a Command Prompt window. Click the Start button,
select All Programs/Accessories, and Command Prompt is normally the third option
down the list.
At the flashing cursor, type “ipconfig” (no quotes of course). You should then see
something similar to the following.

Figure 161 Command Prompt Window

There may be quite a lot of information displayed, so look carefully for the IPv4 line. In
Figure 161 above, the IPv4 address is 192.168.0.8. If you are running Windows XP, the
data displayed is much briefer, and the line to look for starts ‘IP Address. . . . . .’
Now open the file XPWideClient.ini in Notepad, and change the default 192.168.0.20
to the IPv4 address of your PC. Save the file. Note that you cannot use any alternative
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name such as Server, or host etc). There is no error checking in the current version of
XPUIPC, so be careful to enter the numbers correctly.

Figure 162 Editing XPWideClient.ini

XPUIPC should now be configured for your PC.
Start the Plan‐G program. From the ‘File’ tab, select ‘Options’ from the menu and then
‘FS Connection’, select ‘XPUIPC’ as the connection method.
Now close the Options window by clicking “OK”, and return to the main window.

Figure 163 XPUIPC is used with X-Plane

Next, start XPWideClient. The XUIPC window shown in Figure 165 below will be
displayed on your Plan‐G PC desktop.
Useful Tip: On your Plan‐G PC, you will have a shortcut on your desktop to Plan‐G.
Why not put a shortcut to XPWideClient.exe alongside it, as shown below?

Figure 164 XPWideClient Desktop Shortcut on Plan-G PC

Finally start X‐Plane. As loading of X‐Plane nears completion, the XPUIPC window
changes to that shown in Figure 166 below.

Page 140 of 152

Plan G User Manual

V 3.1.1 July 2014

Figure 165 XPUIPC Running

Figure 166 XPUIPC Connected

If you return to the Plan‐G Home ribbon, and click the ‘Connect’ icon, your aircraft will
be displayed on the map, and all the functionality of Plan‐G described in this manual will
be available.

Figure 167 Connected to X-Plane with XPUIPC

The text ‘Flight Simulator’ below the Connect/Disconnect buttons does not mean you
are connected to Microsoft Flight Simulator, but to a Flight Simulator – the word is
used generically in this instance. You will be connected to X‐Plane of course.
Remember that you must put both the XPWideClient.exe and XPWideClient.ini files
in the same directory on the Plan‐G PC. Which directory is not important, but
Documents\Plan‐G Files might be a good place.

Page 141 of 152

Plan G User Manual

20

V 3.1.1 July 2014

MORE ON SIMCONNECT
Microsoft's SimConnect is software that communicates FSX flight information to
another Windows program (Plan‐G in our case). See
http://msdn.microsoft.com/en‐us/esp/cc835021.aspx
for an introduction to SimConnect.
All versions of FSX (Basic, Deluxe and Gold, the original RTM version, SP1 and SP2)
incorporate the SimConnect server interface. However, each release uses its own
version of the SimConnect client (simconnect.dll), which is only distributed with the
Deluxe and Gold versions of the FSX program, in the FSX Software Development Kit
(SDK). The SDK can be found on the Deluxe and Gold editions, DVD 1.
You do not need to install the SimConnect client, in fact you need do nothing technical
with it apart from creating a SimConnect.xml file, because Plan‐G includes a version of
the SimConnect Client created by Tim Gregson, formerly of Microsoft Aces, which
seems to be more robust than the original.
SimConnect requires a “script” in order to know what to do. This script is called
SimConnect.xml and resides on your FSX PC in the same folder as FSX.CFG. The
structure of SimConnect.xml files may look quite awesome to people not familiar with
modern script computer languages. Here are a few simple rules about this file and xml
in general.
1.

There is no error trapping. Make a typing error and it simply won’t work – but it
won’t crash your computer either.

2.

All space characters and new lines are ignored so you can have as many as you
like.

3.

Every Command opening tag <tag> must have an equivalent closing tag
</tag>

4.

Each “Profile” of the file, defining a different protocol, starts
<SimConnect.Comm> and ends </SimConnect.Comm> so you can see in
the examples below several such “Profiles” in the one file.

5.

The whole file must start with the header (in red in examples below) and end
with the closing tag (also in red)

6.

The opening tag <!--and the closing tag--> enclose text which is
ignored, so you can put any comment you like between those tags to explain to
yourself when looking at the code years later, what it means.

7.

If you get it wrong you cannot harm your PC. But do seek expert help if
necessary to avoid hours of frustration.

There are three data transfer protocols which may be used, Pipe, IPv4 and iPv6.
Pipe is normally used for internal communications within a PC.
IPv4 is used by Windows XP by default, and earlier versions of Windows.
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IPv6 is available in Windows Vista and later versions of Windows, and may be installed
in Windows XP if you wish.
You need to Enable the one you want to use by making sure the line:
<Disabled>False</Disabled>
is present. For the other Elements, you can change the line to:
<Disabled>True</Disabled>
but this isn’t essential. Plan‐G will use the protocol set in File/Options/FS Connection.
For Ipv6 connections. Note that <Scope> needs to be set to link-local not
global

20.1

Example 1
This example contains four “Profiles”, one for a local pipe connection, two for remote
(network) IPv6 connections and one for a remote IPv4 connection. Note that the Pipe
protocol cannot be used for networked connections.
<!--Example Local Pipe Server Configuration-->
<?xml version="1.0" encoding="Windows-1252"?>
<SimBase.Document Type="SimConnect" version="1,0">
<Descr>SimConnect Server Configuration</Descr>
<Filename>SimConnect.xml</Filename>
<Disabled>False</Disabled>
<SimConnect.Comm>
<Disabled>False</Disabled>
<Protocol>Pipe</Protocol>
<Scope>local</Scope>
<MaxClients>64</MaxClients>
<Port></Port> Å--THE PORT IS GIVEN NO VALUE
</SimConnect.Comm>
<!--Example Global (remote) IPv6 Server Configuration-->
<SimConnect.Comm>
<Disabled>False</Disabled>
<Protocol>IPv6</Protocol>
<Scope>link-local</Scope>
<MaxClients>64</MaxClients>
<Address>fe80::5974:d93:646d:a902</Address>
<Port>4506</Port>
</SimConnect.Comm>
<!—2nd Example Global (remote) IPv6 Server Configuration->
<SimConnect.Comm>
<Disabled>False</Disabled>
<Protocol>IPv6</Protocol>
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<Scope>link-local</Scope>
<MaxClients>64</MaxClients>
<Address>My_FS_PCs NETWORK NAME</Address>
<Port>4506</Port>
</SimConnect.Comm>
<!--Example Global (remote) IPv4 Server Configuration-->
<SimConnect.Comm>
<Disabled>False</Disabled>
<Protocol>IPv4</Protocol>
<Scope>global</Scope>
<MaxClients>64</MaxClients>
<Address>192.168.0.3</Address>
<Port>4504</Port>
</SimConnect.Comm>
</SimBase.Document>

20.2

Example 2
The example below includes profiles for two remote and three local connections, for
Pipe, IPv6 and IPv4 connections. For remote connections, i.e. a network connection,
you would need to enable one or more of the three "Global" profiles in the
SimConnect.xml file.
To enable a profile, set "Disabled" to false:
<Disabled>False</Disabled>
and then specify the IPv4/IPv6/machine name and port number/pipe name in the
appropriate sections.
<?xml version="1.0" encoding="Windows-1252"?>
<SimBase.Document Type="SimConnect" version="1,0">
<Descr>SimConnect Server Configuration</Descr>
<Filename>SimConnect.xml</Filename>
<Disabled>False</Disabled>
<!-- Example Global (remote) IPv6 Server
Configuration-->
<SimConnect.Comm>
<Disabled>True</Disabled>
<Protocol>IPv6</Protocol>
<Scope>link-local</Scope>
<MaxClients>64</MaxClients>
<Address>::1</Address>
<Port>REPLACE_WITH_PORT_NUMBER</Port>
</SimConnect.Comm>
<!-- Example Global (remote) IPv4 Server
Configuration-->
<SimConnect.Comm>
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<Disabled>False</Disabled>
<Protocol>IPv4</Protocol>
<Scope>global</Scope>
<MaxClients>64</MaxClients>
<Address>192.168.1.200</Address> <!-- SET TO THE IP
ADDRESS OF THE FSX PC -->
<Port>4500</Port> <!-- SET TO A VALUE BETWEEN 4500 AND
4510 -->
<MaxRcvSize>4096</MaxRcvSize>
<DisableNagle>False</DisableNagle>
</SimConnect.Comm>
<!-- Example Local Pipe Server Configuration-->
<SimConnect.Comm>
<Disabled>False</Disabled>
<Protocol>Pipe</Protocol>
<Scope>local</Scope>
<MaxClients>64</MaxClients>
<Port>LEAVE BLANK</Port>
</SimConnect.Comm>
<!-- Example Local IPv6 Server Configuration-->
<SimConnect.Comm>
<Disabled>False</Disabled>
<Protocol>IPv6</Protocol>
<Scope>local</Scope>
<MaxClients>64</MaxClients>
<Address>::1</Address>
<Port>REPLACE_WITH_PORT_NUMBER</Port>
</SimConnect.Comm>
<!-- Example Local IPv4 Server Configuration-->
<SimConnect.Comm>
<Disabled>False</Disabled>
<Protocol>IPv4</Protocol>
<Scope>local</Scope>
<MaxClients>64</MaxClients>
<Address>127.0.0.1</Address>
<Port>4505</Port> <-- SET TO A VALUE BETWEEN 4500 AND
4510
</SimConnect.Comm>
</SimBase.Document>
Instead of <Address>127.0.0.1</Address> in the last profile of Example 2
you can enter<Address>localhost</Address>. Either is valid.
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Appendix 2 – Support
Please go to http://www.tasoftware.co.uk/forum
Email Contact
tim@tasoftware.co.uk
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